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Documentation Updates

The title page of this document contains the following identifying information:
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To check for recent updates, or to verify that you are using the most recent edition of a 
document, go to:

http://h20230.www2.hp.com/selfsolve/manuals 
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Support

Visit the HP Software Support web site at:

http://www.hp.com/go/hpsoftwaresupport 

This web site provides contact information and details about the products, services, and 
support that HP Software offers.

HP Software online support provides customer self-solve capabilities. It provides a fast and 
efficient way to access interactive technical support tools needed to manage your business. As 
a valued support customer, you can benefit by using the support web site to:

• Search for knowledge documents of interest

• Submit and track support cases and enhancement requests

• Download software patches

• Manage support contracts

• Look up HP support contacts

• Review information about available services

• Enter into discussions with other software customers

• Research and register for software training

Most of the support areas require that you register as an HP Passport user and sign in. Many 
also require a support contract.  To register for an HP Passport ID, go to:

http://h20229.www2.hp.com/passport-registration.html 

To find more information about access levels, go to:

http://h20230.www2.hp.com/new_access_levels.jsp 
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Welcome to This Guide

This guide describes how to configure and work with Business Process 
Insight and provides information about the management tasks that you 
need to complete for the ongoing set up and maintenance of your Business 
Process Insight (BPI) solution.

This chapter includes:

➤ How This Guide Is Organized on page 11

➤ Who Should Read This Guide on page 12

➤ How Do I Find the Information That I Need? on page 12

➤ Additional Online Resources on page 15

➤ Documentation Updates on page 16

How This Guide Is Organized

The guide contains the following:

Chapter 1, "Introducing Business Process Insight." 

Provides an overview of using BPI with Business Service Management to 
visualize the health and performance of the Business Processes that are 
running over an IT infrastructure.

 Part I BPI Administration

Describes the BPI Administration options: Modeler, Monitor Definer, 
Process Repository Explorer, Process Intervention, and Notification.
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 Part II Reports

Describes the BPI Reports: BPI Application Scorecard, BPI Application 
Health, Business Process Summary Report, BPI Monitors Over Time 
Report, and Business Process Activity Summary Report.

Who Should Read This Guide

This guide is intended for the following users of HP Business Process Insight:

➤ HP Business Process Insight administrators

➤ HP Business Process Insight application administrators

➤ HP Business Process Insight end users

Readers of this guide should be knowledgeable about navigating and using 
enterprise applications, and be familiar with HP Business Service 
Management and enterprise monitoring and management concepts.

How Do I Find the Information That I Need?

This guide is part of the HP Business Service Management Documentation 
Library. This Documentation Library provides a single-point of access for all 
Business Service Management documentation.

You can access the Documentation Library by doing the following:
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➤ In Business Service Management, select Help > Documentation Library.

➤ From a Business Service Management Gateway Server machine, select 
Start > Programs > HP Business Service Management > Documentation.

Topic Types
Within this guide, each subject area is organized into topics. A topic 
contains a distinct module of information for a subject. The topics are 
generally classified according to the type of information they contain.

This structure is designed to create easier access to specific information by 
dividing the documentation into the different types of information you 
may need at different times. 

Three main topic types are in use: Concepts, Tasks, and Reference. The topic 
types are differentiated visually using icons.

Topic Type Description Usage

Concepts Background, descriptive, or 
conceptual information. 

Learn general information 
about what a feature does.
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Tasks Instructional Tasks. Step-by-
step guidance to help you 
work with the application and 
accomplish your goals. Some 
task steps include examples, 
using sample data. 

Task steps can be with or 
without numbering:

➤ Numbered steps. Tasks that 
are performed by following 
each step in consecutive 
order.

➤ Non-numbered steps. A list 
of self-contained operations 
that you can perform in any 
order.

➤ Learn about the overall 
workflow of a task.

➤ Follow the steps listed in 
a numbered task to 
complete a task.

➤ Perform independent 
operations by 
completing steps in a 
non-numbered task.

Use-case Scenario Tasks. 
Examples of how to perform a 
task for a specific situation.

Learn how a task could be 
performed in a realistic 
scenario.

Topic Type Description Usage
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Additional Online Resources

Troubleshooting & Knowledge Base accesses the Troubleshooting page on 
the HP Software Support Web site where you can search the Self-solve 
knowledge base. Choose Help > Troubleshooting & Knowledge Base. The 
URL for this Web site is http://h20230.www2.hp.com/troubleshooting.jsp.

HP Software Support accesses the HP Software Support Web site. This site 
enables you to browse the Self-solve knowledge base. You can also post to 
and search user discussion forums, submit support requests, download 
patches and updated documentation, and more. Choose Help > HP Software 
Support. The URL for this Web site is www.hp.com/go/hpsoftwaresupport.

Most of the support areas require that you register as an HP Passport user 
and sign in. Many also require a support contract.

Reference General Reference. Detailed 
lists and explanations of 
reference-oriented material.

Look up a specific piece of 
reference information 
relevant to a particular 
context.

User Interface Reference. 
Specialized reference topics 
that describe a particular user 
interface in detail. Selecting 
Help on this page from the 
Help menu in the product 
generally open the user 
interface topics.

Look up specific 
information about what to 
enter or how to use one or 
more specific user interface 
elements, such as a 
window, dialog box, or 
wizard.

Troubleshooting 
and Limitations

Troubleshooting and 
Limitations. Specialized 
reference topics that describe 
commonly encountered 
problems and their solutions, 
and list limitations of a feature 
or product area.

Increase your awareness of 
important issues before 
working with a feature, or 
if you encounter usability 
problems in the software. 

Topic Type Description Usage
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To find more information about access levels, go to:

http://h20230.www2.hp.com/new_access_levels.jsp

To register for an HP Passport user ID, go to: 

http://h20229.www2.hp.com/passport-registration.html 

HP Software Web site accesses the HP Software Web site. This site provides 
you with the most up-to-date information on HP Software products. This 
includes new software releases, seminars and trade shows, customer support, 
and more. Choose Help > HP Software Web site. The URL for this Web site 
is www.hp.com/go/software.

Documentation Updates

HP Software is continually updating its product documentation with new 
information.

To check for recent updates, or to verify that you are using the most recent 
edition of a document, go to the HP Software Product Manuals Web site 
(http://h20230.www2.hp.com/selfsolve/manuals).
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1
Introducing Business Process Insight

This chapter includes:

Concepts

➤ BPI Within Business Service Management Overview on page 18

➤ What is a Business Process? on page 20

➤ What is a BPI Process? on page 21

➤ Business Events on page 26

➤ IT Processes on page 27

➤ Summary of Defining Models for Your Business Processes on page 28

➤ Instances of Business Processes on page 29

➤ Operational and Business Data on page 32

➤ Business Scenario for a Stock Control System and BPI on page 34

➤ What BPI Provides on page 37

➤ Using BPI Within Business Service Management on page 38

Tasks

➤ How to Manage User Permissions on page 44

Reference

➤ Configuration Items Stored in the ODB on page 47
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Concepts

BPI Within Business Service Management Overview

BPI is a Business Service Management Application that enables you to make 
better business decisions by improving the quality of the business 
information available to you. BPI provides you with visibility into the 
health and performance of the Business Processes that are running over your 
IT infrastructure. Using this information, you can assess the financial and 
business impact of delays or blockages in a process due to an IT performance 
problem or other incident such as an IT outage. 

BPI achieves this by linking and relating the information held for your 
business and its IT infrastructure. It takes information, in the form of events, 
from both business applications and from the IT infrastructure, and presents 
these events in business terms; for example, rate of loss of orders, backlogs 
accumulating, value of these backlogs and potential impact on key 
customers. In other words, BPI enables you to visualize and then track the 
state, or health, of Business Processes within your organization. 

Specifically you can use BPI to:

➤ model Business Processes and then measure key business data associated 
with these processes; for example, value of order. 

➤ correlate each Activity in the Business Process with the IT infrastructure 
on which it depends and provide IT with the visibility to show its 
contribution to the business.

To achieve this, BPI uses business data events and IT infrastructure events to 
monitor the status of all the Business Processes that you have modeled. As a 
result, when a problem occurs within the IT infrastructure, BPI reports on 
the instances of the processes that are being monitored and that are 
impacted; for example, BPI might report on the number of orders that are 
affected for a specific customer, for all customers or for a group of customers 
(gold, silver, bronze-level customers).
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The key business data associated with the process are then used to 
determine the business impact of the problem. Business impact typically 
takes the form of financial impact, but it can also be the number of key 
customers affected, or the number of urgent orders affected, and so on.

➤ proactively monitor your service level agreements (SLAs). 

Service Health enables you to see which SLAs are at risk and enables you 
to navigate to see which specific configuration item (CI) is potentially 
causing you to breach a service contract. For more information about the 
BPI CIs see “Configuration Items Stored in the ODB” on page 47.

➤ calculate whether the measurements of an SLA are within the limits set 
out in a service level agreement (as defined in Service Level Management).

➤ calculate whether an SLA is in breach of contract, or might be in breach in 
the near future.

The following diagram shows the structure of the BPI Business Process 
models as CIs within the ODB. 
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Each of the elements in this diagram is represented as a CI within the ODB. 
The BPI application sends data samples for the Business Process CIs that you 
define and these data samples are then displayed on the Business Process 
Diagram in Service Health and in the Business Process Application.

Enabling/Disabling BPI Through BSM Server Deployment
When BSM is deployed, you can enable the applications that you require 
through the BSM Server Deployment page.You must enable Business Process 
Insight through the BSM Server Deployment page to be able to access the 
BPI application from both the Applications and Admin menus. To access the 
BSM Server Deployment page, select Admin > Platform > Setup and 
Maintenance > Server Deployment.

If you disable BPI through the BSM Server Deployment page, even if the BPI 
license is installed, BPI cannot be accessed. For details on using the BPI 
Server Deployment, see Platform Administration.

Note: If you enable/disable Business Process Insight through the BSM Server 
Deployment page, the BSM Gateway and Processing Servers should be 
restarted, for this change to take effect.

What is a Business Process?

Business Processes are a set of Business Activities within your business; for 
example, Business Activities for a telecom service provider might include 
line provisioning, customer billing and equipment repairs. These Business 
Activities might not always be obvious, and they might not be formally 
recognized, but they always exist within a business. A Business Process (or a 
set of Business Activities) typically includes all the activities of the business.

For an insurance company, business activities might include setting up a 
new policy for a customer and processing an insurance claim. In addition to 
these line-of-Business Processes, a Business Process can also be an internal 
administration process, such as HR processes, payroll, and so on.
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Business Processes are not necessarily exclusive to one company; many 
Business Processes involve customers and suppliers. Business Processes can 
be automated, using Business Process management software; however, only 
a fraction of Business Processes are fully automated. Most Business Processes 
are manual and some exist only in the behavior of the organization, that is, 
they are not formally documented.

What is a BPI Process?

A process (for BPI tracking purposes) does not need to include all the 
activities in a Business Process; it need contain only those activities that you 
need to understand in order to determine that your business is functioning 
optimally. As an example, a vehicle dashboard presents a summary of the 
key activities that you need to be aware of for the vehicle; it does not present 
all the information about all the vehicle operations.

The business activities that you need to model within BPI for your business 
are those required to obtain meaningful impact data about the health of 
your business. The fewer business activities that you track, the easier the BPI 
processes are to create and manage and visualize.
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Structure of a BPI Process
Within BPI, a process is presented as a series of Activities and connections, 
which are called Arcs. The Activities represent the business activities and the 
arcs connect the Activities to show the expected direction of flow within the 
process; this is shown in the following diagram.

An activity in a Business Process might represent one or more business 
activities, according to how much detail of the Business Process you are 
modeling in order to track it.

BPI enables you to represent a business process in a graphical form. This 
allows you to show the logical structure of the elements of the process. The 
graphical representation also provides visual information relating to the 
progression of the process.

Using the graphical processes enables you to more easily connect business 
activities into a logical sequence using as few activities as possible; however, 
you do need to make sure that you model sufficient of the structure of the 
process to be able to report on the impact of problems in the process. 
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Example BPI Process
The following diagram is an example of a Business Process for an 
organization that provides building materials primarily for professionals, 
but it also has a store where the public can purchase building supplies. This 
diagram shows the hierarchy of the IT operational resources and how they 
relate to the applications that provide the resources.



Chapter 1 • Introducing Business Process Insight

24

The organization is structured as a front office, middle office and back 
office:

➤ The front office includes:

➤ a Web site for online access

➤ a shop

➤ a call center

An ISP hosts the Web site and the shop has a dial-up connection through 
a point-of-sale checkout. The Call Center is out sourced.

➤ The middle office is where the orders are processed and validated. 

➤ The back office is where the billing and the execution of the orders occur.

In this example, the middle and back office operational systems are 
managed using HP Business Service Management. 

Also, in this example, the Stock Control System is used at several points in 
the Business Process and the Stock Control process diagram shows this 
interaction.

The following diagram shows the significant activities of the Business 
Process represented graphically in a BPI process. This is how they might 
appear within the BPI Modeler, which is the graphical tool for creating BPI 
processes.
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As mentioned earlier, you do not need to include all the Activities in the 
Business Process. The Activities that you include are those that relate to the 
key business activities that need to be tracked.

The process shown in this diagram utilizes underlying business applications 
and also includes IT operational resources. Some of the business applications 
might be operationally tracked and therefore represented as IT operational 
resource CIs within Business Service Management. 

There might also be other business applications that are not being 
operationally tracked, but are still providing business application data for 
BPI. In this example, information about the health of the Stock Control 
System is used at several points in the BPI Business Process and the diagram 
below shows this dependency. Within the BPI Modeler, these resources are 
properties of the Activities in the process.
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Business Events

In order to integrate, or import, business event data from your business 
applications, you use the BPI adapter technology. This technology enables 
you to generate business events from sources such as files and databases, and 
business applications including SAP, PeopleSoft and JMS. These adapters 
enable business data to be accepted as the source data for BPI business 
events, which are received through the BPI Business Event Handler 
component.

In the context of BPI, an event is the notification of some change to the 
underlying system that is being monitored and where this state change 
causes a subsequent change in state of the modeled Process instances. This 
might be directly through the data within the event or through some 
transformation of the data.

The following sections describe business event components for BPI:

➤ “Business Events and openadaptor” on page 26

➤ “BPI Accelerator for SAP Applications” on page 27

Business Events and openadaptor
The Business Event Handler is based on the openadaptor technology and 
openadaptor is the underlying mechanism for receiving business events. 
openadaptor is an open-source Java/XML-based software platform, which 
provides business system integration with little or no programming. 
openadaptor provides many ready-built interface components including 
adapters to capture business events from sources such as files, databases, 
JMS, LDAP, Tibco and MQ Series. 

BPI also provides file and database adapters for use specifically with BPI; 
however, openadaptor is an open source product and easily configurable; 
therefore, you can extend the number of adapters for use with BPI as 
required.

For more information on openadaptor refer to:

http://www.openadaptor.org/
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BPI uses a specific version of the openadaptor platform, and the version 
used is available as part of the BPI software. 

BPI also includes specific adapters for SAP; see “BPI Accelerator for SAP 
Applications” on page 27.

BPI Accelerator for SAP Applications
In addition to using the openadaptor framework to create solutions for 
integrating business applications, you can use the BPI Accelerator for SAP to 
enable you to track the status fields within an IDoc. Using the BPI 
Accelerator, you can create processes and business events that are based on 
the status changes within one or more IDocs.

The Accelerator is based on the openadaptor framework and uses the 
Business Event Handler to access the status information within an IDoc 
header. Refer to the Business Process Insight Accelerator for SAP Guide for full 
details of installing and using the Accelerator. 

IT Processes

Within many organizations the IT processes and transactions are often 
hidden within the environment in which they have been automated. The 
processes might have started as fully documented process models, but as 
they are adapted to the needs of the organizations, the processes change and 
the related documentation becomes out of date. Using BPI helps you 
visualize IT processes that are hidden within the organizational structure 
and then set measurements on the IT operational resources that make up 
the processes in order to report on the status of the operation of these 
resources.

You model your IT operational resources within BSM (as CIs) and then use 
BPI to link the CIs to process Activities. BPI can then obtain status 
information relating to these operational resources for Business Processes 
that you have modeled within BPI.
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TransactionVision
BPI can also utilize the transaction models produced by TransactionVision as 
input for a Business Process model. TransactionVision tracks and measures 
individual transactions as they progress through your organization. 
TransactionVision provides the link between low-level systems and network 
monitoring, and high-level Business Process monitoring in order to link 
your IT objectives with your business objectives.

TransactionVision does not assume that a model exists to describe all 
possible transaction flows. TransactionVision monitors transactions and 
discovers the transaction paths as it observes them being executed across the 
organization. You do not need to configure TransactionVision with 
information describing how you think your transactions flow; 
TransactionVision tells you how they actually flow based on observing real 
transactions as they are processed. You do have to configure 
TransactionVision to send the required transaction events to BPI. See the 
HP TransactionVision Deployment Guide PDF for details.

The discovered transaction events are then available for use by BPI, as input 
for Business Process modeling.

Summary of Defining Models for Your Business Processes

By defining models for your Business Processes and mapping these models 
to the underlying IT operational resources modeled within Business Service 
Management, you can be notified when Activities in the process are 
impacted by a failure in the underlying infrastructure.

There are significant benefits to being able to visualize your Business 
Processes and relate resources to these processes; for example, you can 
identify the impact a resource failure has on the process and how other 
Activities in the process might also be impacted.

However, understanding only the impact of resource status changes does 
not enable you to answer questions such as: 

➤ What is the financial impact of the resource failure?
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➤ How many transactions are waiting to be processed at a particular point 
in the process?

In order to answer these types of question, you also need business data from 
your business applications, plus you need the BPI system to maintain data 
on individual instances of the Business Processes. 

Using rules, filters and database queries, BPI can provide monitor data based 
on each instance and groups of instances. This, plus the business data that 
BPI receives through business events, enables BPI to present business-related 
information related to how your business is impacted by a failure in an IT 
operational resource, or how your Business Processes are running with 
respect to the objectives set on health indicators (HIs).

Instances of Business Processes

In order to get more detail from your business systems, you need to be able 
to model the individual instances of the process and see how these are being 
impacted: a process instance is a specific occurrence of a particular process 
that you have defined, for example, a specific customer transaction, or a 
specific flight arrival.

To model instances of your processes, you need to define data objects. A 
data object usually represents a known object within your organization; for 
example, an order, an employee record or flight details, or indeed it might 
also be an aggregation of a number of properties. In the case of 
TransactionVision, these data objects are created automatically when the 
transaction events that you have identified are imported.

The data captured from the business events, which are being processed by 
your BPI system, can be used directly to change the status of a Business 
Process, or can be used to update the status of the data objects that you have 
defined. In the latter case, rules are used to evaluate how the Business 
Process is progressing, based on the changing status of the data object. 

You can also add Business Process Monitors to the instance-level 
information and use them to provide business measurements to indicate the 
health of the process instances that you are tracking.
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Using the data collected for the defined Business Process Monitors, BPI can 
present the state of the business back to the business manager. The data is 
presented according to the instances of the processes being tracked and the 
data collected. You can also use BPI to indicate to IT how they are meeting 
the needs of the business, for example, you can use the Business Process 
Insight Application Health page to show information about how many 
orders are waiting to be processed, or information about the value of orders 
that are waiting to have payment details checked.

You can also use the instance information that is recorded by BPI as follows:

➤ to view historical data recorded from BPI data using the Business Process 
Insight Application Reports page.

➤ monitor SLA violations using the reporting feature of the Service Level 
Management Application.

➤ create your own portlets using My BSM.

As a result of modeling these process instances and setting Business Process 
spans, the business manager can see the impact of the critical business 
events on the Business Processes.

Modeling Business Processes
The most effective way to model a Business Process is to base it around the 
primary documents and Business Processes in your organization, for 
example, orders or insurance claim applications. As part of defining the 
process you need to identify the following:

➤ Data that will be used to drive the process.

These are the data that define the conditions under which a business task 
is deemed to have started and to have finished, and used to progress the 
process.

You can also use data directly from your Business Events to start, stop and 
progress your Business Process.

➤ Data required to answer the business questions that you want to track.

These data are obtained from your underlying business applications and 
can be thought of in terms of the data required for the business 
measurements that you want to report on for the process. 
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➤ Data required to characterize process instances.

In addition to data that can be used to infer process Activity state, or that 
is used in calculations against business criteria, you might also want to 
include Data properties that will be useful later when you want to 
distinguish between Business Process instances. As an example, you might 
want to group data by a specific location; in this case, the data relating to 
the location is not used to determine whether a process Activity has 
started or completed. It is also not used to calculate any sort of business 
metric; however, it is useful to have the location as a category in 
analyzing business performance.

➤ Events, which are required to obtain the data to drive the process and 
answer the business questions.

Events are defined in cooperation with the IT personnel who own the IT 
infrastructure and who you work with to obtain the data that you need.

➤ Key Business Process Monitors that you want to measure for your Business 
Processes.
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Operational and Business Data

This section discusses the types of data used by BPI in more detail.

The following diagram shows how the Activities in a process can be related 
to the IT operational resources of your business, and that these resources, 
when combined with the business data and events received through the 
Business Event Handler, become the basis for tracking the health of your 
Business Processes.

The BPI system also manages the data required for the process (the data 
models), as Data definitions. In the Stock Control example, it maintains 
information about the account business data and within that, information 
about value, customer name, and customer type data. 

BPI does not need to know about all the data related to a process, just 
enough to give a business manager information on the business impact of 
the affected Business Processes. For example, in the Stock Control process 
(see the diagram in “Example BPI Process” on page 23), the account business 
data might also contain data relating t customer address and customer 
preferences, but this data is not required for process tracking purposes, so it 
does not need to be defined or tracked within BPI.
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The following is a summary of the two types of events received into the BPI 
system:

➤ Events that carry the data to move the process through its Activities. 
These are the business events.

You configure the business events that you need for the business 
applications that have access to (or hold) the data required for the 
Business Process.

➤ Events that report business impact information related to the IT 
infrastructure; these are the operational events, which are linked to the 
Business Process CIs.

You need to model business events for your solution. The events from 
underlying business applications can provide the business data focus. 

The data from these underlying systems is defined as part of the Business 
Process and the resultant information used for reports and analysis. 

A methodology, described later in this guide, takes you through the 
Activities that help you define and then refine your Business Process and its 
data.
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Business Scenario for a Stock Control System and BPI

Continuing with the example of the Stock Control system, the following 
describes the scenario in more detail and shows how BPI can be used, by the 
business manager, to indicate the business impact of failures reported 
through Business Service Management. 

The scenario describes what happens when the stock control system fails - 
the business can accept orders, but it is unable to confirm that it can fulfill 
them. As can be seen from the Business Process diagram below, the Stock 
Control System is accessed at the start of the Business Process to check the 
stock when the order is placed, and at the end of the Business Process, when 
the stock is dispatched.
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The business also has a Gold Customer scheme whereby key customers are 
guaranteed their deliveries within a specified time, or significant penalties in 
the way of discounts are incurred.

Using the BPI Application, the business manager receives information 
about:

➤ the impact of the IT operational resource failures

➤ the impact of the business service failures

Using both these sets of information, the business manager now has the 
Business Process data that can be used to better understand the business 
impact of a failure. As an example, the business manager could define a 
Business Process Monitor that records how long it takes a specific instance of 
a process to move between two activities in the process. The Business 
Process Insight Application shows this monitor information in terms of 
statistical information relating to the process instances and their progress. 
The business manager can view the information in tabular and graphical 
form according to their requirements. 

In addition to monitors, the business manager can request for annotations 
to be added to the processes as they are displayed on the Process Diagram on 
the Application Health page. These annotations can show information such 
as the current value of orders waiting to be processed. 

The business manager also has the option to define instance thresholds for 
the Business Process Monitors and have BPI generate instance threshold 
violations when the instance thresholds agreements are not achieved. The 
instance threshold violations can inform them of critical business events, 
due to event such as the failure of the stock control system. On receipt of a 
violation, the business manager uses the BPI Application Health page or My 
BSM portal (whatever their usual reporting tool might be) to query the BPI 
system and obtain more information. 

As an example, they could determine the following:

➤ There are 200 customer orders waiting to be processed and 10 of these 
customers are Gold Account Customers.
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➤ The impact of the current rate of orders, for example, given historical 
information about the rate of orders, the current number of 200 is likely 
to be 1,000 within a couple of hours, and 20,000 by the end of the day.

➤ Using historical information, the stock float should be good for today and 
tomorrow and most orders can be dispatched without incurring any 
delay. 

➤ If required, temporary manual stock control can be put in place using the 
business data provided by the BPI system.

➤ Information about the stock levels

The stock counters configured in the BPI system can be used temporarily 
whilst the stock control system is offline, so the business manager has an 
ongoing count of the stock and can monitor the situation. The business 
manager also knows the levels of stock in the shop, so they have the 
option to fulfill orders from the stock held at the shop if necessary.

The business manager is now in a position to make a business decision to 
prioritize the orders such that the Gold Customers and the high value orders 
are processed first. If any of the stock levels start to get low, the business 
manager can suspend the transactions, or inform customers that there 
might be some delay. They can also order additional stock manually based 
on the BPI data presented to them.

The introduction of BPI means that the business manager now understands 
the business impact of the stock control failure and as a result can:

➤ Continue to process from stock in shop and redirect that stock to Web 
orders if necessary.

➤ Use the BPI data to manage the stock float manually.

➤ Aggregate shop and warehouse stock as required.

➤ Monitor the Gold account customers and minimize the penalty 
payments.

The business events that provide this information come through the BPI 
Business Event Handler components and the operational events are defined 
in the ODB as IT operational resource CIs.
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What BPI Provides

BPI provides the modeling tools that enable you to build a Business Process 
and associate key business services, data and events with the process. As part 
of defining the process, you need to consider what business measurements 
you are likely to want to take. Later, you can add Business Process Monitors 
to these processes to record these business measurements.

Using Business Process Monitor information, BPI can notify the business 
manager when significant events occur and when Business Process Monitor 
instance thresholds are violated; this notification can be done through 
email, through the Notification Server, through the BPI Application or 
through a My BSM portlet. In addition, you can create reports using the 
Business Process Insight Application Reports pages.

Business managers can also receive the BPI impact reports through their 
own reporting tools, if they choose to. BPI writes all its Business Process 
Monitor data to database tables, which are designed and structured to 
maximize the effectiveness of user and application queries. 

BPI enables you to:

➤ Track instances of Business Processes defined and deployed within the BPI 
Modeler.

➤ Monitor the Business Processes and Business Process Activities using the 
instance-based data samples, which are sent by the BPI Server to BSM.

➤ Create monitors for your Business Processes and Business Process 
Activities using the Monitor Definer.

➤ View the health of your Business Processes, Business Process Activities and 
Business Process Monitors according to objectives that you set using the 
Business Process Insight or Service Health.

➤ View reports based on the history of the Business Process using the 
Business Process Insight Application.

➤ View details of the Business Process instances, Activity instances and 
instance threshold instances using the Business Process Insight 
Application.

➤ Configure notification emails, HPOM messages and scripts for process 
instance violations using the Notification Administration.
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➤ Use the BPI Server Administration Console to manage the BPI Server 
components.

The individual components of the BPI Server system, and their purpose, are 
more fully described in the “BPI Server Architecture” chapter in the Business 
Process Insight Server Administration Guide.

BPI is intended to help you raise the visibility of your Business Processes and 
better understand integration points between your Business Processes and 
the IT infrastructure. This provides you with improved business data and 
also enables you to make business decisions, based on this data, in a more 
timely manner. For example, understanding the business impact if a 
particular resource is made unavailable. This might not be direct financial 
loss, but other losses, such as reputation, regulation breaches, poor delivery 
times and so on.

Business disruptions such as these, and hundreds more that happen on a 
daily basis, unexpectedly and negatively impact the normal business 
operations of many companies. For example, if you are providing a resource 
and there is a sudden increase in the volume of traffic, perhaps due to a 
marketing promotion, it could have an impact on the network. The 
response time for customers might be seriously compromised, which in turn 
can cause anger, ill-will, and some customers taking their business 
elsewhere. This is not a failure in any of the underlying systems and 
applications, but a failure in the capacity of the system that has an impact 
on your customers.

Using BPI Within Business Service Management

When you install HP Business Service Management (BSM), some BPI 
components are also installed, namely the BPI Modeler and the Process 
Repository. A Process Repository Database is also created as part of the BSM 
installation. In this configuration, you can create Business Processes and 
link the Activities in the Business Process to CIs that represent IT 
operational resources. This then enables you to monitor the health of the 
Business Process and the Activities in the process relative to the IT 
operational resources on which they depend.
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When you install the BPI Server, the BPI Application is added as a new 
component to the BSM Gateway Server that you have configured within the 
BPI Server Administration Console. As a result, a new Process Repository is 
installed on the BPI Server system and the existing Process Repository on the 
BSM Gateway Server is disabled. Communication to the Process Repository 
Database is now from the BPI Server system and the data in the Repository 
Database is synchronized with the ODB. 

The addition of the BPI application enables you to monitor the health of 
your Business Process and its Activities as before; in addition, it enables you 
to:

➤ map business events to Activities in your Business Process to enable you 
to monitor the business impact when there are problems with the 
Business Process.

➤ monitor instances of your Business Process in near-real time.

➤ determine how effective your Business Process is by defining Business 
Process Monitors that measure thresholds that you define.

➤ view and report on the status of the health of your Business Processes.

➤ view detailed information about each process instance in the Business 
Process, the Business Process Activities and the thresholds defined for the 
instances.

➤ model your business’s IT processes and your supporting business 
applications services. It also provides the tools to help you prioritize 
problems, based on business impact and service level compliance.

➤ report on the status of operational services and how they impact your 
Business Processes. 

➤ set service level objectives (SLOs) for the BPI configuration items (CIs), 
which are managed within Business Service Management.

➤ configure alerts, within the Business Service Management SLM 
component, based on the SLOs that have been set on the BPI CIs.

➤ enable reports to be generated, based on the BPI CIs.

➤ use MyBSM components for views of the BPI Process and Monitor data.
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The following sections describe in more detail how you can use the features 
of BPI within BSM for designing, managing and tracking your Business 
Processes:

➤ “Design-Time Integration” on page 40

➤ “Run-Time Integration” on page 41

➤ “Data Samples” on page 41

➤ “SLM and Reporting” on page 43

Design-Time Integration
You design and subsequently deploy your Business Processes and process 
Activities using the BPI Modeler. The features of the Modeler that are 
available to you when designing processes depends on whether you have:

➤ The BPI Server installed

➤ Enabled or disabled tracking individual process instances when defining 
your process.

Note: If you do not have the BPI Server installed, then you do not have 
the option to enable individual process instance tracking within the 
Modeler; the option is disabled.

For details about using the BPI Modeler without and with the BPI Server 
installed, see:

➤ “Modeling with Tracking Individual Process Instances Disabled” on 
page 63

➤ “Modeling with Tracking Individual Process Instances Enabled” on 
page 64
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Run-Time Integration
When you have defined and deployed your Business Processes and Business 
Process Monitors, you can then track and monitor the health of your 
Business Process relative to the status of the IT operational resources on 
which the process Activities depend and on the values of the data being 
captured by the Business Event Handler. 

For details about using the Monitor Definer without and with the BPI Server 
installed, see:

➤ “Monitoring - Tracking Individual Process Instances is Disabled” on 
page 109

➤ “Monitoring - Tracking Individual Process Instances is Enabled” on 
page 111

Data Samples
A data sample, in Business Service Management terms, is 
application-specific data sent from an application, in this case, BPI. In the 
case of BPI, these data samples can be used by Business Service Management 
to show key performance indicators (KPIs), relating to the imported Business 
Process Business Activity and Business Process Monitor definitions. The data 
samples are taken from the values of specific values in the BPI Instance 
database. Data samples are sent from the BPI Server to the Gateway server 
that you configure within the BPI Server Administration Console. For details 
on KPIs, see "Health Indicators and KPIs" in Using Service Health.

Samples are sent on a per group basis to BSM.

BPI sends data samples to Business Service Management by configuring the 
Data Sample settings in the BPI Server Admin Console. Sending data 
samples to Business Service Management enables you to use the BPI 
application to report and view the health of the Business Processes that you 
create. For details on configuring the Data Sample settings, see "Component 
Configuration - HP Business Service" in the Business Process Insight Server 
Administration Guide.
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All the BPI data samples are mapped to the following KPIs within Business 
Service Management:

➤ backlog (600)

The data sample for this KPI is taken from the active value of the Business 
Process, Business Process Activity, or Business Process Monitors.

➤ business impact (602)

This KPI shows the overall health of the Business Activities in the Business 
Process within Business Service Management. It is based on the number of 
blocked, at risk and healthy instances reported in the Business Process 
Insight data samples. This KPI applies to processes only.

➤ business performance (631)

The data sample for this KPI is taken from the duration of a Business 
Process, Business Activity, or Business Process Monitor.

➤ value (1311)

The data sample for this KPI is taken from the Process Activity and Process 
Monitor values.

➤ volume (1050)

The data sample for this KPI is taken from the throughput value (Volume) 
as calculated as part of the Business Process, Business Activity, or Business 
Process Monitor statistics.

These data samples include as much information as is possible to give the 
KPI context. In the case of the business health for a Business Process, the 
health of the specific Business Process is reported. When reporting the 
overall health, any Groups that you have defined in the Monitor Definer are 
ignored, it is the overall monitor statistic that is reported.

The time interval between data samples can be configured using the Data 
Sample send interval (seconds) parameter in the BPI Server Administration 
Console.

If you have not modified the BSM configuration, Service Health is 
configured to show KPIs (Backlog, Volume, Value, Business Performance, 
and Business Impact) based on the process value from your process 
definition. 
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To add or modify a KPI, complete these steps:

 1 Select Admin > Service Health > View Management > Ci Indicators.

 2 In the CI Types panel, navigate to the Business Process Activity that you 
want to modify.

You can then add or modify a KPI that you want to show within Service 
Health.

There are a range of KPIs that are available for you to configure as objectives 
for your Business Processes.

SLM and Reporting
The data samples sent to Business Service Management are written to an 
offline data repository.

The Business Service Management Service Level Management (SLM) 
component uses the data stored in the offline data repository as a source for 
building Service Level Agreements and setting Service Level Objectives, and 
for creating reports.

In terms of Service Level Management, you can:

➤ enable service level objectives (SLOs) to be set for the BPI configuration 
items (CIs), which are managed within Business Service Management.

➤ configure alerts, within the Business Service Management SLM 
component, based on the SLOs that have been set on the BPI CIs.

Refer to the Business Service Management Service Level Management 
documentation for information about setting Service Level Objectives.

In terms of reporting, you can configure the Business Service Management 
Report Administration component to generate reports based on the BPI CIs.

Refer to the Business Service Management documentation related to custom 
reporting and alerting for more information. 
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Tasks

How to Manage User Permissions

User permissions determine what operations a user can perform in the 
Business Process Insight application and administration pages. User or 
group permissions can be set by assigning a predefined role or by granting 
individual permissions on specific resources. The predefined roles relevant 
to Business Process Insight are described in the subsections below. 

BSM enables you to fine tune user permissions by applying permissions at 
the resource level. All of the resources on which permissions can be applied 
have been identified and categorized in a hierarchical tree, representing the 
BSM platform. You can restrict which BPI processes BSM users are able to 
view in the BPI application. BPI-specific resources are described in the 
subsections below.

The user’s permissions in a particular session within BSM are determined by 
the user’s login and authentication. User permissions are set up and 
maintained on the User Management Administration page at Admin > 
Platform > Users and Permissions > User Management. For information 
about the related workflow, see Platform Administration. Permission changes 
go into effect the next time the user logs in.

The following sections describe the BPI and BSM permissions:

➤ “Business Process Insight Roles and Operations” on page 45

➤ “BSM Predefined Roles Relevant to Business Process Insight” on page 46
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Business Process Insight Roles and Operations
Within the Business Process Insight context, the following roles and 
associated operations are available:

Role Operations that can be granted

BPIAdministrator Full Control of all BPI processes. a

a. Due to the sensitive nature of User Data and to minimize the possibility of ac-
cidentally granting access, only the (BSM) Administrator has User Data access
(Full Control permission)

BPIUser View all deployed BPI processes.

BPIRestrictedViewUser View only those deployed BPI processes to which 
View permission has been granted.

To grant permission to view a process:

1  Select Admin > Platform > Users and Permissions 
> User Management. 

2  Highlight a group or user in the groups and users 
pane and select the Permissions tab.

3  Under Context, select Business Process Insight.

4  Open the Process Definitions folder to see the list 
of BPI processes.

5  Select the required process, and then select the 
Operations tab. 

6  Check the View check box and click Apply 
Permissions to confirm. 

You must grant View permission for each process 
that you wish the user to be able to view in the BPI 
Application.

NOTE: BPIAdministrator and BPIUser roles by 
definition already have View permissions for all 
processes. 

Inherit Enabled for selected Resources. When enabled, 
select the check box for the operation to be 
inherited to all the child resources within the 
selected resource.
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BSM Predefined Roles Relevant to Business Process Insight
Users and groups can be created and used to manage access to Business 
Process Insight resources. However, BSM has these built-in roles that are 
relevant to BPI. 

Role Operation

Superuser Full Control on all BPI resources listed in the 
previous table.

Administrator Add on the application resource and Full Control on 
any application instances added.

System Modifier View and Change on all BPI resources listed in the 
previous table.

System Viewer View on all BPI resources listed in the previous 
table. 
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Reference

Configuration Items Stored in the ODB

The following table describes the BPI data that is stored in the ODB as a 
result of the synchronization. This sharing of information between BPI and 
Business Service Management enables Business Service Management to 
access the BPI data from the ODB. The BPI data is stored in the ODB as a 
configuration item (CI) of several types. For more information about CI 
types, see the "CI Type Manager" chapter in the Modeling Guide.

Following are the BPI CI types:.

CI Type Description

BusinessProcess 
(business_process)

Stores the Process Name and Process Description 
as entered using the BPI Modeler.

A business_process CI is created for each 
Business Process in BPI. 

Data samples are sent to BSM for each 
business_process CI.

business_process CIs are logical CIs.
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Note that the CI Types have changed for 9.00. The following table shows the 
changes between the 8.00 and 9.00 CI Types:

BusinessActivity 
(business_activity)

Stores the Activity Name and Description as 
entered using the BPI Modeler.

A bpi_activity CI is created for each Activity in 
all Business Processes.

Data samples are sent to BSM for each 
business_activity CI.

bpi_activity CIs are logical CIs.

Business Process Scope 
(business_process_scope)

Stores the Monitor Name, Description, Type, 
Units, Collection Interval, Threshold Operator, 
Server Name and Instance Threshold limits 
(where specified) as defined with BPI.

Monitor data samples are sent for each Business 
Process Monitor.

The value for the bpi_monitor_type attribute 
defined on this CI identifies the Business Process 
Monitor type. It can have one of the following 
values:

➤ Duration

➤ Value

➤ Custom

8.00 CI Type 9.00 CI Type

bpi_process_monitor business_process

bpi_step_monitor

bp_step

business_activity

bpi_monitor > bpi_duration_monitor

bpi_monitor > bpi_value_monitor

bpi_monitor > bpi_custom_monitor

business_process_scope

CI Type Description
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As with any synchronization, or sharing of data, there must be a master 
copy of the data to synchronize from. In this case, the BPI Server holds the 
master copy of the data. This means that any changes to the data within the 
Business Service Management UI Framework are overwritten by BPI when 
the data models are synchronized. If you delete a CI in the ODB, it is created 
again when the data models are synchronized.

Data synchronization occurs as a result of any one of the following:

➤ Business Process is deployed, redeployed, or undeployed.

➤ Business Process Monitor definition is created, modified or deleted.

➤ Related configuration changes are made within the BPI Server 
Administration Console.

➤ a synchronization is forced using the Synchronize with the CMDB option 
in Admin > Business Process Insight > Process Intervention.

As part of the synchronization process, BPI creates mapping tables, which 
are used to provide the references between the BPI data and the 
corresponding CI within the ODB. The BPI unique identifiers for the data 
(GUIDs) are mapped to the ODB GUIDs for the BPI-related CIs. This enables 
BPI to send data samples to Business Service Management as well as manage 
the synchronization process.

Viewing BPI CIs Within BSM
To see the CIs defined within Business Service Management:

 1 Select Applications > Service Health > Service Health.

 2 In the 360o tab, select Business Processes from the Hierarchy drop-down 
list.

This is the list within Business Service Management that groups together 
all BPI Business Processes.

 3 Select a Business Process listed under Business Processes, for example, 
Phone Provision.

The Phone Provision Business Process and its Activities are listed.

 4 Select the Top View tab.
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The root view for the Phone Provision CI and the dependent Activity CIs 
are shown in the graphical view.

The following figure shows the Business Process named Phone Provision 
and its associated Activities. 

In this example, you can see that there are also other processes deployed 
and you also see these other processes within the Business Processes.
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Part I

BPI Administration
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2
General Administration

This chapter includes:

Concepts

➤ BPI Administration Overview on page 54

Tasks

➤ How to Administer BPI on page 56
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Concepts

BPI Administration Overview

This chapter provides an overview of the key features of the BPI 
Administration pages and explains how to use BPI to track and monitor 
your Business Processes. 

The BPI Administration pages enable you to track all the Business Processes, 
Business Process Monitors and Monitor Thresholds that you have defined 
and deployed, including their associated data. You can also track the status 
of the IT operational resources that the Business Process relies on.

The BPI Administration pages can be accessed from the following menu 
option:

Admin > Business Process Insight

Note: The Business Process Insight Administration pages are available when 
you have installed a valid BPI license and the BPI Server. If you have not 
installed a BPI license, you can still access the Modeler with limited 
functionality. For more details on what limited functionality is available, see 
Chapter 3, “Modeler Management.”

The BPI Administration pages enable you to:

➤ map business events to Activities in your Business Process to enable you 
to monitor the business impact when there are problems with the 
Business Process.

➤ monitor instances of your Business Process in near-real time.

➤ determine how effective your Business Process is by defining Business 
Process Monitors that measure thresholds that you define.
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➤ model your business’s IT processes and your supporting business 
applications services. It also provides the tools to help you prioritize 
problems, based on business impact and service level compliance.
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Tasks

How to Administer BPI

The following steps describe how to administer BPI.

➤ “Create the Business Process Definitions, Data Definitions and Event 
Definitions” on page 56

➤ “Define Business Process Monitors and Monitor Instance Threshold 
Definitions for Deployed Processes” on page 57

➤ “View, Print, and Manage the Contents of the Process Repository Schema” 
on page 57

➤ “Use the Process Intervention to Manage Process Instances and Data 
Instances” on page 57

➤ “Configure the Notifications that You Want to Generate” on page 57

 1 Create the Business Process Definitions, Data Definitions and 
Event Definitions

You use the Modeler to create your Business Process definitions, Data 
definitions and Event definitions. The Modeler is a graphical editing tool 
and provides a unified interface for all the definition types that you are 
creating.

The Modeler has two modes of operation, according to whether or not 
you have a valid BPI license and have installed the BPI Server. For more 
information, see Chapter 3, “Modeler Management,” the Business Process 
Insight Integration Training Guide - Modeling Processes and the Modeler 
online Help.
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 2 Define Business Process Monitors and Monitor Instance 
Threshold Definitions for Deployed Processes

You use the Monitor Definer to define Business Process Monitors and 
Monitor instance Threshold definitions for deployed processes.

These Monitors and instance Thresholds are then used to gather statistical 
information, and instance thresholds relating to the health of your 
Business Processes. The results are shown using the BPI Application pages. 
For more information, see Chapter 4, “Monitor Definer,” the Business 
Process Insight Integration Training Guide - Defining Business Monitors, and 
the Monitor Definer online Help.

 3 View, Print, and Manage the Contents of the Process 
Repository Schema

Use the Repository Explorer to view, print and manipulate the contents of 
the Process Repository schema. The Process Repository schema is a set of 
database tables that hold the data for the Business Processes that you have 
defined and modeled using the BPI Modeler. For details, see Chapter 5, 
“Process Repository Explorer.”

 4 Use the Process Intervention to Manage Process Instances 
and Data Instances

In specific circumstances, you can use the Process Intervention Client to 
access processes that you have deployed in order to modify or delete 
Process instances and their associated Data instances. For details see 
Chapter 6, “Process Intervention.”

 5 Configure the Notifications that You Want to Generate

Use the Notification option to configure the notifications that you want 
to be generated for the Business Processes that you have deployed and the 
Business Process Monitors and Monitor instance Thresholds that you 
have defined. For details see Chapter 7, “Notification.”

Once configured, the Notification Server can then notify you of the 
process impact, out-of-sequence and monitor threshold violations that 
are generated by the Business Impact Engine.
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Modeler Management

This chapter includes:

Concepts

➤ Modeler Overview on page 60

➤ Design-Time Integration on page 62

➤ Process Repository on page 66

Tasks

➤ How to Model Your Business on page 71

➤ How to Manage the BPI Modeler on page 72

Reference

➤ Coercion Rules on page 92

➤ Expression Grammar in Process, Data, and Filter Definitions on page 96
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Concepts

Modeler Overview

This chapter describes tasks that are specific to the management of your 
Process definitions using the Modeler. 

For information and help about using the BPI Modeler to create and deploy 
definitions, including examples and scenarios, see Business Process Insight 
Integration Training Guide - Modeling Processes.

The BPI Modeler is a client-side BPI component that you use to create your 
Business Process definitions, Data definitions and Event definitions. It is a 
graphical tool, with a unified interface for all the definition types that you 
are creating. The modeler is accessed from Admin > Business Process Insight 
> Modeling tab > BPI Modeler.

Once BPI has been enabled in Server Deployment, the Modeler can be used 
in the following two ways:
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Partial Modeler capabilities
Without a BPI license (and whether or not the BPI Server is installed), you 
can create and model Business Processes and map process Activities to IT 
infrastructure CIs. However, the ability to create and modify Event and Data 
definitions is disabled. Tracking individual instances of the Business Process 
is not allowed and some options related to this in the Modeler interface are 
not enabled. You can delete any previously created data and event 
definitions, but editing the same or adding any new data or event 
definitions is not supported.

Note: BPI must be enabled on the BSM Server Deployment page to be able to 
access the Modeler. If BPI is disabled, the Business Process Insight 
Application is deactivated. For information on accessing and enabling/
disabling BPI on the Server Deployment page, see “Using BPI Within 
Business Service Management” on page 38.

Full Modeler capabilities
To use the full capabilities of the Modeler, you need BPI enabled on the BSM 
Server Deployment page, a valid BPI license installed, and the BPI Server 
installed and integrated with BSM. (Application licenses are installed 
through the Business Service Management License Management page at 
Admin > Platform > Setup and Maintenance > License Management. For 
licensing information, see Platform Administration.)

When you have access to the Modeler’s full functionality, you can create 
and edit Business Process definitions, Data definitions and Event 
definitions. And when your definitions are complete, you can use the 
Modeler to deploy them to the Business Impact Engine. 

In addition, you can import Business Process Execution Language (BPEL) 
into the Modeler and use the BPEL definition as the start point of your 
Process definition.
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A local repository cache in the BPI Modeler holds Process definitions, 
including Data and Event definitions until they are saved in the Process 
Repository schema as a set of database tables. Definitions might also need to 
be redeployed. The tables are managed by the Process Repository, which is 
described in “Process Repository” on page 66. 

Design-Time Integration

You design and subsequently deploy your Business Processes and process 
Activities using the BPI Modeler. The Modeler is a design-time tool, 
therefore any changes that you make do not affect a runtime system until 
you have deployed the changed definitions

The features of the Modeler that are available to you when designing 
processes depend on whether you have:

➤ installed a valid BPI application license and the BPI Server. 

➤ enabled or disabled tracking individual process instances when defining 
your process.

Note: If BPI is not licensed, you do not have the option to enable 
individual process instance tracking within the Modeler; the option is 
disabled. 

This section includes the following topics:

➤ Modeling with Tracking Individual Process Instances Disabled on page 63

➤ Modeling with Tracking Individual Process Instances Enabled on page 64
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Modeling with Tracking Individual Process Instances 
Disabled
This section describes the concepts for modeling Business Processes, 
including mapping IT operational resources to process Activities when the 
BPI application is not licensed or you have not enabled individual process 
instance tracking.

The following diagram shows design-time process instance tracking 
disabled.

The following steps describe the communication between Business Service 
Management components as shown in the diagram above:

➤ You create your Business Processes using the Modeler. When you deploy 
the Business Processes, the Modeler completes its consistency checking on 
the Business Process. 
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➤ The Processing Server forwards the RMI command to the Process 
Repository, which manages how the process models are stored in the 
Process Repository Schema, including synchronizing the models with the 
ODB.

➤ As part of creating your Business Processes, you can map IT operational 
resources, which are defined as CIs within the ODB by applications such 
as SiteScope, to the Business Process Activities. BSM can then evaluate the 
status of the IT operational resource CIs for later presentation within the 
Business Process Diagram in Service Health. 

Modeling with Tracking Individual Process Instances 
Enabled
This section describes the steps for modeling Business Processes when the 
BPI application is licensed and the BPI Server is installed, and you have 
enabled individual process instance tracking. These steps extend the 
modeling steps described in Modeling with Tracking Individual Process 
Instances Disabled on page 63.
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The following diagram shows design-time process instance tracking enabled.

The following steps describe the communication between Business Service 
Management components when you have chosen to model processes in 
order to track and monitor individual process instances, as shown in the 
diagram above. You can model Business Processes and map IT operational 
resource CIs to the process Activities as described in “Modeling with 
Tracking Individual Process Instances Disabled” on page 63. 
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In addition, you can model processes to track individual process instances as 
follows:

➤ Create your Business Process using the BPI Modeler and select the option 
to Track individual process instances. 

➤ Create the Data Definitions, progression rules, Event Definitions and 
Event Subscriptions for your Business Processes.

➤ Deploy the Business Process, at which point the Modeler completes its 
consistency checking on the Business Process. The Modeler sends the 
definition to the Gateway Server (or load balancer) using RMI over HTTP 
and the Gateway Server sends the Model definitions to the Process 
Repository on the BPI Server using RMI.

➤ The Process Repository manages how the process models and their 
components are stored and synchronized in the Process Repository 
Schema; this includes creating the Java class files and the Process Instance 
tables in the BPI Instance database.

➤ When the Business Process is successfully deployed, you can define 
Monitors and instance thresholds for the Business Process. These 
definitions are stored in the BPI Instance database and are synchronized 
with the ODB.

Process Repository

The Repository schema and the Process Repository are the server-based 
components that manage the data as it is entered through the Modeler. The 
details that you enter using the BPI Modeler are held in the BPI Process 
Repository, which is a series of tables defined in the BPI database. Basically, 
the BPI Modeler is the graphical tool for creating and viewing the model 
data held in the Process Repository. These components manage the model 
definitions in the database and ensure that the details are consistent and 
deployable. 
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If the Process Repository finds inconsistencies, it reports them using the 
ToDoList within the Modeler. The ToDoList is associated with each 
definition. The ToDoList reports on the consistency of the definition and 
keeps track of all the outstanding issues and tasks required to ensure that the 
definition is consistent and complete. A definition cannot be deployed 
unless it is consistent.

Note: There can be only one BPI Modeler connected to a BPI Server 
(specifically the BPI Process Repository) at any one time; otherwise, when 
more than one change is made at there same time, only the last change is 
saved.

If you want to relate the Activities in the Business Processes that you create 
to the status of the underlying operational services in your organization, 
you can use Business Service Management to map the Business Processes 
and Activities CIs that are created from the process and Activities that you 
define in the Modeler.

The deployer component of the Process Repository deploys the different 
definitions to their destinations as follows:

➤ Process definitions, including any imported BPEL definitions, are 
deployed to the Business Impact Engine as compiled Java code.

➤ Data definitions are deployed to the Business Impact Engine as compiled 
Java code.

➤ Event definitions are deployed to the Business Event Handler to be 
mapped to events from underlying business applications.

In addition, there is a Repository Explorer, which is a Web-based interface 
that you can use to view and manage some aspects of the data stored in the 
Repository Database. For more information, see Chapter 5, “Process 
Repository Explorer”.

This section includes the following topics:

➤ Business Process Monitors on page 68

➤ Databases on page 68
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➤ Setting Modeler Options on page 69

➤ Repository Explorer on page 70

Business Process Monitors
A Business Process Monitor is a business measurement that is meaningful to 
your business and is an additional indication of the health (in business 
terms) of the processes that you are tracking.

You create Business Process Monitors for your processes using the Monitor 
Definer. The Monitor Definer is a Web-based interface that you access as 
follows:

Admin > Business Process Insight > Monitor Definer

Full details of the Monitor Definer and using it can be found in the Monitor 
Definer online Help and Business Process Insight Integration Training Guide - 
Defining Business Process Monitors. 

Databases
When you install Business Service Management, you configure the Process 
Repository schema for BPI. This schema is used to maintain the data for the 
Process Definitions that you create using the BPI Modeler.

If you subsequently install the BPI Server, you configure the BPI Server 
schema. This schema is used to maintain the data relating to of all the 
Process and Data instances that BPI is tracking, plus Business Process 
Monitor instances and their related instance threshold data. In addition, the 
Process Repository schema is extended to maintain data for the Data and 
Event that you create using the BPI Modeler.

The BPI Server schema is also used to maintain status information relating 
to all the Process and Data instances that it is tracking, plus Business Process 
Monitor instances and their related statistical and threshold data.
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BPI CIs for Business Process CI types are stored in the ODB.

Note: When creating Event definitions for BPI, make sure that the data you 
are defining for the Business Events is within the range permitted by the 
database that you are using.

Setting Modeler Options
Use the Modeler Options dialog to change the configuration of the BPI 
Modeler. You select Options from the File menu option as follows:

File > Options

You can also click Options on the BPI Modeler logon dialog to change the 
Modeler configuration.

Use Options to set the details related to the background grid within the 
Process Definition Editor. Using the snap to grid option enables you to align 
the Activities in your process more accurately and reduces the possibility of 
moving Activities to bring them into alignment, which could require you to 
redeploy the process.

There are three settings that you can edit:

➤ Snap to grid

Select the check box to activate the Snap to Grid option.

➤ Show grid

Select the check box to show the grid lines on the Process Editor page.

➤ Grid size (pixels)

Enter the number of pixels for the grid size that you want to use. The 
changes take effect immediately, but do not impact the location of the 
existing Activities on the Process diagram.
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Repository Explorer
The Repository Explorer is a Web-based application that enables you to view, 
print and manipulate the contents of the Process Repository. The Process 
Repository holds the data for the Business Processes that you have defined 
and deployed using the BPI Modeler.

Specifically, the Repository Explorer enables you to:

➤ Browse and print definitions.

➤ Export the latest versions of a definition.

➤ Export the latest version of all definitions.

➤ Remove definitions and move them to the Recycled folder.

➤ Restore a definition that has been deleted using the BPI Modeler or 
Repository Explorer.

➤ Permanently remove deleted definitions from the Recycled folder.

➤ Undeploy and permanently remove definitions that have completed from 
the Recycled folder.

For more details of the features of the Repository Explorer, see Chapter 5, 
“Process Repository Explorer.”
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Tasks

How to Model Your Business

There is a methodology for how you model your business to determine the 
answers to business impact questions. The methodology also provides 
guidelines for creating processes and identifying the Data and the Event 
definitions required to provide business information that you need.

Following is a suggested order in which to carry out the tasks of designing a 
Business Process model.

To design a Business Process model:

 1 Design the Business Process model

Use the BPI Modeler to draw out your high-level Business Process.

Identify the Business Processes you want to track for business impact.

 2 Define the data to be maintained for each process instance

Define the data attributes that you wish to maintain for each process 
instance.

Define the data that you need to store in the business model to ensure 
that you get the correct business impact information.

 3 Define the progression rules

Define how a process instance progresses as the data attributes change 
state during the life of the process instance.

 4 Define the data events

Define the events that you expect to receive from the underlying 
application systems. Define the name of each event and its data content.

You then need some consultation with the applications people to see if 
these events can be generated as you expect. For more details on how to 
generate these actual events refer to the BPI Integration Training Guide - 
Business Events.
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 5 Deploy the process and test it

Use the BPI Modeler to deploy the process definition into the Business 
Impact Engine. You can use tools such as the Process Simulator 
(contributed utility in the contrib directory) and the BPI Application to 
test out the behavior of your process, before connecting in the actual 
application system adapters to generate the real data events. For details on 
the contributed utility, see the HP Business Process Insight Using the HP BPI 
Process Simulator Guide, located n the contrib directory as procsim.pdf.

 6 Define how you want the impact information presented to you

This is just a suggested order for defining processes. You might find that 
your preference is to interchange steps 3 and 4, and define the events before 
defining the progression rules. It does not matter. Each person can develop 
the order that best suits them. But you can use the above steps as your 
starting point.

Be aware that this process is iterative. You will revisit steps (perhaps multiple 
times) as you discover more about your process and as you determine more 
about the data that comes from the underlying application systems.

How to Manage the BPI Modeler

The following are the management tasks that you can complete using the 
BPI Modeler:

➤ “Starting and Stopping the Modeler” on page 73

➤ “Deploying Processes and Dependencies” on page 75

➤ “Redeploying a Definition” on page 77

➤ “Running Deployed Processes” on page 77

➤ “Undeploying Definitions from the BPI Modeler” on page 78

➤ “BPI Modeler Log File” on page 79

➤ “Exporting and Importing” on page 80

➤ “Using TransactionVision Events in the Modeler” on page 85

➤ “Linking Activities to IT Operational Resource CIs” on page 89
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➤ “Copying Process Definitions” on page 89

➤ “Copying Properties Between Data and Event Definitions” on page 90

➤ “Exporting Definitions to Recover Unsaved Changes” on page 91

➤ “Exporting Definitions to Recover Unsaved Changes” on page 91

Details of the tasks for creating Business Processes definitions, Data 
definitions and Event definitions are contained in the Modeler online Help, 
which can be accessed from the Modeler Help menu option. 

Starting and Stopping the Modeler

To start the BPI Modeler, complete the following steps:

 1 Select Admin > Business Process Insight.

You are presented with a tabbed page that includes a tab for Modeling. 

 2 Select the Modeling page.

 3 Click the icon for the Modeler on the page and wait for the Modeler to 
launch as a Java Web Start application.

You might be asked to confirm that you want to download the files to 
open the Modeler within your web page. If required, confirm that you 
want the download to proceed.

The BPI Modeler opens.
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The following figure shows an example of the layout of the Modeler when 
you open it.

If you have installed the BPI Server component, you also need to make sure 
that the Process Repository component is started on the BPI Server system 
and the Infrastructure settings are completed for BPI (access the 
infrastructure settings from: Admin > Platform > Setup and Maintenance > 
Infrastructure settings > Business Process Insight).

Use the BPI Server Administration Console on the BPI Server system to start 
the Process Repository as described in “Starting and Stopping the BPI Server 
Components” in the Business Process Insight Server Administration Guide.
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To stop the BPI Modeler, select File > Exit in the Modeler window. You are 
prompted to save any currently unsaved changes to the models that you 
have been editing.

If you logout of BSM and leave the Modeler running, the Modeler no longer 
has access to the Process Repository. In this case, when you next try to use 
the Modeler, you are prompted to save any currently unsaved changes to the 
models that you have been editing and the Modeler closes.

Deploying Processes and Dependencies

When you have completed the development phase of your process 
definition, you can deploy the process to the Business Impact Engine. The 
Engine then creates instances of the process and tracks these instances 
according to the events that are received from the underlying systems and 
the status of any associated IT operational resources.

This section explains how to deploy a Process and any associated Data 
definitions and Event definitions.

Before deployment, you have either created a new definition in the 
repository that the Business Impact Engine does not know exists, or have 
created a new undeployed revision of a definition by making changes to it.

To deploy the Process, Data and Event definitions to the Business Impact 
Engine, complete the following steps:

 1 Open the Modeler.

 2 Select the Process from the left-hand Navigator pane.

 3 Select File > Deploy. 

You are prompted to save all currently unsaved changes, if you have not 
saved them already. Click Yes.

The Deploy dialog opens, which lists the definitions that are to be 
deployed as a result of issuing this command.
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If you have previously deployed the process, the Deploy dialog lists the 
definitions that are to be deployed. The dialog also indicates that a 
previous version of the process is already deployed. In this case, you need 
to select one of the following options for deployment:

➤ Replace the existing definition.

This replaces the definition and retains all the instances of the 
definition. Any statistical information collected for the instance is also 
retained.

➤ Deploy the definition with a different name.

This enables you to deploy the definition using a different name, and 
therefore preserving the instance information for the existing 
definition. If you select this option, select Next to make a copy of the 
definition.

The Modeler checks the state of all the definitions that you selected to 
deploy. A dialog box appears to prompt you to confirm that you want to 
deploy all currently undeployed changes to the Business Process and all 
its dependencies. 

 4 Click Deploy to confirm your request and continue with deployment.

The process and all its dependencies (Data and Event definitions) are 
deployed to the Business Impact Engine and appropriate CIs are created 
in the ODB. A dialog lists all the definitions that are deployed.

 5 Click Close when the Deployer indicates that it has finished deploying the 
definitions.

You have now deployed the process and its dependencies.

The process (and all other deployed definitions) change status in the 
Navigator pane, indicated by the icon. 
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You can also deploy individual definitions, for example, you can deploy an 
Event definition. In this case, the Event definition is deployed and if 
necessary all the Event definition's parent definitions are deployed, plus all 
the Data definitions that depend on the Event definition. If you deployed a 
Data definition, the BPI Modeler deploys that Data definition, plus any (as 
yet undeployed) Event definitions that the Data definition is subscribed to, 
and similarly the parent Process definition.

The BPI Modeler deploys definitions where there have been changes, it does 
not redeploy definitions that are unchanged and already deployed.

Redeploying a Definition

When you redeploy a process definition through the BPI Modeler, any 
existing process and data instances are preserved and migrated to the new 
definition.

You can remove definitions from your BPI system using the Intervention 
Client. See Chapter 6, “Process Intervention,” for more information about 
the Intervention Client.

Running Deployed Processes

You can consider your BPI implementation as having three different stages. 
The design-time or modeling stage, the deployment stage and the run-time 
stage.

The run-time stage is where the definitions that you have developed and 
deployed are progressed by the events received through the Business Events 
Handler. It is also where the business manager tracks their Business Process, 
or processes, through the BPI Application.

The BPI Modeler does not play any part in the run-time aspect of the BPI 
system. However, any changes that are made to definitions and that are 
deployed result in new and revised processes being available for tracking.
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Undeploying Definitions from the BPI Modeler

There are circumstances where you might want to undeploy one or more of 
your Business Processes. In addition, you might need to undeploy individual 
definitions from the BPI Process Repository; for example, you might need to 
undeploy Event definitions when an Event becomes out of date. 

Note: If you undeploy a definition, existing instances using the definitions 
are still running in the Business Impact Engine until completion, or until 
the Instance Cleaner deletes them. New instances of any undeployed 
definitions are no longer created. The definition is removed by the Model 
Cleaner as described in the "Modifying the BIE Model Cleaner Settings" in 
the Business Process Insight Server Administration Guide.

You can undeploy a definition that is referenced by another definition, so 
you need to make sure that you maintain consistency within your Business 
Processes.

To undeploy a Process, Data or Event definition:

 1 Open the Modeler.

 2 Select the definition that you want to undeploy from the Navigator pane.

 3 Select File > Undeploy and follow the instructions provided.

The status of the definition changes from Yes to No, but can be deployed.

You are presented with an Undeploy dialog where the definitions that will 
be undeployed are listed.

 4 Click the Undeploy button to continue. The Deployed? status of the 
definition changes from Yes to No, but can be deployed.

The Summary Window in the BPI Modeler now shows the revised status of 
the definition.
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If you have modified a definition, it is shown as not being deployed; 
however, an earlier version is deployed. If you want to know what the 
deployed status of definitions is (as opposed to a development status), use 
the Repository Explorer, see Chapter 5, “Process Repository Explorer”.

You can also use the Intervention tool to show you the status of the 
definitions. The Intervention tool is described in Chapter 6, “Process 
Intervention”.

BPI Modeler Log File

There is a Modeler log file located on the machine where the Browser is 
running in the user directory as follows: 

<user_dir>\.hp_bpi

The following log files are the most significant files:

hpbpi_modeller0_0.log

This log file is the most useful.

hpbpi_modeller_m.log

This log file is less informative, but does contain communication errors, if 
they occur. 

In addition, there are Modeler related log messages contained in the Process 
Repository log file. If the BPI Server is installed, the Process Repository log 
file is located as follows:

bpi-install-dir\data\log\bia_model_repository0_0.log

If the BPI Server is not installed, the Process Repository log file is located as 
follows:

bsm-install-dir\log\bpi_process_repository

The log files are text files that you can open using a text editor. Use the log 
files to identify problems with your BPI system.
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You can also modify your Java settings to show the Java console while the 
Modeler is running. You should do this only if you are trying to isolate a 
problem. You can access the Java Console options as follows:

Start > Programs > Settings > Java > Advanced > Java Console

Exporting and Importing 

The BPI Modeler has an option to enable you to export and import Business 
Processes, including their dependencies (any Data and Event definitions) to 
a .zip file that contains XML files. This enables you to create Business 
Processes using one Modeler for testing and then move the processes to a 
production system when they are fully verified. You can also export and 
import any Business Process Monitor definitions that you have defined for 
your processes as described in “How to Export and Import Monitor 
Definitions” on page 121.

You can also export a process definition in order to make a copy of the 
process, or import definitions, including BPEL definitions using the import 
option.

You use the File > Import Definitions and File > Export Definition menu 
options from the BPI Modeler to export and import your Business Process 
definitions.

Make sure that you have a naming policy for Process, Data and Event 
definitions across your organization to minimize the possibility of a name 
clash when the Business Processes are imported for deployment to the 
Business Impact Engine. You have the option to rename your definitions 
when you import them; however, you might prefer to have a standard 
naming scheme.

Exporting Process Definitions

Use the File > Export Definition option to export the Business Processes to an 
XML .zip archive file. When you have exported the file, you can copy the 
file to the system where the BPI Modeler that you want to import the file to 
is installed. Finally, use the Import option to import the Process definitions 
as described in section “Importing Process and BPEL Definitions” on 
page 81.
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To export a definition, complete the following steps:

 1 Select the definition that you want to export from the Navigator pane.

 2 Click File > Export Definition.

 3 Specify the directory and file name where you want to create the .zip file 
for the definition.

 4 Click Export.

 5 Close the Export Definition dialog.

 6 Copy the file to the target system.

 7 Click File > Import Definitions in the Modeler on the target system to 
import the definition. When the Process definitions are successfully 
imported they are shown as being undeployed in the BPI Modeler.

 8 Make any necessary amendments to the definition

 9 Click File > Deploy to deploy the definition to the target BPI Server 
system.

Importing Process and BPEL Definitions

You can use the BPI Modeler to import Process definitions and Business 
Process Execution Language (BPEL) definitions. You import a zip archive file 
containing a previously exported definition from the Modeler, or a BPEL 
process file. In order for the Modeler to recognize the files, the zip archive 
file must have a file extension of .zip, and the BPEL process file a file 
extension of .bpel. If your BPEL process file has a .xml file extension, you 
can rename it to .bpel before importing it into the Modeler.

To import a previously exported Process, Data or Event definition, or to 
import a BPEL file, complete the following steps:

 1 Select File > Import Definitions.

The Import Definitions dialog opens.
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 2 Navigate, or browse, to the location of the previously exported definition 
file you want to import and click Open.

The file must be either a zip archive file or a BPEL process file. 

➤ If you import a zip archive file, the content of the Description field 
that you entered in the Modeler to describe the process is displayed as 
the Description.

➤ If you import a BPEL process files, the name of the process is displayed 
in the Description field. If this information is not available in the file 
to be imported a suitable message is displayed instead, for example: 
This BPEL file contains an un-named process.

 3 Click Next to move to the next option. 

The next step that is displayed in the Import Wizard depends on the type 
of file you are attempting to import: a zip archive file containing a 
previously exported definition, or a BPEL definition file.

You are presented with a dialog that lists the content of the definition file 
that you are importing. 

From this dialog, you can:

➤ import a listed definition and overwrite any existing definition of the 
same type that has the same name. 

➤ create a new copy of a listed definition or rename an existing 
definition. For this option, you provide a new name for the definition 
in the Save As column.

➤ choose not to import a listed definition.

When you have tailored your import requirements, click Import.

 4 Click Close to complete the import.

When the Process definitions are successfully imported they are shown as 
being undeployed in the BPI Modeler. You now need to deploy the imported 
Processes and their dependencies to the target BPI Server system.
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Importing BPEL Processes

You can use the BPI Modeler to import Business Process Execution Language 
(BPEL) definitions.

You import the structure of a BPEL definition using the BPI Modeler; 
however, you cannot import the associated BPEL logic. When you have 
imported the BPEL definition, you can use the structure as the basis of a 
Business Process, which you can then modify to suit your reporting and 
tracking requirements. You also need to create the Data and Event 
definitions required to track the imported BPEL definition.

Details of importing BPEL definitions, and the options available for tailoring 
the definitions when importing them are provided in Business Process Insight 
Integration Training Guide - Importing BPEL.

If you are importing a BPEL process file, you are presented with an Import 
Definitions dialog that presents a number of options that you can use to 
determine how the BPEL file is imported and also how the resulting process 
is presented within the BPI Modeler.

To import BPEL processes, complete these actions as follows:

 1 Replace existing Process definition:

You can either create a new Process definition using the imported BPEL, 
or you can replace a process that already exists within the Process 
Repository. To do this, either select the option to create a new Process 
definition, or select the name of the Process definition that you want to 
replace.

The default option presented is to create a new process. This means that if 
you import a BPEL process more than once, you create multiple copies of 
the process, all with the same name. If you have modified the Name 
Generator file to specify your own naming convention, then the option 
to create a new process is the option you need. You can also select a 
process from the drop-down list provided, but you need to make sure you 
are not overwriting a different process definition.
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 2 Include optional parts of the process?  

BPEL provides a wide range of features, not all of which are appropriate 
for monitoring purposes. You have the option to remove some of these 
functions when the BPEL is imported into the Modeler. Specifically, you 
can include, or remove, fault handlers and compensation handlers from 
the imported BPEL. Select or clear the check boxes as appropriate for your 
requirements.

 3 Name generator file:  

The name generator file is optional, but when specified is used as a source 
for building the name of the process and the names of the Activities as 
the BPEL process is imported into the Modeler. If no name generator file 
is specified, a default name is assigned to each Activity and to the process. 
For details of how to use a name generator file for building Activity names 
see the Business Process Insight Integration Training Guide - Importing BPEL.

 4 Process diagram layout  

You can influence how the BPEL diagram is displayed on the Modeler 
canvas when it is imported. This is done by modifying the values of the 
layout attributes as follows: 

 a Grid cell size: The size (in pixels) of the cell border used for each 
Activity on the process diagram. If you have particularly long Activity 
names, you might need to increase the grid cell size to prevent the 
Activity names overlapping other Activities.

 b Gaps between Activities: The size (in pixels) of the gap between the 
Activities on the process diagram.

 c Page border: The size (in pixels) of the border that is created around 
the process diagram. If you intend to expand the process diagram, you 
are advised to create a reasonably sized border for the additional 
Activities. The additional space is added to the left-hand side and 
right-hand side of the diagram and to the top and bottom of the 
diagram.
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 d Minimum page size: The minimum size (in pixels) of the canvas for 
your Process diagram. If you set these values to be very low, the page 
size for your canvas will be the same size as the Process diagram; 
therefore, if your Process diagram comprises only one Activity, the size 
of the canvas will be the same. In this case, you might not leave 
sufficient room to add to or modify your Process diagram.

 5 Click Import to import the new copy of the definition. 

The new copy of the definition appears in the Navigator Pane and the 
import is complete.

Using TransactionVision Events in the Modeler

You can use the Transaction Management editor to define BPI rules and the 
events that are to be sent to BPI. Once these are defined using the 
Transaction Management editor, they are automatically exported to BPI, and 
the Event definitions are available in the BPI Modeler. For details on 
connecting BPI with TransactionVision, see the Business Process Insight Server 
Administration Guide.

The events from TransactionVision that are available in the Modeler can be 
used in any of the Business Processes by updating the Data definition of the 
Business Process to subscribe to these events. 

You can then use these events with any Activity in the Business Process to 
configure the Activity's progression rules.
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The following figure shows using the TransactionVision events in the 
progression rules of the Activity Properties dialog:

You can relate Business Transactions to an Activity using any of the tabs in 
the Activity Properties dialog (right-click on an Activity in the Process 
Editor). The Related Transactions tab displays a filtered list of only the 
TransactionVision Business Transactions that are originating the events to 
which the data object subscribes. TransactionVision event subscriptions are 
created in the same way as you would set up any other event subscriptions. 

If alternatively, you want a more comprehensive list of the Business 
Transactions (Business Transactions could be created by TransactionVision, 
Real User Monitor or Diagnostics) in the ODB, use the Related CIs tab.

For more details on each tab, see the Modeler online help. 
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Linking Activities to TransactionVision 

When events from TransactionVision are used in an Activity's event 
progression rules, the Business Transactions that originated the event are 
automatically linked to the Activity.

If the TranactionVision events are not used in the Activity's progression 
rules, but the Data definition of a Business Process has been updated to 
subscribe to the events, you can manually link the associated Business 
Transactions to one or more Activities of the Business Process.

A single Activity can be linked with one or more Business Transactions. 
Conversely, you can link a Business Transaction to one or more Activities.

The relationship between the Activity and the linked Business Transaction 
CI is persisted in the ODB. These relationships are displayed on the Health 
page. For details, see Chapter 10, “BPI Application Health.”

To link Activities to Business Transactions using the Related Transactions 
tab:

 1 Right-click on the Activity to which you want to link a Business 
Transaction and select Properties. The Activities Properties dialog opens.

 2 Select the Related Transactions tab. The Business Transactions that 
originated from the TransactionVision event are listed.
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 3 Open the Transaction Selector dialog by clicking the Transaction Selector 
icon. 

 4 Select the Business Transaction and click OK.

The Business Transaction is now linked to the Activity.

 5 Follow steps 1 - 4 to link other Activities to Business Transactions.
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Linking Activities to IT Operational Resource CIs

When you configure the Activities in your Business Process using the 
Modeler, there is an option to link the Activity to one or more CIs within 
the ODB.

You edit the Related CIs for a Business Process, and then you redeploy the 
process to commit these CI dependencies to the ODB. For details of linking 
CIs to Business Activities, see the Modeler online Help.

Copying Process Definitions

To make a copy of an existing Process definition, complete the following 
steps:

 1 Complete steps 1 to 5 from the steps in “Exporting Process Definitions” 
on page 80 to export the Process definition.

 2 Select File > Import Definitions.

 3 Select the exported Process definition that you are copying and click Next.

You are presented with an Import Definitions dialog, which presents a 
number of import options and actions. The default action is Import 
Original Definition; however, in this case, you want to make a copy of the 
definition. To do this, you need to select the Create new copy of 
definition action from the drop-down Import Action list provided.You 
can also choose to exclude specific data or event definitions from the 
copy that you are making.

 4 Configure the Import Action on the Import Definitions dialog to make 
the required copy of the definitions that make up the Process definition 
that you are copying.

 5 Double-click the name of each definition in the New Name column of the 
dialog and enter a new and unique name for each definition that you are 
copying. Make sure that you rename the Process, Data and Event 
definitions.

 6 Click Import to import the new copy of the Process definition. The new 
copy of the Process definition appears in the Navigator Pane.
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Copying Properties Between Data and Event Definitions

Using this option enables you to create properties in your Data definition 
that match the properties of an Event definition that it subscribes to. 
Similarly, it can be used to create properties of an Event definition that 
match those in a Data definition.

Using the copy function saves the need to define identical properties for 
your Data and Event definitions multiple times. 

To copy properties from one definition to another definition, complete the 
following steps:

 1 Open the definition whose properties you want to define.

The properties that you select in the following steps are copied to this 
definition.

 2 Select the Properties tab for the definition.

 3 Select the Copy Properties option from the Tools menu.

You are presented with a Copy Properties dialog that has a tree definition 
of all the Data and Event definitions currently defined.

 4 Select the definition whose properties you want to copy.

Note that you are not able to copy a property that already exists in the 
selected definition.

 5 Select the properties within the definition that you want to copy. You can 
use the Select All option to select all the properties.

 6 Click OK and the selected properties are copies to the definition that you 
opened in step 1.

You have now copied properties from one definition to another definition.
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Exporting Definitions to Recover Unsaved Changes

If the BPI Modeler loses its connection to the Process Repository for any 
reason; for example, the BPI Server has been shutdown in order to 
reconfigure a component, you cannot continue and modify your Process 
definitions.

If you have made changes to your definitions, but not saved the changes, 
you have the opportunity to export these changes to a recovery file before 
closing the BPI Modeler

Note: If you close the BPI Modeler without exporting your unsaved changes, 
the changes are lost.

As soon as the BPI Modeler realizes that it has lost its connection to the 
Process Repository, it presents a dialog for you to enter the name of the file 
where you want to save your modifications. The next time that you start the 
BPI Modeler and the Modeler successfully connects to the Process 
Repository, you are presented with a dialog that enables you to select the file 
where you saved your changes in order to import them back into the Process 
Repository.

If the BPI Modeler loses its connection to the Process Repository, and all 
your definitions are up to date, you are informed that the BPI Modeler must 
exit, and that no data is lost.

When you have exported the unsaved modifications, the file that is created 
is the same as the files created using the Export option and you can import 
the file at a later time if required or preferred.

The file used to store the definitions for recovery purposed is not deleted 
after the recovery process is complete. It is therefore available in the future if 
you wanted to import your modifications again for any reason.
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Reference

Coercion Rules

This section describes the rules for how properties are coerced when 
evaluating binding, filter and assignment expressions. This is an enforced 
evaluation by the BPI Modeler, based on the rules described in this section.

Valid data types for use within BPI are:

➤ String

➤ Numeric, which can be one of:

➤ Integer

➤ Long

➤ Double

➤ Currency

➤ Boolean

➤ Date

Assignments
The following table shows how assignments are coerced:

Data Type... Assigned from...

String Any type

Numeric Any other numeric value (with possible 
truncation if assignment is to an integer), or 
from Strings provided that the string is numeric. 
If the assignment does not produce a valid 
number, you receive an error similar to the 
following in the Business Impact Engine log file:

Cannot assign value prop-name to property 
prop-name as it is not a compatible type.
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Boolean Other Boolean values, or from Strings provided 
that the string is either true or false. If the 
assignment does not produce a valid boolean 
expression, you receive an error similar to the 
following in the Business Impact Engine log file:

Cannot assign value prop-name to property 
prop-name as it is not a compatible type.

Date Other Dates or a Numeric value (treated as 
number of milliseconds since 1970).

Data Type... Assigned from...
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Expressions
The following table shows how values within expressions are coerced.

Operator Behavior

Arithmetic:
+ 

- 

* 

/ 

%

Supported between Numeric properties or values 
that can be coerced to numeric using the 
assignment rules described in “Assignments” on 
page 92.

Comparison:

< 

<= 

= 

!=

> 

>= 

The comparison operators can be used to 
provide a:

➤ numeric comparison between Numeric 
properties or values that can be coerced to 
numeric using the assignment rules described 
in “Assignments” on page 92.

➤ date comparison between Date properties. 

➤ alphabetic comparison (locale-specific) 
between String properties or values that can 
be coerced to Strings using the using the 
assignment rules described in “Assignments” 
on page 92 (including Boolean).

The result of a comparison is always a boolean 
value.

String tests:

starts()

ends()

contains()

in()

Performs a test on a String property.

Note that these tests cannot be applied to 
non-string properties.
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Using NULL Within an Expression

The BPI Modeler allows only the equals and not-equals tests with the null 
constant. However, there might be expressions using other operators 
involving values that are null when these expressions are executed, for 
example how is the following expression evaluated when index is null?

index + 1 

The following table shows the rules that apply when comparing data items 
within an expression where one data item contains a null value.

Logical: 

! (Not)

&& (And)

|| (Or)

Supported between Boolean properties or values 
that can be coerced to boolean using the 
assignment rules described in “Assignments” on 
page 92.

Conditional value if, then, 
else: 
?:

First operand must be Boolean or be coerced to 
boolean, other operands can be any type; 
however they must be the same each other.

Operator Comparison

==

!=

Returns TRUE if the other operand is (or is not) 
null.

All other comparison operators Always return FALSE. 

For example the following expressions both 
return FALSE if index is null:

➤ index > 10 

➤ index <= 10

Arithmetic operators Arithmetic operators for expressions containing 
a null value always return null as the result, for 
example:

index + 1 returns null if index is equal to null

Operator Behavior
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Note: The null constant is case sensitive and when used in Java expressions, 
should always be lower case.

Expression Grammar in Process, Data, and Filter 
Definitions

This section lists the rules for the grammar that can be used for Business 
Process progression rules and expressions, and expressions within Business 
Process Monitor filter definitions. 

The progression rules and expressions are within the BPI Modeler for the 
start and complete conditions for Activities, and for filter expressions for 
Data definitions when subscribing to events.

Business Process Monitor filter expressions are used within the Monitor 
Definer to optionally specify the conditions for collecting statistical data for 
the Business Process Monitors.

The grammar used for expressions is similar to Java expressions. The 
following sections describe the grammar and its construct. Further examples 
of using this grammar are provided in the Business Process Insight Integration 
Training Guide - Modeling Processes. 

Grammar
The following is an informal description of the grammar, showing how 
expressions can be constructed. Note that this construct is subject to specific 
limitations according to how it is being used. Examples of using the 
grammar are provided in the following sections.

expression =>
property-value = expression
| expression + expression
| expression - expression
| expression * expression
| expression / expression
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| expression % expression
| - expression
| expression && expression
| expression || expression
| ! expression
| expression == expression
| expression > expression
| expression >= expression
| expression < expression
| expression <= expression
| expression != expression
| (expression)
| expression ? expression : expression
| value

value =>
       constant_value
      |property_value
      |function_return_value

See “Function Return Values” on page 98 for possible values for 
function_return_value.

constant_value =>
       string_contant
      |integer_constant
      |real_constant
      |true
      |false
      |null

property_value =>
root_object.relationship_name.property_name

where:

➤ root_object is this or event. 

If no root_object is specified, the expression assumes this.

➤ relationship_name can be included zero or more times, depending on how 
the property relates to the root object.
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Possible property_value expressions are:

➤ this.property

➤ this.data.property

➤ event.property

➤ property

The following are examples that you might use in your expressions. Further 
examples are given in the Business Process Insight Integration Training Guide - 
Modeling Processes:

➤ this.OrderNumber

➤ this.Customer.Customer_ID

➤ event.Status

Function Return Values
The following sections describe the data and string values that can be 
returned from the value expression.

These functions can be used in filter expressions, binding expressions, 
progression rules and assignment actions.

Functions for Dates and Times

The following functions convert expressions into milliseconds:

➤ hours (number)

➤ minutes (number)

➤ seconds (number)

➤ days (number)

These functions convert number to the equivalent number of milliseconds 
(which are the Business Impact Engine time units).
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Functions for Identifying String Values

The following functions take a string parameter and return a boolean result.

➤ string_property.contains(value)

Returns true if value is found in the property value.

➤ string_property.starts(value)

Returns true if the property value starts with value.

➤ string_property.ends(value)

Returns true if the property value ends with value.

Functions for All Property Types

The following function takes one or more parameters and returns a boolean 
result:

property.in(value,value,...)

This expression returns True if the value of property is one of the listed set of 
values (value, value,...), and False if it is not.

Process Progression Rules
The grammar for process progression rules is slightly different from the 
simple expression grammar, as it is used to describe deltas or changes to 
Data definition properties.

There are four styles of progression rule provided in BPI as follows:

➤ Complete on first assignment

➤ Complete on transition

➤ Start and complete on transitions

➤ Advanced conditions

The Advanced conditions style of progression rule requires you to enter the 
methods for the progression rules directly as described in section “Methods 
for Progression Rules” on page 102.
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For the remaining progression styles, you do not need to enter the methods, 
you just select the style of the progression rule that you want for the 
Activity. Ultimately, each style uses a subset, or selection of the methods 
described in section “Methods for Progression Rules” on page 102. You can 
see these methods if you define a progression rule using one of the styles 
and then change the style to Advanced conditions to view the methods 
created for the style.

More detailed information about using these progression rules in your 
processes is provided in the Business Process Insight Integration Training Guide 
- Modeling Processes.

The methods used for the progression rule styles are listed in the following 
table.

Style Methods Used Comments

Complete on first 
assignment

before()==null This style of progression 
rule uses the method listed 
to determine when the 
property value changes 
from Null to any other 
value.
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Complete on transition Complete Condition: 
before().in() and 
after().in()

This style of progression 
rule uses the methods 
listed to determine when 
the Activity complete 
condition is met. It does 
this by testing the original 
and modified value of a 
property against one or 
more values in the rule. 
Use of the in() method 
enables you to enter a 
selection of values that can 
be tested. If you do not 
enter a value, any value for 
the property can satisfy the 
condition.

Start and complete on 
transitions

Start Condition:

before().in() and 
after().in()
Complete Condition:

before().in() and 
after().in()

This style of progression 
rule uses the methods 
listed to determine when 
the Activity start and 
Activity complete 
conditions are met. It does 
this by testing the original 
and modified value of a 
property against one or 
more values in the rule. 
Use of the in() method 
enables you to enter a 
selection of values that can 
be tested. If you do not 
enter a value, any value for 
the property can satisfy the 
condition.

Style Methods Used Comments
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Methods for Progression Rules

In order to express progression rules using the Advanced Conditions option 
in the BPI Modeler, there are methods for Data definitions and their 
properties. A method represents the value relating to the data object or 
property at a point in time. 

The methods are described in the following table and apply only to a 
property in a process progression rules.

Method Description

this.data.property.changed() This function is used to test when the 
property value changes. When the 
property value changes it returns a 
result of True. 

this.data.property.before()==

“prop-value”

This evaluates to the value of the 
property before a change and is 
executed only when the property values 
changes. It is implicit in this expression 
that the property value was as stated by 
prop-value and is now no longer that 
value.

The type returned is the same as the 
type of the property.

this.data.property.after()==

“prop-value”

This evaluates to the value of the 
property after a change and is executed 
only when the property value changes. 
It is implicit in this expression that the 
property value was a value other than 
prop-value and is now prop-value. The 
type returned is the same as the type of 
the property.

this.data.created() This evaluates to true when the data 
definition is created. This method is 
executed only when a new Data 
definition is created. 

The method returns a Boolean result.
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Example of Complete Condition for Start Activity When Data 
Definition Created

The following shows an example of the expression that you use when you 
want a process instance to be started when a Data definition for the process 
is created. In this case, a new process instance is started only when the start 
and complete conditions for the start Activity in the process are met, for 
example:

this.order.created();

where:

➤ this is the reference to the process, in this case the Order process.

➤ order is the Data definition. 

➤ created() is a method that evaluates to true when the order Data 
definition is created. 

this.data.property.in(

“prop-value1”, “prop-value2”, ...)

This evaluates to true when the value of 
the propery is set to any of the listed 
values.

The method returns a Boolean result.

this.data.terminated() This evaluates to true when the data 
definition is terminated, specifically 
when the Data definition received an 
event that is flagged as terminating it. 
This is specified in the Event 
Subscription dialog for the Data 
Definition; Terminate this instance of 
the Data Definition after handling the 
event. 

The method returns a Boolean result.

onEvent(“event-name”) This evaluates to true when the 
specified event is processed by the Data 
definition. It evaluates to false if the 
event does not match.

Method Description
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Example Start Condition for Start Activity When Data Definition 
Modified

The following shows an example of the expression that you use when you 
want a process instance to be started when the Data definition for the 
process is modified. In this case a process instance is started not when the 
Data definition is created but when there is a change to the Data definition 
property.

this.order.priority.before() == null && this.order.priority.after() <= 3;

where:

➤ this is the reference to the process, in this case the Order process.

➤ order is the primary Data definition.

➤ priority is an integer property.

➤ before() is a method, which returns the value of the property before the 
change.

➤ null indicates that the property was not initialized before the change.

➤ after() is a method, which returns the value of the property after the 
change.

Example Start Condition using a Method on a Method

The following example is similar to the example above; however, shows an 
example of the expression that you use when you want a process instance to 
be started when the Data definition for the process is modified and the Data 
definitions contains a specific string.

this.order.customer_id.after().contains(“X”);

where:

➤ this is the reference to the process, in this case the Order process.

➤ order is the primary Data definition.

➤ customer_id is a string property that is a unique identifier for the 
customer.
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➤ after() is a method, which returns the value of the property after the 
change.

➤ contains() is a string function, which returns a boolean result 
depending on whether the string “X” is present in the customer_id.

Example Start Condition for an Activity Based on Event Properties

The following example shows an expression where a you want a process 
Activity to be started when the business event Order Updated is received and 
the business events contains a Status attribute of Credit Check Done.

onEvent(“Order Updated”) && event.Status == “Credit Check Done”;

Case Sensitivity for Expressions
This section describes case sensitivity for expression properties and for 
expressions containing string constants.

Expression Properties

Properties and methods in expressions are case sensitive, which means the 
following expression are not equivalent within your BPI system:

this.order.priority.before() == null && this.order.priority.after() <= 3;

this.Order.Priority.before() == null && this.Order.Priority.after() <= 3;

Expressions with String Constants

Expressions containing string constants are case sensitive, which means the 
following expressions are not equivalent within your BPI system:

this.order.status.after() == “a”;

this.order.status.after() == “A”;
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Subtracting Dates in Filter or Binding Expressions

When you create a filter or binding expression where you want to subtract 
dates, you need to make sure you create expressions using the following 
format:

(this.dateProp + days (2) + hours (12) > event.dataProp

In this example, the duration is added to one date and tested against the 
second date to achieve the required result. 

You cannot use expressions such as the following:

(event.dateProp - this.dateProp) > days (2) + hours (12)

This expression tests whether the difference between two dates is greater 
than two days and 12 hours. 
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4
Monitor Definer

This chapter includes:

Concepts

➤ Business Process Monitor Definer Overview on page 108

➤ BPI Monitor Definer Log Files on page 117

Tasks

➤ How to Manage the BPI Monitor Definer on page 119

➤ How to Export and Import Monitor Definitions on page 121
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Concepts

Business Process Monitor Definer Overview

This chapter describes tasks that are specific to the management of your 
Monitor definitions using the Monitor Definer.

Note: You cannot open or use the Monitor Definer, unless you have 
installed the BPI Server. The Monitor Definer options appear when the BPI 
Server is installed and the connectivity between the BPI Server and the BSM 
Gateway Server has been configured and the BPI Server components are 
started. This configuration is described in the "Component Configuration - 
HP Business Service Management Settings" section of the Business Process 
Insight Server Administration Guide.

The Monitor Definer is a Web-based UI that enables you to define Business 
Process Monitors and monitor instance threshold definitions for deployed 
processes.

A Business Process Monitor is a business measurement that has a specific 
meaning within your business and can be used to record information about 
the Business Process that you are monitoring. Monitor instance thresholds 
are set on individual monitor instances. When monitor instance thresholds 
are violated, instance threshold violations are generated and can be reported 
through the Business Process Insight Application Health pages. You can also 
configure the Notification Server to send violation messages when a 
monitor instance threshold is violated.
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Within BPI, the tool for defining Business Processes is separated from the 
tool for defining Business Process Monitors for these processes. You use the 
BPI Modeler to define your Business Processes and you use the Monitor 
Definer to define the Business Process Monitors and monitor thresholds for 
these Business Processes. You define Business Process Monitors for a Business 
Process after the process has been deployed; this provides more flexibility 
for defining and modifying Business Process Monitors without the need to 
redeploy your Business Processes.

Using the Monitor Definer Without and With the BPI 
Server Installed
You can use the Monitor Definer without the BPI Server, but to use the full 
capabilities of the Monitor Definer, you need to install the Server 
component of Business Process Insight. The following sections list the 
Monitor Definer capabilities without and with the BPI Server:

➤ “Monitoring - Tracking Individual Process Instances is Disabled” on 
page 109

➤ “Monitoring - Tracking Individual Process Instances is Enabled” on 
page 111

Monitoring - Tracking Individual Process Instances is Disabled

The following diagram shows the components involved for displaying the 
monitoring data when you do not have the BPI Server installed or you have 
not enabled tracking of individual process instances.
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The following is a list of the key steps involved for monitoring your Business 
Processes:

➤ Data collectors, such as SiteScope make their data samples available 
through the Profile database. This data is then available for Reporting and 
SLM.

➤ The data samples collected from other applications are also used for the IT 
operational resource CIs, which can be mapped to Business Activities.

➤ You need to set health indicator objectives on your IT operational 
resource CIs in order to be able to monitor status changes.

➤ BSM calculates the status of the dependencies for the mapped IT 
operational resource CIs and makes the results available to the Service 
Health. 

Service Health combines these results with the process definition model 
information (obtained from the Process Repository) and the results are 
displayed on the Business Process Diagram within Service Health.
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Monitoring - Tracking Individual Process Instances is Enabled

the following diagram shows the components involved for displaying the 
monitoring data when you have the BPI Server installed and you have 
enabled tracking of individual process instances.

The following is a list of the key steps involved for monitoring your Business 
Processes. These steps are in addition to those described in section 
“Monitoring - Tracking Individual Process Instances is Disabled” on 
page 109:
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➤ In addition to the IT operational resource CIs that are monitored and 
reported for your Business Processes, BPI receives business events through 
the Business Event Handler.

➤ The business data relating to individual process instances is stored in the 
BPI Instance database.

➤ At the same time as each new Monitor definition is created in the BPI 
database tables, a Business Process Scope CI is created in the ODB.

➤ Changes to process instance data that impact the Business Process 
Monitors that you have defined are sent to the Monitor Engine, which in 
turn updates the relevant tables in the BPI Instance database.

➤ The BPI Server periodically sends a set of data samples to the Business 
Service Management Gateway Server.This period can be configured from 
the BPI Server Administration Console; see “Component Configuration - 
HP business Availability Center Settings” in the Business Process Insight 
Server Administration Guide. 

The data samples are held on the BPI Server for a configurable length of 
time, until the Business Service Management acknowledges receipt. If a 
data sample cannot be delivered in the required time, it is deleted. The 
values of these data samples are used to evaluate KPIs within the Business 
Service Management environment.

These data samples can also be used for reporting and SLM.

➤ The BPI Server polls for the status of CIs to obtain details of the status of 
the IT operational resources that the process Activities are linked to. This 
period can be configured from the BPI Server Administration Console on 
the BPI Server. For more information, see “Component Configuration - 
HP Business Service Management Settings” in the Business Process Insight 
Server Administration Guide. 

➤ The business event data and monitor data for the process instances is 
made available to other BSM components and displayed through the BPI 
Application Reports, described in more detail in Chapter 9, “Introduction 
to Reports”.

Ongoing changes made to the Processes and Monitors in the BPI database 
tables are automatically synchronized with the ODB.
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BPI Database
You can also use filters to further target the statistical data that you want to 
collect. This has the added benefit of reducing the amount of data stored in 
the database and therefore maintaining the BPI system performance.

The following diagram shows the Business Process Monitor Definer relative 
to the Business Monitor data stored in the BPI database.

You can define monitors for:

➤ Single Activities

➤ Multiple Activities

➤ Whole process

These monitors can be duration based or Process Value based. In addition, 
you can define a custom monitor.

Data are collected based on this configuration, and instance thresholds can 
be defined to report on individual process instances.
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You can also use the Monitor Definer to export Monitor and instance 
threshold definitions to an XML file, and subsequently import these 
definitions.

How the Business Process Monitors definer interworks with the Monitor 
Engine is described in “Monitor Engine” on page 114. 

Monitor Engine
The Monitor Engine is the component of the BPI Server that analyzes and 
provides the statistical results from the Business Process Monitor and 
monitor instance threshold data that you define. The Monitor Engine takes 
data about the individual instances from the Business Impact Engine and 
combines this data with the data you enter through the Monitor Definer to 
collect and report on the required information about the process.
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The following diagram shows the relationship between the process impact 
data and the monitor data that you define.

The Business Process Monitors and monitor thresholds are configured 
through the Business Process Monitor Definer; see “Business Process 
Monitor Definer Overview” on page 108.

The Monitor Engine maintains business data for the Business Processes that 
are deployed according to the Business Process Monitors that you have 
defined. It also maintains statistical information about the monitor 
thresholds that are defined.
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The following diagram shows how the monitor data is used by the Monitor 
Engine to report statistics and instance threshold violations to other BPI 
components.

The statistics that the Monitor Engine calculates are stored in BPI database 
tables and are used by the Business Process Insight Application Health pages. 
The database tables also hold information used to determine if any monitor 
thresholds have been violated. These violations are reported through the 
Health pages and can also be reported through the Notification Server or 
other HPOM applications.

Managing the Monitor Engine parameters is described in the "Component 
Configuration - Monitor Engine" section of the Business Process Insight Server 
Administration Guide, and the architecture for the Monitor Engine and 
Monitor Definer is described in the "BPI Server Architecture" section of the 
Business Process Insight Server Administration Guide.
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Collection Interval
When you install the BPI Server and configure the integration between BPI 
and Business Service Management Gateway Server, you configure the Data 
Samples settings. One of the properties of these settings is Data samples send 
interval (minutes); this is the time interval used to send data samples to 
Business Service Management. The value for the Data samples send interval 
becomes the value for the Collection Interval within BPI and you can no 
longer modify the value for Collection Interval within the Monitor Definer.

If you import a previously exported Business Process Monitor.zip archive 
file, the value for the imported Collection Interval is imported and recorded; 
however, when the integration with Business Service Management is 
enabled, the value for Collection Interval is not used. The value is imported in 
order that it is available for use if the integration with Business Service 
Management is subsequently disabled. The value used for the Collection 
Interval, in the case of importing to a system where the Business Service 
Management integration is enabled, is the value set for the Data samples 
send interval.

BPI Monitor Definer Log Files

There are two sets of log files that you need to be familiar with when 
managing your Business Process Monitors:

➤ Monitor Engine log files

The Monitor Engine log files are managed in the same way as other BPI 
Server components and are described in the "Component Configuration - 
Logging" section of the Business Process Insight Server Administration Guide.

➤ Monitor Definer log files

The Monitor Definer logs messages to the BPI Servlet Engine log file. 
These messages in the Servlet Engine log file are prefixed with the string 
Monitor Definer. The Servlet Engine is considered as a component of the 
BPI Server. The Servlet Engine log file is described in the "Component 
Configuration - Logging" section of the Business Process Insight Server 
Administration Guide.
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Warning Messages in Log Files

Each time a Business Monitor is created with an associated Monitor 
Threshold or Group, a warning is generated in the Business Process Engine 
log file. This warning is added by Hibernate and can be ignored; there is not 
a problem with the Business Monitor. 
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Tasks

How to Manage the BPI Monitor Definer

The following are the management tasks that you can complete using the 
BPI Monitor Definer:

➤ “Opening the Monitor Definer” on page 119

➤ “How to Export and Import Monitor Definitions” on page 121

For details about creating and modifying monitors, see the Monitor Definer 
online Help.

Opening the Monitor Definer
Before trying to start the BPI Modeler, make sure that the Process Repository 
component is started on the BPI Server system. Use the BPI Server 
Administration Console to start the Process Repository as described in the 
"Starting and Stopping the BPI Server Components" section of the Business 
Process Insight Server Administration Guide.

Opening the Business Process Monitor

To open the BPI Monitor Definer:

 1 Select Admin > Business Process Insight.

You are presented with a tabbed page that includes a tab for Monitor 
Definer.

 2 Click the tab for the Monitor Definer and you are presented with a page 
listing any processes that are deployed and any monitors defined for 
these processes.



Chapter 4 • Monitor Definer

120

Following is an example of the layout of the Monitor Definer when you 
open it. 

Importing a Business Process Monitor

Before importing a Business Process Monitor, you must have already 
imported and deployed the Business Process to which the Business Process 
Monitor is linked.

In addition, if you have defined custom monitors, and you are moving the 
definitions to a new machine, make sure that you also copy any files that 
you have created for the custom monitor to the new machine. For example, 
you might have created SQL files for your custom monitor and this SQL file 
is not exported as part of the .zip file. If you do not copy the files relating to 
any custom monitors before importing the Monitor definition and creating 
the appropriate stored procedures, the import fails.

To import the Business Process Monitor, complete the following steps:

 1 Select File > Import on the Monitor Definer navigation frame: 
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The right-hand pane provides a browse button that you can use to 
navigate to the file where the file that you want to import is located.

 2 Select the file that you want to import and click Open.

 3 Click the Import Definitions button.

The Monitor Definer provides a summary of the monitor definitions 
contained in the zip file and how they will be applied to the processes 
that are currently defined on your system. You need to check that the 
monitor definitions in the zip file are being applied to the correct process 
definitions before importing the file. As an example, you need to make 
sure that you have not renamed a process since a monitor definition was 
exported.

 4 Select the checkbox next to each set of Business Process Monitors that 
you want to import from the zip archive file.

 5 Click Import Definitions.

The Monitor Definer displays a feedback message indicating whether or 
not it successfully imported the selected monitor definition.

 6 Click OK and the Monitor Definer returns to the Monitors and Thresholds 
page for the process.

If you import monitor definitions which are named identically to monitor 
definitions that are already defined within the Monitor Definer, they are 
imported and renamed (appended with a number), to make them unique. 
Instance threshold names are not changed as they need only be unique for 
the Monitor definition that they apply to.

How to Export and Import Monitor Definitions
The BPI Monitor Definer has options that enable you to export and 
subsequently import the Business Process Monitors, monitor thresholds and 
filters defined for a selected Business Process. You might want to export a 
Business Process Monitor definition to enable you to create Business Process 
Monitors for testing and then move these monitors to a production system 
when they are fully verified.
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These definitions can be exported to a .zip archive file, which contains XML 
files describing the definitions. The .zip archive contains a copy of the 
monitor definition and some (but not all) information about the parent 
Process definition. The information relating to the Process definition is that 
required to uniquely identify the Process definition that the Business 
Process Monitor applies to. The .zip archive file does not contain all the 
information relating to files that you might have created for custom 
Business Process Monitors; it contains the custom monitor definition, but 
you need to separately manage and export any SQL you have created for the 
custom monitor definitions.

Be aware that the .zip archive created from the Monitor Definer is not the 
same as the .zip archive created from the BPI Modeler. You cannot 
interchange the .zip archives between the two applications, you must import 
the archive created from the appropriate application. This is because the .zip 
archive from the Monitor Definer contains sufficient information about the 
Business Process to enable the Monitor Definer to import the monitor; it 
does not contain a full definition of the Business Process.

Note: You cannot import a monitor definition until the process definition 
that the monitor applies to is deployed to the Business Impact Engine. Refer 
to section “Exporting and Importing” on page 80 for details of exporting 
and importing process definitions.

Exporting a Business Process Monitor

To export one or more Business Process Monitors, use the Export or Export All 
options from the File menu in the Monitor Definer Navigation frame.

When you select a Business Process Monitor to export, all the associated 
monitor instance threshold and filters are also exported. The export is based 
around the identifier of the Business Process that the Business Process 
Monitor is linked to. All the information, including monitor thresholds and 
filters, is exported to XML files, which are then packaged into an overall .zip 
archive file. The .zip file can then be copied to the destination system in 
order to be imported.
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When you export a Business Process Monitor, you also need to make a copy 
of any additional files that you might have created that are associated with 
the Business Process Monitor; for example, you might have defined a 
custom monitor. In the case of a custom monitor, you need to make sure 
that you have a copy of any SQL files that you have created for the custom 
monitor.

The name of the exported file is based on the Process name, machine name 
and time that the monitor is exported, so that a unique name is provided for 
the .zip archive file. If any of the elements of this constructed file name 
contain non-ASCII characters, the elements are excluded from the file name. 
This is because Internet Explorer allows only .zip archive file names that 
contain ASCII characters.
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5
Process Repository Explorer

This chapter includes:

Concepts

➤ Process Repository Explorer Overview on page 126

Tasks

➤ How to Use Repository Explorer to Complete Tasks on page 129

Reference

➤ Process Repository Explorer User Interface on page 134
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Concepts

Process Repository Explorer Overview

This chapter describes the BPI Repository Explorer, which is a Web-based 
interface that enables you to browse and manage the contents of the Process 
Repository Database. The Process Repository Database holds the data for the 
Business Processes that you have defined using the BPI Modeler.

Note: You cannot open or use the Process Repository Explorer, unless you 
have installed the BPI Server. The Process Repository Explorer options appear 
when the BPI Server is installed and the connectivity between the BPI Server 
and the Business Service Management Gateway Server has been configured. 
This configuration is described in the "Configuring the BPI Server to 
Connect to a Gateway Server or Load Balancer" section in the Business 
Process Insight Server Administration Guide.

For information about creating definitions using the BPI Modeler, see the 
Business Process Insight Integration Training Guide - Modeling Processes, or the 
Modeler Online Help.

The Repository Explorer is a Web-based interface that enables you to view, 
print and manipulate the contents of the Process Repository. The Repository 
Database is a set of database tables that hold the data for the Business 
Processes that you have defined using the BPI Modeler.

Note: The data presented by the Repository Explorer contains a super-set of 
information. It shows those definitions that were once deployed, those 
definitions that are currently deployed, and those definitions that have 
been edited and not yet deployed.
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This is because you might have modified the process within the BPI 
Modeler, but not yet redeployed the process.

Using the BPI Modeler, you can create, modify and subsequently deploy a 
definition. When you have deployed the definition, you might then go on 
and revise the definition and significantly change it. This means that, unless 
you have exported the version of the definition that you previously 
deployed, you no longer have a copy of it within the BPI Modeler. You can 
therefore be in the position of having a deployed process, but no copy of the 
source for the process.

The Repository Explorer enables you to always be able to access the source to 
versions of processes that you have created and deployed.

Using the Repository Explorer you can:

➤ See whether a process is defined for instance tracking or not.

➤ View all the details of your currently deployed processes in a tabular form.

➤ Browse and print definitions.

➤ Export the latest version of a deployed definition, or latest versions of all 
deployed definitions.

➤ Import previously exported definitions.

➤ Remove definitions and move them to the Recycled folder within the 
Repository Explorer. And permanently remove deleted definitions from 
the Recycled folder.

➤ Restore a definition that has been deleted, but not permanently removed, 
using the BPI Modeler or Repository Explorer.

➤ Undeploy and permanently remove definitions that have completed from 
the Recycled folder. 
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The Repository Explorer is a view on the Process Repository data, which is 
created using the BPI Modeler and stored in the Process Repository database 
tables. You can browse and manage the data using the Repository Server as 
shown below.

Process Repository Explorer Log Files
The Repository Explorer uses the Repository Server to access its data and the 
Repository Server logging is recorded under Process Repository in the BPI 
Server Administration Console. For details of the logging settings that are 
used for BPI components, see “Component Configuration - Logging” in the 
Business Process Insight Server Administration Guide.

In addition, you can find log messages for the Repository Explorer in the 
Servlet Engine log file.
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Tasks

How to Use Repository Explorer to Complete Tasks

The following are the tasks that you can complete using the Repository 
Explorer:

➤ “Open the Repository Explorer” on page 129

➤ “Browse Definitions” on page 130

➤ “Print Definitions” on page 130

➤ “Delete Definitions” on page 130

➤ “Exporting Process Definitions” on page 130

➤ “Undeploying a Process Definition” on page 132

➤ “Restoring a Definition” on page 133

Open the Repository Explorer

Before trying to use the BPI Repository Explorer, make sure that the Process 
Repository and Servlet Engine components are started on the BPI Server 
system. Use the BPI Server Administration Console to start these 
components, as described in the "Starting and Stopping the BPI Server 
Components" section of the Business Process Insight Server Administration 
Guide.

To open the BPI Repository Explorer, complete the following steps:

 1 Make sure that the Process Repository and Servlet Engine components are 
started.

 2 Select Admin > Business Process Insight.
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Browse Definitions

Using the Repository Explorer, you can easily browse the current and earlier 
revisions of a definition to quickly see how they were defined. You need to 
be able to do this as the BPI Modeler is optimized for editing and not for 
browsing and therefore does not present the information relating to Process, 
Data and Event definitions in an easy-to-view way.

Print Definitions

You can also print definitions using the print option at the top right-hand 
corner of the GUI. This print option enables you to print the contents of the 
right-hand pane in the Details view.

Delete Definitions

You can delete any definition using the Repository Explorer, provided it is 
not the current version of the definition that has instances currently 
running in the Business Impact Engine.

To delete a definition:

 1 Select the definition that you want to delete from the Navigator Frame 
(see “Navigator Frame” on page 135)

 2 Click the History tab (see “History Tab” on page 139).

 3 Select the checkbox for the definition, or definitions that you want to 
delete.

 4 Click Delete.

Exporting Process Definitions

The Repository Explorer can be used to export any revision of a definition 
from the Process Repository.

Caution: This definition is compatible with the Modeler and not the 
Monitor Definer; it does not contain any Business Process Monitor 
information.
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You might have multiple versions of a definition where you have deployed 
the Process definition multiple times. You can also export the latest version 
of a definition using the BPI Modeler; however, you cannot export earlier 
revisions of a definition using the Modeler, you can do this only through 
the Repository Explorer.

In addition to exporting individual versions of a definition, you can also 
choose to export the latest revision of all definitions from the Process 
Repository; you might want to do this to move all the latest definitions to 
another BPI Server.

You can export single definitions or all definitions:

➤ single definitions; see “Exporting a Single Definition” on page 131.

You might want to do this in order to take a copy of the latest revision of 
the definitions. The latest version of the definition is exported to a .zip 
file. Exporting the definitions through the Repository Explorer, or the BPI 
Modeler, also ensures that the definitions are consistent within 
themselves as the definition and all its dependencies are exported.

➤ all definitions; see “Exporting All Definitions” on page 132.

You might want to do this in order to move the definitions from one BPI 
Server to another BPI Server, for example, from a development system to a 
staging system. The latest versions of all the definitions within the Process 
Repository are exported to a .zip file, including all the dependencies.

Exporting a Single Definition

To export a definition, complete the following steps:

 1 Select the definition that you want to export from the left-hand Navigator 
pane.

 2 Click the Export option from the File menu in the Navigation pane. 

Continue at step 6.

 3 Select the History tab in the right-hand pane.

 4 Select the revision of the definition that you want to export from the list.

 5 Click the Export button in the right-hand pane.

 6 The right-hand pane lists the definition that will be exported.



Chapter 5 • Process Repository Explorer

132

 7 Click the Download button to continue to export the definition.

You are presented with your browser’s File Download dialog.

 8 Select Save, to save the definition as a .zip file.

You are presented with a Save As dialog, where you can specify a file 
name and directory location for the .zip file.

 9 Enter the details of the file name and click Save.

The file is saved and a Download complete dialog is displayed.

 10 Click Close and the export is complete.

Exporting All Definitions

To export all definitions, complete the following steps:

 1 Click the Export All Option from the File menu in the Navigation pane. 

 2 The right-hand pane lists the definitions that will be exported.

 3 Click the Download button to continue to export the definition.

You are presented with your browser’s File Download dialog.

 4 Select Save, to save the definition as a .zip file.

You are presented with a Save As dialog, where you can specify a file 
name and directory location for the .zip file.

 5 Enter the details of the file name and click Save.

The file is saved and a Download complete dialog is displayed.

 6 Click Close and the export is complete.

Undeploying a Process Definition

You cannot use the Repository Explorer to undeploy a specific definition. 
You must use the BPI Modeler to do this. You can use the Cleanup Recycled 
option within the Repository Explorer to undeploy and delete all current 
revisions of definitions held in the Recycled folder; see “Navigator Frame” 
on page 135.
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Be aware that undeploying an Event definition, which is referenced by a 
Data definition that has current active instances, means that these data 
instances might not be able to progress. If this is the case, you can use the 
Intervention tool to delete the individual Data definition instances.

Restoring a Definition

The Repository Explorer can be used to restore definitions that have been 
deleted using the BPI Modeler. These definitions are listed in the Recycled 
folder on the Navigator frame. 

You can access the Restore option from the File menu on the Navigator 
frame. The steps for restoring a previously deleted definition are as follows:

 1 Select the definition that you want to restore from the Recycled folder.

 2 Select the Restore option from the File menu in the Navigator frame.

The definition is restored to the Process Repository and is removed from 
the Recycled folder in the Repository Explorer. The restored definition 
appears under the appropriate definition list in the Repository Explorer.
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Reference

Process Repository Explorer User Interface 

This section includes (in alphabetical order):

 ➤ Repository Explorer Page on page 134

Repository Explorer Page

Following is an example of the layout of the BPI Repository Explorer.
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The Repository Explorer comprises the following main areas:

➤ “Navigator Frame” on page 135

➤ “Details Tab” on page 137

➤ “History Tab” on page 139

Navigator Frame

User interface elements are described below:

UI Elements Description

<folders> Process, Data and Event definitions have been created in 
the BPI Modeler. 

The deployment status (deployed or undeployed) of each 
definition is displayed using the same icons used within 
the BPI Modeler. For details on the Modeler, see 
Chapter 3, “Modeler Management.”

Recycled folder, which lists definitions that have been 
deleted from the BPI Modeler. When you delete a 
definition using the BPI Modeler, the definition is moved 
to this Recycled folder, which is accessible only from the 
Repository Explorer.
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File The menu includes the following options:

➤ Export. Enables you to export the selected definition 
to a zip file. For details see “Exporting Process 
Definitions” on page 130.

➤ Export All. Enables you to export the latest revision of 
all the definitions in the Navigator frame to a zip file. 
For details see “Exporting Process Definitions” on 
page 130.

➤ Restore. This option is available when you select a 
definition from the Recycled folder. It restores the 
definition back to its original location in the Process 
Repository, at the point where it was deleted in the BPI 
Modeler. For details see “Restoring a Definition” on 
page 133.

➤ Cleanup Recycled. This option deletes all definitions 
in the Recycled folder and undeploys definitions that 
are deployed. If a definition is still in use by the 
Business Impact Engine, it is not deleted or 
undeployed. When all instances of these definitions 
have completed, these entries can then also be 
removed using the Cleanup Recycled option and the 
entries no longer appear in the interfaces. The 
instances of definitions are deleted by the Business 
Impact Engine using the Engine Instance Cleaner.

Note: When you select a definition in the Navigator 
frame, the right-hand frame opens at the Details tab as 
described in “Details Tab” on page 137. You can select 
the History tab described in “History Tab” on page 139. 

Refresh Click to refresh the Navigator frame to be up-to-date with 
the latest definitions that have been recently entered into 
the Process Repository using the BPI Modeler.

UI Elements Description
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Details Tab

The Details tab provides details of the definition that you have selected in 
the Navigator frame. Much of the information listed under the Details tab 
can be determined from the BPI Modeler. However, the Repository Explorer 
provides the information in a structured form, which makes it easier to 
reference and print. 

The information listed under the Details tab varies according to the type of 
definition selected in the Navigator frame: Process, Data, or Events. For 
more information, see the Modeler online Help.

Following is an overview of all the sections under the Details tab for all the 
definitions:

UI Elements (A-Z) Description

Activities This section appears only for a Process definition and lists 
details of the individual Activities that make up the 
Process definition, including:

➤ Name of the Activity: shown next to the icon for the 
Activity.

➤ Type of Activity: Start, End, Junction or Business 
Activity. 

➤ Start Condition: associated progression rule.

➤ Complete Condition: associated progression rule.

➤ Image File: Filename of the image selected for the 
Activity’s icon.

➤ Related CIs: List of any CIs that the Activity is linked 
to.

Checked Arcs This section appears only for a Process definition and lists 
details of the arcs that have been defined as Checked Arcs 
for the Process definition.
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Identity/Summary This section appears for all the definitions and lists an 
overview, or summary, of the definition.This includes 
information that you have entered relating to the 
definition using the BPI Modeler, and information 
relating to the revision of the definition. 

This section also lists the revision number of the 
definition and details of the other definitions that the 
selected definition uses and is used by.

Process Diagram This section appears only for a Process definition and 
shows the Process Diagram of the selected process. It is 
the same Process Diagram as shown through the BPI 
Modeler.

Properties This section appears for Data and Event definitions and 
lists details of the properties that have been defined for 
the selected definition.

➤

Related Data This section appears only for a Process definition and lists 
details of the Data definition that has been defined as the 
Related Data definition for the selected Process 
definition. This section includes whether the option to 
track instances has been enabled for the selected process 
and whether there is a Group property for collecting data 
by group.

UI Elements (A-Z) Description
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History Tab

The History tab provides a page tabulating the details of the revision history 
related to the selected definition in the Revision History table.

These details include:

➤ Revision number

➤ Deployment status

➤ Name of process as defined in the Modeler

➤ Date the revision was last saved

➤ Description (from the Description field in the definition)

➤ Labels, which is the date and time that the revision was deployed.

Subscriptions This section appears only for a Data definition and lists 
details of the Event subscriptions related to the Data 
definition and includes:

➤ Name of the subscription, which is shown adjacent to 
the icon for the subscription.

➤ Subscription Description: Description as entered in the 
Modeler.

➤ Event Binding Expression: Binding specified to 
associate a specific event property from the Business 
Event to the corresponding Data Definition key 
property.

➤ Creation Option: Conditions under which you have 
requested that the Event definition can be created.

➤ Filter Expression: Additional filtering that you can 
define to be applied to the incoming business event.

➤ Actions: Action that you have specified for extracting 
the required properties from the Business Event in 
order that they can be placed into the Data Definition.

ToDo List This section appears for all the definitions and lists the 
content of the current to-do list for the selected 
definition.

UI Elements (A-Z) Description
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Each entry in the table has a check box which you can select (and clear). 
When you select the check box for one, or more, of the definitions in the 
table, the Export and Delete options are made available. The Export option 
is available only if you select a single entry. If you select more than one 
definition, or do not select any definitions, the Export option is not 
available.

If you want to export a definition on the Revision History table, select the 
definition, click the Export button and then follow the instructions that are 
presented to you by the Repository Explorer.

There is also a delete option available for each revision of the definition. You 
cannot delete a definition that is currently being processed by the Business 
Impact Engine, if you do try to delete such a definition, the Repository 
Explorer issues a warning message and does not allow the delete action to 
progress.

You can select any version of a definition to delete, including the current 
version of a definition. In the case of the current definition, the Repository 
Explorer issues a warning message for you to confirm the delete action and 
then continues.

Caution: You cannot recover any definition that is deleted using the 
Repository Explorer. 



141

6
Process Intervention

This chapter includes:

Concepts

➤ Process Intervention Overview on page 142

Tasks

➤ How to Use the Process Intervention Tool on page 145

Reference

➤ Process Intervention Reference on page 150
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Concepts

Process Intervention Overview

This chapter describes how you can make changes to your Business Process 
data, and delete completed instances of Processes and Data definitions using 
the Process Intervention pages. 

The Process Intervention page enables you to access processes that you have 
deployed in order to modify or delete Process instances and their associated 
Data instances.

You might want to modify or delete instances to resolve problems with the 
process, or its data. This is more usually required after a period of new 
development or where progression rules are not behaving as expected; for 
example, you might need to:

➤ manually progress and delete process instances.

➤ update and delete Data Definition instances.

Note: You cannot open or use the Process Intervention page, unless you 
have installed the BPI Server. The Process Intervention page appears when 
the BPI Server is installed and the connectivity between the BPI Server and 
the Business Availability Gateway Server has been configured. This 
configuration is described in the "Component Configuration - HP Business 
Service Management Settings" section of the Business Process Insight Server 
Administration Guide.

You use Process Intervention to remove individual process instances or data 
instances from the database. If you want to delete several completed or 
active instances on a regular basis you should use the Engine Instance 
Cleaner parameters as described in the "Deleting Completed Instances from 
the Database" chapter of the Business Process Insight Server Administration 
Guide.



Chapter 6 • Process Intervention

143

The purpose of Process Intervention is to:

➤ enable you to access deployed Process and Data definitions, plus Process 
instances and Data instances. 

➤ enable you to delete Process and Data definitions, and clear the average 
and total counts associated with a specific definition.

➤ invoke a manual synchronization between BPI CIs and the ODB. 

The following are some examples of why you might want to use the 
Intervention tool:

➤ where a process instance has progressed through a process, but one or 
more Activities that should be complete still appear as active. 

You can use the Intervention tool to change the state of the active 
Business Activities to Complete. Activities can get into this state if you 
have manually progressed a Process instance, for example, when an 
application that usually provides the service is not available and you have 
substituted another application to complete the Activity. 

➤ when the start and complete conditions for an Activity are incorrect and 
therefore cannot be satisfied. In this case, you might want to delete all 
instances of the process and any associated process data. 

➤ where you want to progress a specific process instance to its completion, 
for example, there might be and order processing instance waiting for an 
automated system to enter credit card information, and the automated 
system is not operational. In this case, you can modify a data instance to 
add credit card information manually and progress the order for a 
customer.

➤ to remove erroneous processes to tidy up your system. You might need to 
do this if you have been developing new processes and want to remove 
older versions, which are no longer required.

➤ where you want to search for all process instances over a certain age and 
remove them. You can also do this using the instance cleaner parameters 
tools (see the "Deleting Completed Instances from the Database" chapter 
of the Business Process Insight Server Administration Guide). However, you 
might not want to remove all the process instances, just for one specific 
process.
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➤ to delete an orphaned Data definition that is not linked to a Process 
definition, or perhaps where the Data definition was linked to a Process 
that has been deleted.

➤ to test your BPI system. You might want to delete all the active Data 
definitions to reset the system.

➤ to reset the totals and averages for Process and Data definitions. You 
might want to do this periodically (daily, weekly, monthly) so you can see 
the totals and averages in terms of a known period.

➤ to manually synchronize the BPI CIs with the ODB for reasons such as:

➤ an earlier synchronization failed when you deployed a definition using 
the Modeler, and you want to invoke another one immediately and 
not wait for the background synchronization to run.

➤ CIs have been deleted from the ODB in error and you want to reinstate 
them. In this case, the synchronization adds, removes and updates CIs 
for the latest installation of BPI (including upgrades). If you have 
previously installed BPI and then removed it without undeploying 
definitions, these definitions are not synchronized.

Using the option to delete all existing BPI CIs from the ODB provides the 
option to remove all BPI-related CIs regardless of who or what created 
them.The delete action is completed before the synchronization is 
started. This option is useful if you want to clean out CIs that have been 
created by prior BPI installations.

Note: If you want to clean up your development system using the 
Intervention pages, it is recommended that you use the Intervention 
Client to remove the definitions and all their instances from the Business 
Impact Engine and then re-deploy the process or processes that you want 
to use.
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Tasks

How to Use the Process Intervention Tool

The following are the tasks that you can complete using the Process 
Intervention tool:

➤ “Opening the Process Intervention Page” on page 145

➤ “Deleting Process or Data Definitions and Clearing Data” on page 145

➤ “Search for Specific Instances” on page 146

➤ “Change the State of an Instance” on page 147

➤ “Delete All Instances” on page 148

➤ “Modify or Reset the Data within a Data Instance” on page 148

➤ “Synchronize with the ODB” on page 149

Before completing any of these options, you are advised to read section 
“Process Intervention Reference” on page 150, which provides information 
on the possible impacts of making these changes.

Opening the Process Intervention Page

You access the Process Intervention page as follows:

 1 Select Admin > Business Process Insight

You are presented with a tabbed page that includes a tab for Process 
Intervention.

 2 Click the tab for Process Intervention and you are presented with a page 
requesting you to select from Process Definitions, Data Definitions or 
Synchronize with the ODB.

 3 Select the option for the task that you want to complete.

Deleting Process or Data Definitions and Clearing Data

This section describes how to:
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➤ Delete Process and Monitor Definitions, and instances of these 
definitions.

➤ Delete Process, Monitor and Data Definitions and all related instances.

➤ Clear Average Time and Total Instance Count for both the Process and the 
Process Activities).

➤ Delete Data Definition and associated instances

➤ Clear Average Time and Total Instance Count

If you want to deleted individual instances and not the Process or Data 
definition refer to the sections below.

To make your required changes:

 1 Open the Process Intervention page.

 2 Select the Process Definitions or Data Definitions option as appropriate.

 3 Select the Process or Data definition that you want to modify, or delete.

 4 Select the option for the task that you want to complete.

When you have completed your changes you can exit from the Process 
Intervention page.

Search for Specific Instances

To search for a specific instances of a process or data definition:

 1 Open the Process Intervention page.

 2 Select the Process Definitions or Data Definitions option as appropriate

 3 Click the Search option for the definition that you are interested in.

The search dialog various according to whether you are searching for a 
process or a data instance.

 4 Enter the criteria for the search as appropriate.

In the case of a Process instance, you can enter a Process instance 
identifier directly, or you can filter for instances according to the 
following criteria:

➤ Process instances with a specific identifier and value for the Process 
Value parameter.
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➤ Process instances within specified time periods.

➤ Process instances that are in a particular state, for example: Active or 
Completed.

In the case of a Data instance, you can search based on the values of the 
properties of the Data instances. You are presented with a Data Instance 
List page where you can delete or edit the Data Instances that match the 
search criteria.

When you choose to edit a Data instance, you are presented with a Data 
instance screen where you have access to the properties of the Data 
instance in order to confirm that it is the definition that you are 
interested in.

When modifying the properties of a Data instance, make sure that you 
enter the correct Type for the property, for example, if the property is an 
Integer, a numeric value for the property must be specified.

 5  Click the Search button to initiate the search. If you want to return to the 
previous screen click Cancel.

You can leave the search criteria blank, in which case the Intervention 
tool returns all the instances for the selected definition.

Change the State of an Instance

To change the state of a process or data instance:

 1 Open the Process Intervention page.

 2 Select the Process Definitions or Data Definitions option as appropriate

 3 Click the search option for the definition that you want to list instances 
for.

The search option enables you to filter the list of instances that are 
presented.

 4 Enter the criteria for the search; see “Search for Specific Instances” on 
page 146 for information related to completing the search criteria. Click 
the Search button to initiate the filter. If you want to return to the 
previous screen click Cancel.

You can leave the search criteria blank, in which case the Intervention 
tool returns all the instances for the selected definition.
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 5 Select the instance that you want to modify and click the Edit option.

 6 Make the change to the State of the instance at the required Activity and 
click OK.

Continue and make changes to other instances in the same way.

When you have completed your changes you can exit from the 
Intervention page.

Delete All Instances

To delete all instances of a process or data definition:

 1 Open the Process Intervention page.

 2 Select the Process Definitions or Data Definitions option as appropriate

 3 Click the Search option for the definition that you want to delete the 
instances for.

 4 Enter the criteria for the search; see “Search for Specific Instances” on 
page 146 for information related to completing the search criteria. Click 
the Search button to initiate the filter. If you want to return to the 
previous screen click Cancel.

You can leave the search criteria blank, in which case the Intervention 
tool returns all the instances for the selected definition.

 5 Click the Select All button to select all the instances.

 6 Click the Delete button to delete all the instances.

When you have completed your changes you can exit from the 
Intervention page.

Modify or Reset the Data within a Data Instance

To modify the data in a data instance:

 1 Open the Process Intervention page.

 2 Select the Data Definitions option.

 3 Click the Search option for the Data definition that you want to list 
instances for.

 4 Enter the criteria for the search.
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 5 Make the required changes to the data Select the instance that you want 
to modify and click the Edit option.

You can leave the search option blank to select all the instances for the 
Data definition.

The full list of instances for the definition is presented.

 6 Select the Data instance that you want to modify and click the Edit 
button.

The Data instance details are presented in on editable form.

 7 Edit the Data instance as appropriate and click OK.

When you have completed your changes you can exit from the Process 
Intervention page.

Synchronize with the ODB

To synchronize the BPI definitions with those held in the ODB, complete 
the following steps:

 1 Open the Process Intervention page.

 2 Select the Synchronize with the ODB option.

You have the option to delete all existing BPI CIs from the ODB before 
synchronizing. This is useful if there are CIs in the ODB that have been 
created by previous installations and processes were not undeployed 
before BPI was uninstalled.

 3 Select the checkbox if you want to delete all existing BPI CIs, clear the 
checkbox if you do not want to delete them.

 4 Click the Synchronize button to commence the synchronization.

When the synchronization is complete, you can exit from the Process 
Intervention page.
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Reference

Process Intervention Reference

This section provides background information relating to using the Process 
Intervention tool to delete or modify definitions and instances. 

Typically, you have identified an anomaly using the Business Process Insight 
Application, and are therefore using the Process Intervention tool to solve a 
specific problem. In this case, you have the identifier of the definition that 
you want to modify and you can enter this identifier directly on the search 
page to access the definition that you want to modify. Alternatively, you can 
use the Intervention tool’s filtering capability to search for the instance that 
you want.

You need to be aware of the following when using the Intervention tool:

➤ When selecting the option to delete a Process and associated Data 
definition, make sure that the Data definition is not also a dependency 
for other Process definitions. If the Intervention tool detects that by 
deleting the Data definition other deployed processes are affected, it 
presents you with a page that lists all the processes that also depend on 
the Data definition, where appropriate.

➤ When you select the option to delete a data instance, or a process 
instance including all its data instances, you can potentially leave other 
process instances in an indeterminate state.

This is a similar scenario to the previous bullet describing Process and 
Data definitions; however, in the case of instances, the Business Impact 
Engine cannot determine any relationships between the data instance 
that is being deleted and other process instances that might have a 
dependency on it.

If you do delete a data instance and there are process instances that 
depend on it, the process can no longer progress.
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If you want to delete a significant number of process instances or data 
instances, the quickest way to achieve this is to delete the Process definition 
or Data definition; however, this deletes all instances of the Process and 
Data definitions, including any active instances. You can then redeploy the 
Process and Data definitions using the BPI Modeler. 

Using the Process Intervention Option
On the Process Intervention page, you are offered the following menu 
options:

➤ Process Definitions

➤ Data Definitions

➤ Synchronize with the ODB

When you select one of the options (Process Definitions or Data Definitions), 
you are presented with a list of definitions within the selected category. The 
actions that you can complete at this point depend on the definition that 
you have selected:

➤ for Process definitions, refer to section “Process Definitions” on page 151.

➤ for Data definitions, refer to section “Data Definitions” on page 152.

Caution: If you make changes to the values of data properties within a 
process, the progression rules associated with the data properties are 
evaluated and the process progresses, based on the new values.

Process Definitions

When you select the Process Definitions option from the Intervention tool 
menu, you are presented with a list of Process definitions that are deployed 
in the Business Impact Engine.

The Process definitions within the Modeler are not impacted by the actions 
of the Intervention tool, so you can redeploy the Process; however active 
and completed instances of the process are potentially impacted by changes 
made through the Intervention tool.
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At this stage, you can choose one of the following options:

➤ Delete Process and Monitor Definitions and instances

➤ Delete Process, Monitor and Data Definitions and all related instances

➤ Clear Average Time and Total Instance Count (Process and Activities)

This clears (or removes) the values for TotalFlows and AvrgTime from the 
Flows table in the BPI Instance database.

You can also choose to select:

➤ the Search option to identify specific instances of the definition; see 
“Search for Specific Instances” on page 146.

➤ the Edit option and a process diagram is displayed. The process diagram 
shows the status of each Activity in the process, for example, whether it is 
in the started or completed state. You can progress process instances from 
this option, by manually activating or completing Activities in the 
process.

The following are the icons that can be associated with each instance:

➤ a tick, which indicates that the Activity instance has completed at least 
once

➤ a cog wheel, which indicates that the Activity instance is started

➤ no icon, which indicates that the Activity instance is not started or 
completed

Data Definitions

When you select the Data Definitions option from the Intervention tool 
menu, you are presented with a list of Data Definitions that are currently 
deployed in the Business Impact Engine.

At this stage, you can choose one of the following options:

➤ Delete Data Definition and instances

➤ Clear Average Time and Total Instance Count

This clears (or removes) the values for TotalInstances and AvrgTime from 
the Data Objects table in the BPI Instance database. The Business Process 
Insight Server Administration Guide describes the database tables in detail.
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You can also choose to select the Search option to identify specific instances 
of the definition; see “Search for Specific Instances” on page 146.

The Data definitions within the Modeler are not impacted by the actions of 
the Intervention tool, so you can redeploy the Data definition; however all 
active instances of the Data definition, and possibly the associated Process 
definition, are impacted by changes made through the Intervention tool.
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7
Notification

This chapter includes:

Concepts

➤ Notification Server Overview on page 156

Tasks

➤ How to Perform Notification Server Administration Tasks on page 160

Reference

➤ Methods for All Violations on page 179

➤ Methods Specific to Process Impact Violations on page 180

➤ Methods Specific to Out-of-Sequence Violations on page 182

➤ Methods Specific to Monitor and Instance Threshold Violations 
on page 183

➤ Environment Variables for Scripts on page 187
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Concepts

Notification Server Overview

This chapter describes the BPI Notification Server pages and how to use 
them to configure the Notification Server to process subscriptions for 
notifications such as process impact and monitor instance threshold 
violations.

Note: You cannot open or use the Notification pages, unless you have 
installed the BPI Server. The Notification options appear when the BPI Server 
is installed and the connectivity between the BPI Server and the BSM 
Gateway Server has been configured. This configuration is described in the 
"Component Configuration - HP Business Service Management Settings" 
section of the Business Process Insight Server Administration Guide.

The chapter also describes how to configure the Notification Server email 
templates and scripts, which can then be used to deliver notifications that 
are received by the Notification Server.

The Notification Server is the BPI component responsible for sending email 
notifications and HP Operations Manager messages for events. These 
messages provide details of the process impact, monitor instance threshold 
and out-of-sequence events. You can receive these notifications through 
your email client or through an HP BTO Software client according to your 
requirements. 

You also have the option to execute a script when an impact event is 
received; for example, the script might update a file, or send an SMS 
message.
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The Notification component can be considered to be in two parts:

➤ Server, which is responsible for receiving the impact events from the 
Business Impact Engine and converting them into the appropriate email 
messages and HP Operations Manager Messages for delivery. For more 
details, see “Notification Server Component” on page 157.

➤ Notification Server administration console, which enables you to create 
subscriptions for users to receive email notifications. It also enables you to 
create subscriptions for HP Operations Manager messages and scripts. For 
more details, see “How to Perform Notification Server Administration 
Tasks” on page 160. 

Notification Server Component
The Notification Server is a component of the BPI Server and is responsible 
for notifying you of the process-impact, out-of-sequence and 
monitor-threshold violations that you have configured through the 
Notification option for the Business Process Insight Application. The tasks 
for using the Notification options are described in “How to Perform 
Notification Server Administration Tasks” on page 160.

Notifications can be sent either through an SMTP server to an email client, 
or as an HPOM message to an HPOM Server. There is a retry mechanism for 
both types of notifications if either the SMTP server or HP Operations 
Manager is not available for any reason. Notifications are queued and retried 
after a configurable interval.
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The following diagram shows the architecture of the Notification Server and 
its relationship to other BPI Server components.

Business violations are created by the Notification Server as a result of 
receiving:

➤ process-impact and out-of-sequence notification events from the business 
object manager through the Business Event Handler Transmitter.

➤ monitor instance threshold violation notification events from the 
Monitor Engine.

The Notification Server sends these events as business violations to you, 
based on a set of filters. These are filters that you create and that specify the 
impact events for which you want notification. You can filter email 
notifications based on event name, event type and the name of the Business 
Process.
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In addition to sending violations when an event is received, the Notification 
Server can also run any script (.bat file) that you have created. Creating 
scripts is described in section “Creating Script Files” on page 176.

Email Notification Messages
The email notifications contain impact information about:

➤ the Business Processes that you are monitoring.

➤ out-of-sequence events.

Out-of-sequence events are those events that you have chosen to monitor 
using the Check sequence option, which is an option on the BPI Modeler.

➤ monitor instance threshold violations.

There is a default template for these email notifications; however, you can 
change the layout of the email messages that are sent by the Notification 
Server. You can also configure the templates for the email notifications and 
add properties from the business violations into the messages and configure 
how many email notifications that you receive for a particular monitor 
instance threshold violation.

The default templates are provided as part of the BPI installation and 
instructions for creating your own templates and configuring monitor 
thresholds are provided in Chapter 4, “Monitor Definer.”

The following are the template types that you can use to change the format 
of your messages, if required:

➤ Velocity, which is a Java-based template Engine.

➤ XSLT, which transforms one XML document into another text document. 

It does not matter which tool you use, it is entirely dependent on your own 
preferences.
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Tasks

How to Perform Notification Server Administration 
Tasks

The following are the tasks that you can complete when using the 
Notification option:

➤ “Managing Email Subscriptions” on page 160

➤ “Managing HP Operations Manager Message Subscriptions” on page 164

➤ “Managing Script Subscription” on page 167

➤ “Creating Notification Server Templates” on page 169

➤ “Creating Script Files” on page 176

Managing Email Subscriptions

This section includes creating:

➤ subscriber accounts to receive specific process impact events that are 
generated by the BPI Server.

➤ subscriber accounts to receive specific monitor instance threshold events 
that are generated by the BPI Server.

➤ subscriber accounts to receive specific out-of-sequence events that are 
generated by the BPI Server.

Complete the following steps to configure the Notification 
Server

 1 Make sure the Servlet Engine component is started using the BPI Server 
Administration Console, which is located on the system where the BPI 
Server is running.

 2 On the system where Business Service Management is running, select 
Admin > Business Process Insight.

A tabbed page displays, which includes a tab for Notification.
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 3 Click the tab for Notification and you are presented with a page requesting 
you to select from Email Subscriptions, Script Subscriptions or HPOM 
Message Subscriptions.

 4 Select Email Subscriptions.

 5 Click the New User button to add a new user.

The User Information screen displays.

 6 On the User Information screen:

 a Enter a User Name 

This is a name that you want to assign to the user; it can be any name 
that identifies the user subscription.

 b Enter an Email Address

This is the email address for the user named in the previous step. This 
must be a valid email account.

 c Click OK.

The new user now has an account on the Notification Server and is 
listed in the User List with the other users. 

You now have the option to:

➤ add another new user as described in the above steps.

➤ subscribe the new user account to the events that you want it to receive. 
To do this refer to section “Configuring the Events Received by 
Notification Server Users” on page 162.

➤ return to the main menu, where you can add more email subscriptions or 
add HP Operations Manager message subscriptions.

➤ delete an entry in the User List. To do this select the checkbox next to the 
User Name entry that you want to delete and then click the Delete button.
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Configuring the Events Received by Notification Server Users 

When you have added the user accounts for the users to receive 
notifications, you then need to configure these user accounts to subscribe to 
BPI events that you want them to receive. To do this, select the Subscriptions 
link on the Users List screen, under the Email Subscriptions column, for the 
user that you want to configure. This link takes you to the Process 
Subscriptions list for that user.

 1 Click the New Subscription button.

You are taken to the EMail Subscription Details screen where you can add 
the email subscription details.

 2 Select the Event Name and the Process Name for your new event 
subscription:

➤ Event Name:

You can select from: Process Impacted events, Process Monitor 
Threshold Violation Events, Process Out Of Sequence events, or All 
events. If you select All you subscribe to all types of event.

➤ Process Name:

You can select all process names to report on, or you can choose a 
specific process that is deployed to the Business Impact Engine. There 
is a drop down list provided, which lists all the deployed processes for 
you to select from, including the All option.

Click Next.

 3 If you selected Process Monitor Threshold Violation Events, continue at step 
5.

 4 If you selected All, Process Impacted or Process Out Of Sequence as the 
Event name, you are prompted to select the Minimum Severity Level and 
the Template for your new subscription:

➤ Minimum Severity Level:

This is the minimum severity level for which you want to receive email 
notifications; for example, if you select Critical you will receive email 
notifications only for violations that are critical. If you select Minor, 
you receive email notifications for Minor, Warning, Major and Critical 
violations.
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➤ Template:

Select the template that is appropriate to your Event Name, for 
example, you might have created your own template for the event. 

➤ If you have selected Process Impacted as the Event Name, choose 
the EMAIL-ProcessImpactedDefault.vm template. 

➤ If you have selected Process Monitor Threshold as the Event Name, 
choose the EMAIL-MonitorThresholdDefault.vm template. 

➤ If you have selected Process Out of Sequence, choose the 
EMAIL-OutOfSequenceDefault.vm template. 

➤ If you have selected All for the Event Name, choose the 
EMAIL-GenericDefault.vm template, as it provides the most detailed 
information.

Note: If you create two subscriptions for the same event type, each with 
different templates, BPI uses the template from the more restrictive 
subscription to format the violation. For example, if you create a 
subscription for all process impact events using one template and a 
subscription for a specific process impact event using a different template; 
the template for the specific process impact event is the one used to 
format the violation.

 5 If you selected Process Monitor Threshold Violation Events, you are 
prompted for the following information, in addition to that requested in 
step 4:

➤ Monitor Name

➤ Monitor Threshold Name

 6 Click OK to commit the subscription to the administration database.

The new Event Subscription is now added to the list of Process 
Subscriptions for the user.

You now have the option to:
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➤ add another subscription as described above.

➤ delete an entry in the subscription list. To do this select the checkbox 
next to the entry that you want to delete and then click the Delete 
button.

➤ logout of the Notification Server Administration Console. You do this by 
closing the Web Browser Window where the console is running.

Managing HP Operations Manager Message Subscriptions

The Notification Server uses Velocity and XSLT templates to create HP 
Operations Manager messages before forwarding the message to the HP 
Operations Manager agent.

The HP Operations Manager agent then applies one or more templates to 
filter out unwanted messages and to make any additional changes to the HP 
Operations Manager message format.

Before configuring BPI to send events to HP Operations Manager, ensure 
that the HP Operations Manager Agent and Message Interface template are 
installed and set up on the system where the BPI Server, including the 
Notification Server are installed.

Complete the following steps to configure the Notification Server to send 
HP Operations Manager message notifications to the HP Operations 
Manager Agent for process impact, out-of-sequence or monitor instance 
threshold notification events: 

 1 Make sure the Servlet Engine component is started using the BPI Server 
Administration Console, which is located on the system where the BPI 
Server is running.

 2 On the system where Business Service Management is running, select 
Admin > Business Process Insight.

A tabbed page displays, which includes a tab for Notification.

 3 Click the tab for Notification and you are presented with a page 
requesting you to select from Email Subscriptions, Script Subscriptions or 
HPOM Message Subscriptions.

 4 Select HPOM Message Subscriptions.
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 5 Click the New Subscription button.

You are presented with an HPOM Subscription Details screen where you 
can enter the subscription details for the HP Operations Manager 
messages.

 6 From the New Event Subscription screen, select the Event Name and the 
Process Name for your new event subscription:

➤ Event Name

You can select to filter for Process Impacted events, Process Monitor 
Threshold events, Process Out Of Sequence events, or All events. If you 
select All, you receive HP Operations Manager impact violations for all 
BPI notification events.

➤ Process Name

You can select all process names to report on, or you can choose a 
specific process that you have defined. There is a drop down list 
provided, which lists all the deployed processes for you to select from, 
including the All option.

 7 Click Next.

 8 If you selected Process Monitor Threshold Violation Events, continue at 
step 10.

 9 If you selected All, Process Impacted or Process Out Of Sequence as the 
Event name, you are prompted to select the Minimum Severity Level and 
the Template for your new subscription:

➤ Minimum Severity Level:

This is the minimum severity level for which you want to receive email 
notifications; for example, if you select Critical you will receive email 
notifications only for violations that are critical. If you select Minor, 
you receive email notifications for Minor, Warning, Major and Critical 
violations.
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➤ Template:

Select the template that is appropriate to your Event Name, for 
example you might have created a custom template:

➤ If you have selected Process Impacted as the Event Name, choose 
the OVO-ProcessImpactDefault.vm template. 

➤ If you have selected Process Monitor Threshold as the Event Name, 
choose the OVO-MonitorThresholdDefault.vm template. 

➤ If you have selected Process Out of Sequence, choose the template 
for the OVO-OutOfSequence.vm for the template. 

➤ If you have selected All for the Event Name, choose the 
OVO-GenericDefault.vm template, as it provides the most detailed 
information.

Note: If you create two subscriptions for the same HP Operations 
Manager message subscription, each with different templates, BPI uses the 
template from the more restrictive subscription to format the violation. 
For example, if you create a subscription for all process impact events 
using one template and a subscription for a specific process impact event 
using a different template; the template for the specific process impact 
event is the one used to format the violation.

 10 If you selected Process Monitor Threshold Violation Events, you are 
prompted for the following information, in addition to that requested in 
step 9:

➤ Monitor Name

➤ Monitor Threshold Name

 11 Click OK to commit the subscription to the Notification Server 
Administration database.

The new HP Operations Manager Message Subscription is now added to 
the list of HP Operations Manager Subscriptions.
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You now have the option to:

➤ add another HP Operations Manager Message Subscription as described 
above.

➤ delete an entry in the HP Operations Manager Message Subscription list. 
To do this select the checkbox next the entry that you want to delete and 
then click the Delete button.

You can configure the template set used by HP Operations Manager and you 
can filter the events received through HP Operations Manager by 
customizing the HP Operations Manager Message Interface template. Details 
of how to do this are provided in the HP Operations Manager 
documentation.

Managing Script Subscription

You can configure the Notification Server to run a script when it receives 
specific notification events. Section “Creating Script Files” on page 176 
describes how you can create these scripts and provides details of the 
variables that you can include in your scripts to report details of the 
violation as required.

This section describes how to configure the Notification Server to run the 
scripts for specific notifications that it processes for process impact, 
out-of-sequence or monitor instance threshold notification events: 

 1 Make sure the Servlet Engine component is started using the BPI Server 
Administration Console, which is located on the system where the BPI 
Server is running.

 2 On the system where Business Service Management is running, select 
Admin > Business Process Insight.

A tabbed page displays, which includes a tab for Notification.

 3 Click the tab for Notification and you are presented with a page requesting 
you to select from Email Subscriptions, Script Subscriptions or HPOM 
Message Subscriptions.

 4 Select Script Subscriptions.
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 5 Click the New Subscription button.

You are presented with a New Subscription screen where you can enter the 
subscription details for the script.

 6 From the New Script Subscription screen, enter the following details:

➤ Event Name

You can select to filter for Process Impacted events, Process Monitor 
Threshold events, Process Out Of Sequence events, or All events. If you 
select All, you receive HP Operations Manager impact violations for all 
BPI notification events.

➤ Process Name

You can select all process names to report on, or you can choose a 
specific process that you have defined. There is a drop down list 
provided, which lists all the deployed processes for you to select from, 
including the All option.

 7 Click Next.

If there are no scripts defined, the following error is displayed and you 
cannot continue:

No scripts currently available for selection.

See “Creating Script Files” on page 176 for details of creating scripts.

 8 If you selected Process Monitor Threshold Violation Events, continue at 
step 10.

 9 If you selected All, Process Impacted or Process Out Of Sequence as the 
Event name, you are prompted to select the Minimum Severity Level and 
the Template for your new subscription:

➤ Minimum Severity Level:

This is the minimum severity level for which you want to receive email 
notifications; for example, if you select Critical you will receive email 
notifications only for violations that are critical. If you select Minor, 
you receive email notifications for Minor, Warning, Major and Critical 
violations.
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➤ Script Name

Select the script that you want the Notification Server to run when it 
received a notification event for the specified event and process. All 
the scripts that you have defined and saved in the notify-scripts are 
presented in the drop-down list for you to select from.

 10 If you selected Process Monitor Threshold Violation Events, you are 
prompted for the following information, in addition to that requested in 
step 9:

➤ Monitor Name

➤ Monitor Threshold Name

 11 Click OK to commit the subscription to the administration database.

The new Script Subscription is added to the list of Script Message 
Subscriptions.

You now have the option to:

➤ add another New Script Subscription as described above.

➤ delete an entry in the Script Subscription list. To do this select the 
checkbox next the entry that you want to delete and then click the Delete 
button.

Creating Notification Server Templates

The Notification Server uses templates to format email messages and 
messages sent to HP Operations Manager. The templates contain 
instructions on how to format event information, for example, event name 
and event time. You might want customize an email template if you want to 
generate email messages for different locales. 

This section describes how BPI uses these templates and some guidance in 
how you can modify them. You need to be familiar with either XSLT, or 
Velocity to make the changes; XSLT is a standard for transforming XML 
documents. It is up to you which format you choose.
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The Notification Server uses the Apache Velocity template engine to process 
Velocity templates. There is a user guide available with the template engine 
that provides details of creating and using Velocity templates. Details of 
Velocity templates, including a user guide for creating them, can be found at 
the following location:

http://jakarta.apache.org/velocity/

You configure the template used for each event when you create the event 
subscription through the Notification pages. The Notification Server then 
uses the template that you have defined to format all notifications related to 
the specified event. 

Creating an Email Template

You create a custom email template for a specific event. These custom email 
templates must have a file name that starts with the string EMAIL- and a file 
extension of .vm for Velocity templates and .xsl for XSLT templates. 

The Notification Server reads the custom templates from the following 
directory:

bpi-install-dir\data\conf\bia\notify-templates\flows

If you want to modify these templates, make a copy of the appropriate 
example template from the files in the following directory:

bpi-install-dir\examples\bia\NotifSvrTemplates

Make sure that you add your template to the correct directory as the 
Notification pages presents the templates in the context of the selection, 
based on the contents of the above directories. 

You also need to make sure that you copy the template from the examples 
directory to the data directory as the examples directory is updated and files 
replaced if you reinstall BPI.

The Notification Server uses an email template to create XML that describes 
an email. Then the notification server uses the XML to create an email. 
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The email XML is very simple; it contains a subject, content type, and body. 
The actual schema is described in the file email.xsd, which is located at:

bpi-install-dir\misc\bia 

The Notification Server applies the Velocity or XSLT templates that you 
define to a violation from the Business Impact Engine. From this the 
Notification Server is able to create an email XML document based on your 
templates. 

Creating an HP Operations Manager Template

The Notification Server uses a template to create XML that describes the HP 
Operations Manager message. It then uses this XML to create an HP 
Operations Manager message. 

You configure the templates that are used to send HP Operations Manager 
messages through the Notification pages.

Custom HP Operations Manager template files must start with the string 
OVO- and a file extension of .vm for Velocity templates and .xsl for XSLT 
templates. Store custom templates in the following directory:

bpi-install-dir\data\conf\bia\notify-templates\flows

The following is an example of an HP Operations Manager message XML 
document:

<?xml version="1.0" encoding="UTF-8"?>
<OVOMessage xmlns:xsi="http://www.w3.org/2001/XMLSchema
   instance"xsi:noNamespaceSchemaLocation="ovomessage.xsd" >
<Severity>critical</Severity>
<Application>HPBPI application</Application>
<Object>PROCESS_IMPACTED or PROCESS_OUT_OF_SEQUENCE</Object>
<MessageGroup>NOTIFICATIONS</MessageGroup>
<MessageText>A PROCESS_OUT_OF_SEQUENCE violation occurred at 
7.10pm.</MessageText>
<Option>example_option_variable_1=this is an example option 
value</Option>
<Option>example_option_variable_2=this is another example 
option value</Option>
</OVOMessage>
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The example XML document contains an element for each message 
attribute:

➤ message severity

➤ application

➤ object

➤ message group

➤ message text

Optionally, the XML document, can contain message options. An option 
has the form variable=value. The notification server applies Velocity and 
XSLT templates to an violation from the Business Impact Engine to create an 
HP Operations Manager message XML document.

The schema for the message is available at the following location:

bpi-install-dir\misc\bia\ovomessage.xsd

Creating a Velocity Template

This section describes the list of the BPI notification methods that have been 
defined for use within your Velocity template. A variable in the Velocity 
context contains information from an Business Impact Engine event.

A Velocity template is a file that contains the XML describing an email or 
HP Operations Manager message.   

In addition to text, the file can contain Velocity formatting directives. The 
following is an example of an email Velocity template:

<?xml version="1.0" encoding="UTF-8"?>
<Email xmlns:xsi='http://www.w3.org/2001/XMLSchema-instance'
    xsi:noNamespaceSchemaLocation='email.xsd'>
<Subject>
$alert.getSeverity() $alert.getEventName() Alert
</Subject>
<ContentType>text/plain</ContentType>
<Body>
A "$alert.getEventName()" alert has occurred.

Severity: $alert.getSeverity()
Event Group: $alert.getEventGroup()
Event Name: $alert.getEventName()
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Event Time: $alert.getEventTime()
Process Name: $alert.getFlowName()
Frocess Guid: $alert.getFlowGuid()
</Body>
</Email

A formatting directive starts with a hash (#) or a dollar ($); these formatting 
directives are described more fully in the Velocity Users’ Guide. A formatting 
directive is used to insert event information into the XML document. In the 
case of BPI this event information is provided through the alert variables.

The $alert variable contains information from a Business Impact Engine 
event, for example, the service name for the event. The $alert variable 
contains methods such as getFlowName() and getServiceName(), which can 
be used to insert the event flow name and the event service name into the 
XML. (getServiceName() inserts the service name).

Note: If the Velocity templates that you create contain non-ASCII 
characters, you must encode and save the template as UTF8. This UTF8 
needs to be created without a byte order mark (BOM). BOMs are added 
automatically by some Windows editors; for example, Notepad and 
Wordpad. Choose an editor that enables you to exclude the BOM.

If you include a BOM in your template encoding, it is not recognized as an 
XML file.

When the Notification Server generates an email notification message, it 
adds data to the message, where the display language is determined by the 
locale of the BPI Server. If your email recipients are not in the same locale as 
the BPI Server, you can use the Velocity templates to specify the locale for 
the language used for the email notifications. This enables you to provide 
email notifications in several languages if required.

The java Locale() class is used to identify the language string used within the 
alert methods. The definition for the Locale() class can be found at the 
following URL: 

http://java.sun.com/j2se/1.4.2/docs/api/java/util/Locale.html



Chapter 7 • Notification

174

The Locale() class takes a parameter comprising the language code and the 
country code as described in the definition for the Locale() class; for 
example: ko_KR for Korea and en_CA English-speaking Canadian.

For details on the methods, see “Methods for All Violations” on page 179, 
“Methods Specific to Process Impact Violations” on page 180, “Methods 
Specific to Out-of-Sequence Violations” on page 182, or “Methods Specific 
to Out-of-Sequence Violations” on page 182.

XSLT Templates

An XSLT template is a file containing XML that transforms event XML into 
email or HP Operations Manager message XML. An example of an email 
XSLT template is shown below.

<?xml version="1.0" encoding="UTF-8"?>
<xsl:stylesheet xmlns:xsl="http://www.w3.org/1999/XSL/Transform" 
version="1.0"
        xmlns:env="http://schemas.xmlsoap.org/soap/envelope/"
        xmlns:xsi="http://www.w3.org/2001/XMLSchema-instance"
        xmlns:etype="http://www.hp.com/openview/bia/eventtype"
        xmlns:edata="http://www.hp.com/openview/bia/eventdata">
  <xsl:output method="xml"
       indent="no" />

<xsl:template match="/">
<Email xsi:noNamespaceSchemaLocation='email.xsd'>
<Subject>
<xsl:apply-templates select="//env:Body/*/etype:Severity/*"/><xsl:text> </
xsl:text><xsl:value-of select="//etype:EventName" /> Alert</Subject>
<ContentType>text/plain</ContentType>
<Body>
A "<xsl:value-of select="//etype:EventName" />" alert has occurred.

Severity: <xsl:apply-templates select="//env:Body/*/etype:Severity/*"/>
Event Group: <xsl:value-of select="//etype:EventGroup" />
Event Name: <xsl:value-of select="//etype:EventName" />
Event Time: <xsl:value-of select="//etype:EventTime" /><xsl:text>
</xsl:text>
<xsl:for-each select="//edata:DataItem" >
<xsl:choose>
<xsl:when test="edata:Name = 'RootCause'" >
<xsl:text>Root Cause: </xsl:text>
<xsl:for-each select="//edata:Value/Services/Service" >
<xsl:text>-&gt;</xsl:text><xsl:value-of select="Label" />
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</xsl:for-each>
</xsl:when>
<xsl:otherwise>
<xsl:value-of select="edata:Name" /><xsl:text>: </xsl:text><xsl:value-of 
select="edata:Value" />
</xsl:otherwise>
</xsl:choose>
<xsl:text>
</xsl:text>
</xsl:for-each>
</Body>
</Email>
</xsl:template>

<xsl:template match="etype:Critical" >
<xsl:text>Critical</xsl:text>
</xsl:template>

<xsl:template match="etype:Major" >
<xsl:text>Major</xsl:text>
</xsl:template>

<xsl:template match="etype:Minor" >
<xsl:text>Minor</xsl:text>
</xsl:template>

<xsl:template match="etype:Warning" >
<xsl:text>Warning</xsl:text>
</xsl:template>

<xsl:template match="etype:Normal" >
<xsl:text>Normal</xsl:text>
</xsl:template>

</xsl:stylesheet>

The style sheet is applied to the event sent by the Business Impact Engine. 
The style sheet contains email XML text as well as XSL elements. XSL 
elements format information from the form of the event and insert it into 
the email XML. 
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The schemas for the event are located in the files eventtype.xsd and 
eventdata.xsd in the following directory:

bpi-install-dir/misc/bia

The message header contains a business event type, which is described in 
eventtype.xsd. The message body contains a business event type followed by 
business event data; Business event data is described in eventdata.xsd.

Creating Script Files

You can define a script, which is a Windows .bat file, to be run when a 
notification event is received by the Notification Server; for example, this 
script might send an SMS message to a recipient directly (bypassing the 
email server), or it might update an entry in a database or spreadsheet.

You can create a script to complete any action that you want, and you can 
also include any of the environment variables that have been defined for 
use within your scripts. These environment variables identify configuration 
information relating to the BPI data available for notifications and are 
defined in section “Environment Variables for Scripts” on page 187.

These environment variables are included in your scripts using the 
following notation:

%env_name%

where %env_name% is an environment variable name, for example, 
%OVBPI_FLOWNAME%.

For details on the environment variables, see “Environment Variables for 
Scripts” on page 187.

The following examples show how you can create a script and configure the 
Notification Server to run the script when a specific notification event is 
received.
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Example Script to Write a String to a File

The following is an example of the steps that you need to complete in order 
to configure the Notification Server to write the string Hello World to a file 
on receipt of a specific process impact event:

 1 Create the script that you want to be executed when the notification 
event is received, for example:

echo "hello world" >>c:\notif.txt

This script writes the string "hello world" to the file notif.txt in the root of 
your c: drive.

 2 Save the script to the following location with a unique file name and a 
.bat file extension:

bpi-install-dir/data/conf/bia/notify-scripts

The Notification Server looks in this directory for scripts and presents 
these scripts to you through the Web Administration Console for the 
Notification Server when you are configuring subscriptions. Note that if 
the script that you create does not have a .bat file extension, it is ignored.

 3 Follow the instructions in “Managing Script Subscription” on page 167 to 
create a subscription for the script selecting Process Impacted as the Event 
Name and the name of the process for the Process Name.

If you have the Web Administration for the Notification Server 
administration open at the New Event Subscription page, you might need 
to click the Refresh option on your Web Browser. This refreshes the page 
and adds the new script to the list.
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Example Script to Write Process Name and Blocked Instances to 
a File

The following is an example of the steps that you need to complete in order 
to configure the Notification Server to take the process name and the 
number of blocked instances from the event data and write the information 
to a file on receipt of a specific process impact event:

 1 Create the script that you want to be executed when the notification 
event is received, for example:

echo %OVBPI_FLOWNAME%, 
%OVBPI_NOOFBLOCKEDINSTANCES%>>c:\notif2.txt

This script writes the values of the process name and the number of 
blocked instances to the file notif2.txt in the root of your c: drive.

 2 Save the script to the following location with a unique filename:

bpi-install-dir/data/conf/bia/notify-scripts

The Notification Server looks in this directory for scripts and presents 
these scripts to your through the Web Administration Console for the 
Notification Server when you are configuring subscriptions.

 3 Follow the instructions in section “Managing Script Subscription” on 
page 167 to create a subscription for the script selecting Process Impacted 
as the Event Name and the name of the process for the Process Name.

If you have the Web Administration for the Notification Server 
administration open at the New Event Subscription page, you might need 
to click the Refresh option on your Web Browser. This refreshes the page 
and adds the new script to the list.
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Reference

Methods for All Violations

The following table lists the alert methods that can be used for all violations: 
Process Impact, Process Out-Of-Sequence, Business Monitor and Monitor 
instance threshold.

Alert Method Names Alert Method Description

$alert.getVersion() Returns a STRING containing the version 
number for the BPI event.

$alert.getSeverity(locale) Returns a STRING containing the severity of the 
BPI event. Possible values are Critical, Major, 
Minor, Warning, and Normal. The language used 
for these values is determined by the locale for 
the BPI Server or, if specified, the locale of the 
country and language specified in locale, for 
example:

➤ $alert.getSeverity("ja"), for a Japanese locale

➤ $alert.getSeverity("ko"), for a Korean locale

The value returned is also used to determine the 
color of the text in the email notification.

$alert.getEventGroup() Returns a STRING containing the name of the 
event group for the BPI event, that is, 
NOTIFICATIONS.

$alert.getEventName() Returns a STRING containing the name of the 
BPI event, that is, PROCESS_IMPACTED, 
PROCESS_MONITOR_THRESHOLD_VIOLATIO
N or PROCESS_OUT_OF_SEQUENCE

$alert.getEventTime(locale) Returns a STRING containing the time of the 
BPI event, formatted using the locale for the BPI 
Server or, if specified, the locale of the country 
and language specified in locale.
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Methods Specific to Process Impact Violations

The following table lists the alert methods that can be used for Process 
Impact violations. Using any of these methods for other violations results 
in a message containing erroneous data.

$alert.getEventDataListSize() Returns the number of event data items in the 
BPI event.

$alert.getEventDataNames() Returns an ARRAYLIST of the names of the 
event data items in the BPI event.

$alert.getEventDataByName

(Stringname, locale)

Returns a STRING containing the value of the 
data item with the given name using the locale 
for the BPI Server or, if specified, the locale of 
the country and language specified in locale.

$alert.getEventDataByIndex

(index, locale)

Returns a STRING containing the value of the 
data item located at the supplied index using 
the locale for the BPI Server or, if specified, the 
locale of the country and language specified in 
locale.

Alert Method Name Alert Method Description

$alert.getFlowName() Returns a STRING containing the process 
name for the BPI event.

$alert.getFlowGuid() Returns a STRING containing GUID for the 
process definition in the BPI event.

$alert.getServiceName() Returns a STRING containing the name of the 
service for the BPI event.

$alert.getServiceGuid() Returns a STRING containing the service 
GUID for the BPI event.

Alert Method Names Alert Method Description
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$alert.getFlowNodeString() Returns a STRING containing Activity names 
for the BPI event. An example of a string 
returned by this method is: Bill Customer, 
Check Stock, Remove Item.

$alert.getFlowNodeList() Returns an ARRAYLIST of Activity names in 
the BPI event. You can use the methods 
defined in the ArrayList class. For example, 
you can access the first element of an array 
list named flowNodeList using 
$flowNodeList.get(0)

$alert.getFlowNodeListSize() Returns the number of elements in the 
process Activity list in the BPI event.

$alert.getRootCause() Returns a STRING containing the labels of the 
root cause services in the BPI event. (Note 
that this string cannot be localized.) An 
example of a string returned by this method 
is: Oracle Financial System-&gt;Oracle System 
Europe-&gt;Network Resources

$alert.getFlowNodeStatusList() Returns an ARRAYLIST of the status of the 
Activities in the BPI event. You can use the 
methods defined in the ArrayList class. For 
example, you can access the first element of 
an array list namesFlowNodeStatusList using 
$flowNodeStatusList.get(0).

Alert Method Name Alert Method Description



Chapter 7 • Notification

182

Methods Specific to Out-of-Sequence Violations

The following table lists the methods for out-of-sequence events only. Using 
any of these methods for other violations results in a message containing 
erroneous data.

$alert.getFlowNodeStatusString(l
ocale)

Returns a STRING containing the labels for 
the Activity status in the BPI event. For 
example, Critical, Major, Minor, Warning and 
Normal. These status correspond to the HP 
Operations Manager severity levels.

The language used for these values is 
determined by the locale for the BPI Server or, 
if specified, the locale of the country and 
language specified in locale, for example:

➤ $alert.getFlowNodeStatusString("ja"), for a 
Japanese locale

➤ $alert.getFlowNodeStatusString("ko"), for a 
Korean locale

$alert.getFlowNodeStatusList

Size()

Returns the number of elements in the 
process Activity status list in the BPI event.

Alert Method Name Alert Method Description

$alert.getFlowName() Returns a STRING containing the process 
name for the BPI event.

$alert.getFlowGuid() Returns a STRING containing GUID for the 
process definition in the BPI event.

$alert.getFlowInstanceGuid() Returns a STRING containing GUID for the 
process instance in the BPI event.

$alert.getSourceNode() Returns a STRING containing the name of the 
Activity that is the source Activity for the 
out-of sequence violation.

Alert Method Name Alert Method Description
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Methods Specific to Monitor and Instance Threshold 
Violations

The following table lists the monitor and instance threshold violation 
notification events only. Using any of these methods for other violations 
results in a message containing erroneous data.

$alert.getDestinationNode() Returns a STRING containing the name of the 
Activity that is the destination Activity for the 
out-of sequence violation.

$alert.getFlowIdentifier() Returns a STRING containing the identifier for 
the impacted process instance.

Alert Method Name Alert Method Description

$alert.getThresholdAlertGuid() Returns a STRING containing the internal 
unique identifier (GUID) of the instance 
threshold violation event raised for a specific 
instance threshold violation.

The following methods are duration periods that correspond to the Threshold 
violation notification polling interval (seconds) as set in the BPI Server 
Administration Console for Monitor Engine threshold violation notification 
settings.

It is called the actual period because it can differ from the requested configuration 
interval according to the other priorities that the machine, and the JVM, have at 
the times the requests to start and stop tracking are made.

getThresholdAlertNotification
PeriodDurationHours()

Returns a STRING containing the duration of 
actual notification period in terms of hours.

getThresholdAlertNotification
PeriodDurationHours(locale)

Returns a STRING containing the duration of 
actual notification period in terms of hours, 
using the locale for the BPI Server or, if 
specified, the locale of the country and 
language specified in locale.

Alert Method Name Alert Method Description
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getThresholdAlertNotification
PeriodDurationMinutes()

Returns a STRING containing the duration of 
actual notification period in terms of minutes.

getThresholdAlertNotification
PeriodDurationMinutes(locale)

Returns a STRING containing the duration of 
actual notification period in terms of minutes, 
using the locale for the BPI Server or, if 
specified, the locale of the country and 
language specified in locale.

getThresholdAlertNotification
PeriodDurationSeconds()

Returns a STRING containing the duration of 
actual notification period in terms of seconds.

getThresholdAlertNotification
PeriodDurationSeconds(locale)

Returns a STRING containing the duration of 
actual notification period in terms of seconds, 
using the locale for the BPI Server or, if 
specified, the locale of the country and 
language specified in locale.

$alert.getThresholdAlert
NotificationPeriodStart()

Returns a STRING containing the start time of 
the Threshold violation notification period. 
Start time is the time from and including the 
time specified.

$alert.getThresholdAlert
NotificationPeriodEnd()

Returns a STRING containing the end time of 
the Threshold violation notification period. 
End time is the time up to but not including 
the time specified.

$alert.getThresholdAlertStatus
ChangeTime()

Returns a STRING containing the time that the 
Metric_Fact_Alerts table was updated with 
the instance threshold alert notification.

$alert.getThresholdAlertRaised
Time()

Returns a STRING containing the time that the 
event notification was sent to the Notification 
Server.

$alert.getThresholdGuid() Returns a STRING containing the internal 
unique identifier (GUID) for the monitor 
instance threshold defined for the Business 
Process Monitor in the BPI event.

Alert Method Name Alert Method Description
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$alert.getThresholdMessage() Returns a STRING containing the monitor 
instance threshold message in the BPI event.

This is the message that you have defined to be 
displayed when the event is triggered. 

$alert.getThresholdName() Returns a STRING containing monitor instance 
threshold name in the BPI event.

$alert.getThresholdNumber
NotificationsInPeriod()

Returns a STRING containing the total number 
of notifications sent for the instance threshold 
in the Threshold violation notification polling 
interval. 

$alert.getThresholdNumber
AlertsInPeriod()

Returns a STRING containing the total number 
of instance threshold violations generated for 
the instance threshold in the Threshold 
violation notification polling interval.
The number of instance threshold violations 
generated might be different to the number of 
notifications sent, depending on how you 
have configured the instance threshold 
violation notification settings.

$alert.getThresholdNumber
NormalAlertsInPeriod()

Returns a STRING containing the total number 
of Normal instance threshold violations 
generated for the instance threshold in the 
Threshold violation notification polling 
interval.
This number is a subset of 
getThresholdNumberAlertsInPeriod().

$alert.getThresholdNumber
WarningAlertsInPeriod()

Returns a STRING containing the total number 
of Warning instance threshold violations 
generated for the instance threshold in the 
Threshold violation notification polling 
interval.
This number is a subset of 
getThresholdNumberAlertsInPeriod().

Alert Method Name Alert Method Description
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$alert.getThresholdNumber
MinorAlertsInPeriod()

Returns a STRING containing the total number 
of Minor instance threshold violations 
generated for the instance threshold in the 
Threshold violation notification polling 
interval.
This number is a subset of 
getThresholdNumberAlertsInPeriod().

$alert.getThresholdNumber
MajorAlertsInPeriod()

Returns a STRING containing the total number 
of Major instance threshold violations 
generated for the instance threshold in the 
Threshold violation notification polling 
interval.
This number is a subset of 
getThresholdNumberAlertsInPeriod().

$alert.getThresholdNumber
CriticalAlertsInPeriod()

Returns a STRING containing the total number 
of Critical instance threshold violations 
generated for the instance threshold in the 
Threshold violation notification polling 
interval.
This number is a subset of 
getThresholdNumberAlertsInPeriod().

$alert.getFlowMetricGuid() Returns a STRING containing the Business 
Process Monitor GUID in the BPI event.

$alert.getFlowMetricName() Returns a STRING containing the Business 
Process Monitor name in the BPI event.

$alert.getFlowMetricValue() Returns a STRING containing the Business 
Process Monitor value in the BPI event.

Alert Method Name Alert Method Description
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Environment Variables for Scripts

The following tables list the environment variables that can be used within 
your scripts to report data on process impact, process out-of-sequence and 
monitor instance threshold violations.

The following table lists the environment variables that are available for all 
BPI violations.

The following table lists the environment variables available for process 
impact violations. Using these environment variables for other alerts results 
in erroneous data being returned.

Variable Description

OVBPI_EVENTGROUP name of the event group, which is always 
NOTIFICATIONS.

OVBPI_EVENTNAME name of the event: PROCESS_IMPACTED, 
PROCESS_MONITOR_THRESHOLD_VIOLATI
ON or PROCESS_OUT_OF_SEQUENCE.

OVBPI_SEVERITY severity of the BPI event. Possible values are 
Normal, Warning, Minor, Major or Critical

Variable Description

OVBPI_FLOWGUID internal unique identifier (GUID) for the 
process definition in the BPI event.

OVBPI_FLOWNAME name of the process in the BPI event

OVBPI_NOOFBLOCKEDINSTANC
ES

number of blocked process instances at the 
time of the PROCESS_IMPACTED event. A 
blocked instance is an instance of the 
process that is active at an Activity and 
cannot proceed as there is a problem in an 
underlying operational service.
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The following table lists the environment variables available for instance 
threshold violations. Using these environment variables for other violations 
results in erroneous data being returned.

OVBPI_NOOFIMPEDEDINSTANC
ES

number of at risk process instances at the 
time of the PROCESS_IMPACTED event. An 
at risk instance is where one or more process 
instance has the potential to be blocked in 
the future.

OVBPI_SERVICEGUID internal unique identifier (GUID) for the 
service in the BPI PROCESS_IMPACTED 
event.

OVBPI_SERVICENAME name for the service in the BPI 
PROCESS_IMPACTED event.

OVBPI_ROOTCAUSE the label of the root cause service, or 
services, in the BPI PROCESS_IMPACTED 
event.

Variable Description

OVBPI_FLOWGUID internal unique identifier (GUID) for the 
process definition in the BPI 
PROCESS_MONITOR_THRESHOLD_VIOLATI
ON event.

OVBPI_FLOWIDENTIFIER identifier for the process instance in the 
PROCESS_MONITOR_THRESHOLD_VIOLATI
ON event. This property contains a value only 
if the instance threshold violation is an 
instance violation, for example, Absolute 
duration. It does not contain a value if the 
property is for a statistical violations, for 
example, a Backlog count. This the property 
that you have nominated to be the identifier 
for the processe.

Variable Description
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OVBPI_FLOWINSTANCEGUID internal unique identifier (GUID) for the 
process instance in the 
PROCESS_MONITOR_THRESHOLD_VIOLATI
ON event. This property contains a value only 
if the instance threshold violation is an 
instance violation, for example, Absolute 
duration. It does not contain a value if the 
property is for a statistical violations, for 
example, a Backlog count. 

OVBPI_FLOWMETRICGUID internal unique identifier (GUID) for the 
process monitor in the 
PROCESS_MONITOR_THRESHOLD_VIOLATI
ON event.

OVBPI_FLOWMETRICNAME name of the process monitor in the BPI 
PROCESS_MONITOR_THRESHOLD_VIOLATI
ON event. 

OVBPI_FLOWMETRICVALUE value of the process monitor in the BPI 
PROCESS_MONITOR_THRESHOLD_VIOLATI
ON event.

OVBPI_FLOWNAME name of the process in the BPI 
PROCESS_MONITOR_THRESHOLD_VIOLATI
ON event

OVBPI_THRESHOLDALERTGUID internal unique identifier of the instance 
threshold identified in the BPI 
PROCESS_MONITOR_THRESHOLD_VIOLATI
ON event.

OVBPI_THRESHOLDMESSAGE message defined for the BPI 
PROCESS_MONITOR_THRESHOLD_VIOLATI
ON event. This is the message that you have 
defined to be displayed when the event is 
triggered.

OVBPI_THRESHOLDNAME name of the monitor instance threshold in the 
PROCESS_MONITOR_THRESHOLD_VIOLATI
ON event.

Variable Description
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The following table lists the environment variables for the Out-of-Sequence 
violations. Using these environment variables for other violations results in 
erroneous data being returned.

Variable Description

OVBPI_FLOWIDENTIFIER identifier for the process instance in the BPI 
event. This the property that you have 
nominated to be the identifier for the 
process.

OVBPI_FLOWINSTANCEGUID internal unique identifier (GUID) for the 
process instance in the BPI event. 

OVBPI_SOURCENODE name of the Activity that is the source 
Activity for the out-of-sequence violation.

OVBPI_DESTINATIONNODE name of the Activity that is the destination 
Activity for the out-of-sequence violation.
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9
Introduction to Reports

This chapter includes:

Concepts

➤ BPI Reports Overview on page 194

Tasks

➤ How to Use the Reports to View and Analyze Data on page 196
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Concepts

BPI Reports Overview

This chapter provides an overview of the reports you can view on the BPI 
Application pages.

BPI enables you to view the overall status of your Business Processes and 
Business Process Monitors, including any links that you might have to IT 
operational resources.

The BPI Application pages can be accessed from the following menu option:

Applications > Business Process Insight

Note: The Business Process Insight Application reports and their data are 
available only when you have installed the BPI license, BPI Server, and 
configured the Server to send data samples to the Gateway Server.

The BPI Reports provide:

➤ an overall view of the health and status of the Business Processes that you 
have deployed in your BPI system, including the status of any Business 
Process Monitors.

➤ an overall view of the status of the IT operational resources that you have 
linked your Business Process Activities to.

➤ details of the individual process instances and their progression through 
the Activities in the process.

➤ details of the active process instances at individual Activities in the 
process.

➤ details of any thresholds that have been violated.

➤ details of the transactions that you have linked your Business Process 
Activities to within TransactionVision.
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➤ graphical representation of your monitor data, which can be displayed in 
terms of times, where appropriate.

➤ a view of the aggregated Monitor data, which can include minimums, 
maximums and standard deviations.

➤ ability to configure the types of graphs and the period over which the 
monitor data should be presented.

➤ ability to search for specific process instances.
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Tasks

How to Use the Reports to View and Analyze Data

The following steps describe how to use the reports to view and analyze 
data.

Note: Three main reports enable you to track and monitor your Business 
Processes. In addition, you can also use the Business Process Diagram, 
which is available from the Application > Service Health menu. For details 
on using the Business Process Diagram in Service Health, see Chapter 14, 
“BPI Components in MyBSM.”

Use the reports to view data

 1 To view all the Business Processes that are currently selected to be 
monitored use the Scorecard. The Scorecard displays the current values of 
the configured KPIs; see Chapter 11, “BPI Application Scorecard”. 

The Value is based on the Process Value property of the Business Process. 
The Process Value is assigned when you create the Business Process in the 
Modeler.

 2 To view a graphical representation of a selected Business Process in the 
form of the process diagram, use the Health tab. The process diagram is 
annotated with information of the overall Business Process in both 
business and operational terms, and the individual Activities in the 
process.

In addition, there are links to more details of the various components of 
your Business Process; see Chapter 10, “BPI Application Health”.

 3 To view data for Business Processes and Business Process Activities, use the 
following reports in the BPI Application:

➤ BPI Process Summary
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➤ BPI Monitors Over Time

➤ Business Process Activity Summary

The Reports are described in Chapter 12, “BPI Application Reports”.

Customize the Business Process Diagrams and use annotations 
– optional

You can customize your Business Process diagrams and define annotations 
specific to your processes. Some level of annotation is provided by default; 
however, you can modify the form of these annotations for your Process 
Diagrams. These customizations are described in Chapter 13, “Annotations 
for Process Diagrams”.
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10
BPI Application Health

This chapter includes:

Concepts

➤ Health Page Overview on page 200

➤ BPI Instance and Violation Health Information on page 204

➤ Process Status on page 206

➤ Synchronization and Delay in Seeing Updates to Data on page 207

Tasks

➤ How to Configure Active Monitor Instances in the Infrastructure Settings 
Manager on page 208

Reference

➤ BPI Application Health User Interface on page 209
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Concepts

Health Page Overview

This chapter describes the BPI Application Health pages and explains how to 
navigate and use the them to track and monitor the health of your Business 
Processes. 

The Health pages show the operational and business health of the Business 
Processes that you have defined using the BPI Modeler. The Health pages 
also include data on the Business Process Monitors, Thresholds and KPIs 
that you have defined for the Business Processes.

The Health pages provides:

➤ Graphical representation of a selected Business Process, in the form of the 
process diagram. The process diagram is annotated with information 
relating to the health of the overall Business Process and the individual 
Activities in the process.

➤ Business Process or Business Activity summary information according to 
the selection criteria. This shows the overall business health of the 
Business Process or Business Activity, in tabular and in graphical form. 
You can drill down and view related BPI reports if required.

➤ Details of the KPIs that you have defined for the selected Business Process 
or Business Activity, or Business Process Monitor.

➤ Instance violation counts for the selected Business Process or Business 
Activity.

➤ Ability to view the status of the IT operational resources that are linked to 
Activities in the Business Process.

➤ Ability to filter Business Process and Activity data by a specified group. A 
<group_property> drop-down list displays on the Health page, if the Group 
property was set in the Modeler for the Business Process. The Group 
drop-down lists the groups that were defined in the Modeler.
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If the Group property was not set or was set to None in the Modeler, the 
<group_property> drop-down list does not appear on the Health page or 
any of the Health dialogs. For details on setting the Group property in the 
Modeler, see the Modeler Help menu option.

You can limit the number of groups that can be specified using the BPI 
Server Admin Console, to optimize BPI’s performance. For details on 
setting the group limit, see the "Component Configuration - Business 
Impact Engine (BIE)" section in the Business Process Insight Server 
Administration Guide. If the number of groups specified in the Group 
property field exceeds the group limit, the data for the groups listed 
beyond the exceeded number are combined into a group called Other.

Note: If you had defined groups in the Modeler, but set the Group 
Property to None, and you later decide you want to collect data by groups 
on the client pages, you can reset the Group Property value in the 
Modeler and redeploy the Business Process. Changes to the Group 
Property require redeployment of the process model.

➤ List of the related transaction CIs and KPIs for the selected Business 
Process or Business Activity. You can drill down to the Transaction 
Management Transaction Summary Report for each Business Transaction, 
which displays a list of all completed TransactionVision transactions in a 
specified time frame.

If there are no TransactionVision CIs linked to the Business Process that 
you are viewing, no data is available from this option. 
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Following is an example of the BPI Application Health page

This figure shows the top-level Health Page for the Business Process Insight 
Application.
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The Health Page is subdivided into different areas of focus, but at the 
top-level it provides an overall view of both the business and operational 
health of your deployed Business Processes.

The Health Page is divided into the following areas, each of which provides 
more detailed information:

➤ “Process Diagram Area” on page 210

You can collapse and expand the Process Diagram if you want to provide 
more space for the information shown on the tabbed areas under the 
diagram.

➤ “Summary Tab” on page 217

The Summary Tab displays process instance information and the 
Scorecard over time graph for the selected Business Process.

From the Summary Tab you can link to additional pages, which enable 
access to details of Instances; see “Process Instances Dialog” on page 227

➤ “Business Health Tab” on page 221

The Business Health Tab displays KPI details in the form of a dial and 
instance violation details in the form of a table. 

From the Business Health Tab, you can link to additional pages, which 
enable access to details of:

➤ Violations; see section “Instance Violations Dialog Box” on page 241.

➤ Monitor details; see section “Monitor Dialog Box” on page 244.

➤ BPI Monitors Over Time Report; see section “BPI Monitors Over Time 
Report” on page 283.

To access Applications > Business Process Insight > Health

Important 
Information

The Health page is available only when you have 
configured the BPI Server to connect with the BSM Server 
so that data samples can be sent to the BSM Server. For 
details, see the "Component Configuration - HP Business 
Service Management Settings" section of the Business 
Process Insight Server Administration Guide.
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➤ Process Over Time Report; see section “Business Process Over Time 
Report” on page 291.

➤ Activity Over Time Report; see section “Business Activity Over Time 
Report” on page 295.

➤ “Transactions Tab” on page 224

From the Transactions Tab, you can link to the Transaction Management 
Transaction Summary report, which provides more details of the selected 
transaction event.

BPI Instance and Violation Health Information

Some of the information presented from the Health pages (links from the 
Health Tab) is sourced directly from the BPI Server and some is sourced from 
the BSM system.

When you open the Health Page, the page comprises a set of Java Server 
Pages (JSPs) and Java beans, which run on the Web Server configured for 
your BSM installation. 
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The data presented within the Process Diagram area, the Summary Tab and 
the Business Health Tab is sourced using the BSM Web Server, which obtains 
its count information directly, from the BPI data samples, as shown in the 
following diagram:

The BPI Instance and Violation pages, which you access when you drill 
down from the top-level Health page to subordinate pages and dialogs, are 
managed by a set of Java Server Pages (JSPs) and Java beans. These JSPs run 
on the Web Server configured for the BPI installation and the instance and 
violation data is obtained from the BPI Instance database.



Chapter 10 • BPI Application Health

206

Following is a diagram of the BPI Instance and Violation web pages.

If the BPI Server, or Servlet Engine, is not running for any reason, this 
information is not available within the Health Pages.

Process Status

When displaying the status of a process, the following terms are used:

➤ Blocked

At least one instance of the process is active for an Activity, and this 
instance cannot proceed due to a problem in an underlying IT 
operational service.
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➤ At Risk

There are currently no process instances in a blocked state, however there 
are process instances in progress that might reach the blockage some 
point in the future.

➤ Healthy

All active process instances are currently past the blockage and can 
therefore continue to run to completion, or there is no problem with the 
IT infrastructure.

There is also an icon representing each of the statuses, which is used in place 
of text. Following are the Business Process Status icons:

Note: Be aware that these rate values can give slightly incorrect values.

Synchronization and Delay in Seeing Updates to Data

The data displayed on the BPI application is based on data sample data. The 
frequency that the data samples are sent are configured using the Data 
samples settings within the BPI Server Administration Console.

Only the instance data shown in the drill-downs from the BPI Health page is 
obtained directly from the BPI Instance database.
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Tasks

How to Configure Active Monitor Instances in the 
Infrastructure Settings Manager

You can determine whether active monitor instances are to be included in 
violation counts on the Health page, or to include only completed 
instances.

To modify the active monitor instances setting, select Admin > Platform > 
Setup and Maintenance > Infrastructure Settings:

➤ Select Business Process Insight.

➤ In the Health Page Setting, locate the Include violations for active 
monitor instances setting. Change the value to:

➤ true to include active monitor instances in violation counts on the 
Health page

➤ false to include only completed instances and violation counts on the 
Health page and the Business Process Instance Violations component 
in myBSM
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Reference

BPI Application Health User Interface 

This section includes:

 ➤ Process Diagram Area on page 210

 ➤ Summary Tab on page 217

 ➤ Business Health Tab on page 221

 ➤ Transactions Tab on page 224

 ➤ Process Instances Dialog on page 227

 ➤ Process Instance Dialog Box on page 234

 ➤ Activity Instance Dialog Box on page 240

 ➤ Instance Violations Dialog Box on page 241

 ➤ Monitor Dialog Box on page 244

 ➤ Monitor Threshold Dialog Box on page 251
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Process Diagram Area

Following is the Process Diagram area on the Health Page.

The Process Diagram shows the components and structure of the Business 
Process when you create it using the Modeler. The data displayed is based on 
data samples sent to BSM from the BPI Server.

This enables you to visualize the Business Process, which includes the 
Activity annotations to indicate how many process instances are active at a 
particular Activity and the process values.

When displayed in the Process Diagram page, the Business Process layout is 
the same as when it is created in the Modeler.

The data displayed on the Health page changes according to whether you 
select:

➤ the whole process — in this case, the data relates to all the instances for 
all the Activities in the process.

➤ a specific process Activity — in this case, the data relates to all the 
instances for the selected Activity.
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Click a specific Activity to obtain data for the Activity. Click anywhere in 
the process diagram area, but not another Activity, to deselect it and move 
to a whole process view.

User interface elements are described below (unlabeled elements are shown 
in angle brackets):

UI Elements Description

Click this icon to collapse and expand the pane 
where the Process Diagram is located. This 
allows more room for the tabbed areas below 
the diagram.

The arrows point upwards when the process 
diagram is displayed.

This and the icon that follows enable you to 
toggle between a fit-to-pane view and a normal 
view.

Click this icon to stretch or shrink the Process 
Diagram such that it fits within the available 
space.

This and the icon above enables you to toggle 
between a fit-to-pane view and a normal view.

Click this icon to revert the Process Diagram to 
the size it was when defined within the Modeler

Click this icon to hide or display transactions.



Chapter 10 • BPI Application Health

212

This icon is the Activity that represents a 
normal starting point for a process.

Note: A visual representation of the health of 
the Business Process with respect the IT 
operational resources on which it depends. The 
health of each Activity is shown as an icon 
overlay. “Activity Overlay” on page 216 
describes these overlays and their meaning.

Customization: You can customize the Activity 
graphic as described in Chapter 13, 
“Annotations for Process Diagrams”.

This icon is the Activity that represents an 
activity within your Business Process, for 
example, a check for account details.

Note: A visual representation of the health of 
the Business Process with respect the IT 
operational resources on which it depends is 
shown in terms of an icon overlay. “Activity 
Overlay” on page 216 describes these overlays 
and their meaning.

Customization: You can customize the Activity 
graphic as described in Chapter 13, 
“Annotations for Process Diagrams”.

This icon is the Activity that represents a 
normal end point for a process.

Note: A visual representation of the health of 
the Business Process with respect the IT 
operational resources on which it depends is 
shown in terms of an icon overlay. “Activity 
Overlay” on page 216 describes these overlays 
and their meaning.

Customization: You can customize the Activity 
graphic as described in Chapter 13, 
“Annotations for Process Diagrams”.

UI Elements Description
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This icon represents a junction point within 
your Business Process and is a visual Activity 
and is used to help define the structure of the 
Business Process. 

It shows the start and end point of a structural 
element in the process and has no IT 
operational resource status or count and value 
information associated with it.

<Activity overlay> A visual representation of the health of the 
Business Process with respect the IT operational 
resources on which it depends. The health of 
each Activity is shown as an icon overlay.

The Activity overlay provides additional 
information to show the health of the of the 
selected Business Process with respect to the IT 
operational resources on which the process 
depends; see “Activity Overlay” on page 216 for 
more information about the meanings of the 
overlays.

UI Elements Description
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<group_property> drop-down Available if the Group property was set in the 
Modeler for the Business Process. If the Group 
property was not set, or was set to None, this 
field is not shown.

Select one of the following Group attributes to 
filter the data shown for a Business Process:

➤ All - Shows combined data for all the groups.

➤ <group> - Shows data only for that group.

➤ Other - If available, shows combined data of 
groups that exceeded the group limit set in 
the BPI Server Admin Console. This only 
appears if the number of defined groups 
exceeded the limit. For details on setting the 
group limit, see the "Component 
Configuration - Business Impact Engine 
(BIE)" section in the Business Process Insight 
Server Administration Guide.

For more details on groups, see “Health Page 
Overview” on page 200.

<Normal Arc> Process Activities are linked using Arcs, which 
are dotted lines that join Activities. The Arc 
shows the direction of the flow in the Business 
Process; they do not imply any sequence or 
processing order, but they do imply an expected 
order. Arcs are not enforced; however, they are 
used when determining the business impact 
status of the process. 

If you want to know when the Activities in your 
process are executed in an unexpected order, 
use a Sequence Arc.

<Sequence Arc> A Sequence Arc is a solid line and is a 
notification that the Activities, which are 
connected by the arc, are not being activated in 
the correct order. The correct order is 
determined by the direction of the arc between 
the Activities. 

UI Elements Description
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<Text below the Activity icon> This is the name of the Activities as entered in 
the BPI Modeler when the process was created; 
for example: Confirm Identity.

<Text in upper left-hand 
corner of Activity icon>

In the case of a Start or Business Activity, this 
represents the total Business Process value of all 
the instances that are currently active at that 
Activity.

In the case of an End Activity, this represents 
the total value of all the instances that have 
completed at that Activity.

If the locale for the system is set, a currency 
symbol appears with the text for values that are 
currencies.

Customization: You can customize this text as 
described in Chapter 13, “Annotations for 
Process Diagrams”.

<Text in upper right-hand 
corner of Activity icon>

This is the count of the number of instances 
that are currently active at the Activity. The End 
Activity shows the total of the completed 
instances for the business; this is the total of all 
instances since the process was deployed in the 
Modeler or the counts were reset. 

If the locale for the system is set correctly, the 
count is displayed in a locale-sensitive format.

Customization: You can customize this text as 
described in Chapter 13, “Annotations for 
Process Diagrams”.

Business Health Status Overall Business Health of the Business Process. 
The worst case status is presented here.

UI Elements Description
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Activity Overlay

The Activity Overlays provide additional information on the Process 
Diagram to show the health of the Business Process.This is the health of the 
Business Process in terms of the IT infrastructure of the underlying systems 
on which the individual Business Activities are linked. The IT infrastructure 
is linked to the Activities in your Business Process when you model the 
process using the BPI Modeler.

The overlays are presented as visual representations and are shown in terms 
of an icon overlay on the Activity of the Business Process. 

The diagram displays the operational status as an overlay on an Activity if 
the status is OK or above.

Last Update The date and time the data presented on the 
Health page was last updated.

Note: If you have configured a delay for 
sending data samples to BSM, the data 
presented is not for Last Update time, but for 
the Last Update time adjusted by the delay you 
have configured; refer to section “Data 
Samples” on page 41 for more information.

Operational Status Overall IT operational resource status for the 
Business Process. The worst case status is 
presented here.

This is the IT operational resource status as it is 
known to BPI.

Real Time Process Diagram Click to view the Process Diagram data from the 
BPI Server in real time.

Selected Business Process Click to open a drop-down list where you can 
select a different Business Process that you want 
to display on the Health page.

UI Elements Description
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The following table describes the overlays in more detail (unlabeled UI 
elements are shown in angle brackets):

Summary Tab

Following is an example of the Summary Tab on the Health Page.

UI Elements (A-Z) Description

A system health status of OK. All the system KPIs 
fell within their configured settings.

A system health status of Warning. The worst 
status of any system KPI, for a dependent CI, was 
reported as a warning (using the worst-child 
rule).

A system health status of Minor. The worst status 
of any system KPI, for a dependent CI, was 
reported as minor (using the worst-child rule).

A system health status of Major. The worst status 
of any system KPI, for a dependent CI, was 
reported as major (using the worst-child rule).

A system health status of Critical. The worst 
status of any system KPI, for a dependent CI, was 
reported as critical (using the worst-child rule).

The system health status is No Data. This means 
there is insufficient data to make a decision on 
the system health status.
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The Summary Tab shows business and operational summary information 
relating to either the selected Business Process (see “Business Process 
Elements” on page 218), or the selected Process Activity (see “Business 
Activity Elements” on page 220).

If you select a Business Process, you can then select specific categories of 
process instances; for example, blocked instances. You are then moved to 
the Instances Details page, where the list of instances is filtered to show only 
those process instances that are blocked. 

The label No Data is displayed when no data samples are available.

Business Process Elements

The following table describes the elements presented on the Summary Tab 
when the Business Process is selected; that is, you have not selected a 
specific Activity in the Business Process.

User interface elements are described below (unlabeled elements are shown 
in angle brackets):

UI Elements Description

<Name> The name of Business Process is shown in the title 
bar of the tabs area and is the name of the Business 
Process as entered using the Modeler.

Description Content of description field entered using Modeler. 
If no description is provided, [NA] is displayed as a 
value.



Chapter 10 • BPI Application Health

219

Business Impact Breakdown of the health status of all the process 
instances for the selected Business Process. It 
includes instances that are:

➤ Healthy

➤ At Risk

➤ Blocked

For more details about the status field, see “Process 
Status” on page 206.

Click the status label to open the Process Instances 
Page, which is filtered to show only instances with 
the selected status; see “Process Instances Dialog” 
on page 227.

Instances Numbers of instances for the Business Process in 
each of the specified statuses; see “Process Status” 
on page 206 for a description of the status field.

The total Count for all instances is also presented 
and the count of Violations.

Value Value of the instances for the Business Process in 
each of the specified statuses; see “Process Status” 
on page 206 for a description of the status field.

The total Value for all instances is also presented.

Completed Click to open the Process Instances Page, which is 
filtered to show only instances with the status of 
Completed.

<Scorecard summary> Scorecard display for the selected Business Process 
showing the over-time bar; see Chapter 11, “BPI 
Application Scorecard”.

UI Elements Description
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Business Activity Elements

The following table describes the elements presented on the Summary Tab 
when a specific Business Activity is selected (unlabeled UI elements are 
shown in angle brackets):

User interface elements are described below (unlabeled elements are shown 
in angle brackets):

UI Elements Description

<Name/Activity name> Name of Business Process and the Business Activity 
is shown in the title bar of the tabs area and is the 
name of the Business Process and Business Activity 
as entered using the Modeler.

Description Content of description field for the Business 
Activity when entered using the Modeler. If no 
description is provided, [NA] is displayed as a 
value.

Instances Lists the Active instances for the selected Activity.

Active instances are still progressing through the 
process. 

Click the Total Active link to open the Instances 
Page; see “Process Instances Dialog” on page 227. 
The instances page is filtered to show all the 
process instances for the selected Activity within 
the selected Business Process.

Count Label for the instance counts, which lists the 
number of Active instances at the selected Activity.

Active instances are still progressing through the 
process. 

Value Labels for the value, which lists the values of the 
instances that are Active at the selected Activity.

Active instances are still progressing through the 
process.

<Scorecard summary> Scorecard display for the complete Business 
Activity showing the over-time bar; see Chapter 11, 
“BPI Application Scorecard”.
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Business Health Tab

Following is an example of the Business Health Tab on the Health Page. 

The Business Health tab displays:

➤ Objective dials for the objectives set on a Health Indicator associated with 
a Business Process, Business Activity or Business Process Monitor using 
the option: 

Admin > Service Health > View Management> CI Indicators

See “Business Health Dials” on page 221 for more details.

➤ Table showing the Instance Violation Counts for the selected Business 
Process or Business Activity; see “Instance Violation Counts” on page 223.

➤ Violation details for the selected Business Process or Business Activity.

Click to open the Violations page; see “Instance Violations Dialog Box” 
on page 241.

Note: You must create a unique KPI for each Health Indicator. Otherwise, 
KPIs that contain multiple related Health Indicators are not displayed.

Business Health Dials

When you open the Business Health tab, you are presented with a series of 
dials representing the KPI statuses that you have configured.
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User interface elements are described below (unlabeled elements are shown 
in angle brackets):

UI Elements Description

<Dials> The dials provide a visual representation of the business 
objectives that have been set on Health Indicators 
associated with a Business Process, Business Activity or 
Business Process Monitor. 

The dial shows the current value. The needle on the dial 
indicates status of the KPI value with respect to the 
objectives that have been set on the related Health 
Indicators. 

<Drilldown> You can select a dial and drill down for more 
information, as follows:

➤ For dials representing Business Process Monitor KPIs 
configured using the Monitor Definer, you can drill 
down to the Monitors Over Time Report; see “BPI 
Monitors Over Time Report” on page 283.

➤ For dials representing Business Process or Business 
Activity KPIs, you can drill down to the Business 
Process Over Time or Business Activity Over time 
Report; see “Business Process Over Time Report” on 
page 291 and “Business Activity Over Time Report” on 
page 295.

You can also drill down to the Monitors page for more 
details of the Monitors; see “Monitor Dialog Box” on 
page 244.

<KPI name and 
process or activity 
name>

The name of the KPI and the appropriate Process. 
Activity, or Monitor or Process Activity name are 
displayed below the dial.

If the dial represents objectives set on a custom monitor, 
the KPI name is shown as the custom monitor data units 
value.
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Instance Violation Counts

The Business Health tab displays an Instance Violation Counts table which 
summarizes the counts for the selected Business Process or Business Activity. 

User interface elements are described below (unlabeled elements are shown 
in angle brackets):

<KPI status> The KPI status shows the current status of all the KPIs for 
which you have set Health Indicator objectives.

<Tooltip> There is a tooltip for each dial showing the monitor 
status, plus the monitor and objective values. The 
background color for the tooltip indicates the Business 
Process Monitor status. 

Important 
information

The Instance Violation Counts table can be configured to 
include threshold violations for active instances of 
duration monitors, or to include only completed 
instances. A duration monitor instance is considered 
active if the business process instance has entered the 
monitor's span, but not yet exited. For details on this 
configuration setting, see “How to Configure Active 
Monitor Instances in the Infrastructure Settings 
Manager” on page 208.

UI Elements Description

All Violations Click the link to open the Violation page, which is 
filtered to show violations for the selected Business 
Process, or Business Activity; see “Instance Violations 
Dialog Box” on page 241.

Threshold Name 
Drilldown

You can select an Instance Threshold and drill down to 
the Threshold Violations table for more information on 
the individual threshold instances.

UI Elements Description
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Transactions Tab

Following is an example of the Transactions Tab on the Health Page.

The Transactions tab displays summary information relating to the Business 
Transactions that are linked to the selected Business Process or Business 
Activity. You can see which Business Transactions drive each Business 
Activity in the Business Process in one of the following ways:

➤ In the “Transactions Tab Table” on page 224.

➤ In the “Transactions Tab Process Diagram” on page 226.

Transactions Tab Table

The Transactions tab table shows in table format which Business 
Transactions drive each Business Activity in the Business Process.
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Following are the user interface elements that are presented in the 
Transaction Tab table. The elements are the same if you select the whole 
Business Process, or a Business Activity (unlabeled UI elements are shown in 
angle brackets):

UI Elements Description

Business Transactions The name of the Business Transaction as defined 
in TransactionVision and as linked to the BPI 
Business Process.

Click a Business Transaction to drill down to the 
Transaction Summary Report in Transaction 
Management. This report displays a list of all 
completed transactions in a specified time 
frame, as well as volume and response time 
metrics. For details, see the "Transaction 
Summary Reports" chapter in Using Transaction 
Management or the Transaction Management 
Help.

<column data> This column data is as defined under:

Admin > Service Health> Business Transactions

The columns included on the Transactions Tab 
are variable to match the KPI defined for 
Business Transaction and as shown in Service 
Health.

Status Current status of the Business Transaction as 
defined by TransactionVision.

Used By List of all activities linked to the Business 
Transaction.
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Transactions Tab Process Diagram

Following is an example of the Process Diagram when the Transactions Tab 
is selected on the Health Page.

When you select the Transactions tab on the Health page, the Process 
Diagram changes to show the relationships between the Business Activities 
and the Business Transactions. Each Business Transaction is represented by 
the Transaction icon along the bottom of the Process Diagram, with dotted 
lines to the activities they drive. 

When you click on a Business Transaction icon, the dotted lines are 
highlight between the icon and the Business Activities to which the icon is 
linked. You can also click on the Business Activity to highlight the dotted 
line to the Business Transaction that drives it.
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The Hide Transactions icon enables you to toggle between hiding and 
viewing the transaction icons and dotted lines. 

Process Instances Dialog

The Process Instances dialog is accessible directly from the Healthy, Blocked, 
At Risk and Completed links in the left panel of the Summary Tab on the 
Health page. 

Following is an example of the Process Instances Dialog.
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The Process Instances dialog displays information relating to the process 
instance counts. The display is filtered according to the status of the 
instances and whether the instance counts have been requested from a 
Business Process, or an Activity context. The most recent instances are listed 
first.

➤ “Process Instances for a Selected Business Process” on page 228 describes 
the information for a selected Business Process.

➤ “Process Instances for a Selected Business Activity” on page 231 describes 
the information for a selected Business Activity.

Process Instances for a Selected Business Process

This section describes the Process Instances dialog when selected from a 
Business Process context. The Process Instances dialog is divided into the 
following areas:

➤ “Instances Dialog Settings for a Business Process” on page 229

➤ “Instances Dialog Results for a Business Process” on page 230
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Instances Dialog Settings for a Business Process

The following table describes the user interface elements for the settings area 
of the Instances dialog for a Business Process (unlabeled UI elements are 
shown in angle brackets):

UI Elements (A-Z) Description

Business Activity Indicates the selection criterion for the dialog. 
You can list all the Activities in the selected 
Business Process, or you can select a specific 
Activity and list only the instances that are 
active at the Activity.

The number of Process Instances found and the 
number of Process Instances listed in the results 
area is displayed underneath this UI element.

<group_property> drop-down Available if the Group property was set in the 
Modeler for the Business Process. If the Group 
property was not set, or was set to None, this 
field is not shown.

Select one of the following Group attributes to 
filter the data shown for a Business Process:

➤ All - Shows combined data for all the groups.

➤ <group> - Shows data only for that group.

➤ Other - Shows combined data of groups that 
exceeded the group limit set in the BPI Server 
Admin Console. This only appears if the 
number of defined groups exceeded the limit. 
For details on setting the group limit, see the 
"Component Configuration - Business Impact 
Engine (BIE)" section in the Business Process 
Insight Server Administration Guide.

For more details on groups, see “Health Page 
Overview” on page 200.

Identifier The Identifier of the Process Instance that you 
want to list in the results area. You can search for 
a specific instance, or leave this field blank if you 
want to list all Process Instances. Wildcard 
searches are also available.
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Instances Dialog Results for a Business Process

The following table describes the user interface elements in the results area 
(unlabeled UI elements are shown in angle brackets):

Instance Status The status of the Process Instances that you want 
to list in the results area. 

Select the value Any to list all Process Instances 
in all states.

Maximum List Size The number of Process Instances that you want 
to list in the results area. You can select from a 
list size of 12, 20 50 or 100.

Export all Enables you to export all the process instances 
and their values to a file in comma separated 
value (CSV) format. You can optionally include 
Data definition values when exporting the 
process instance information; this is set from the 
Servlet Engine option within the BPI Server 
Administration Console. see "Component 
Configuration - Servlet Engine" in the Business 
Process Insight Server Administration Guide. 

The exported CSV file can then be imported into 
Microsoft Excel for analysis.

UI Elements (A-Z) Description

End Time The time that this Process Instance fulfilled the 
End Condition for the End Activity, if applicable.

Identifier The identifier for the Process Instance. Click to 
open the Process Instance page to obtain more 
information relating to the selected Process 
Instance; see section “Process Instance Dialog 
Box” on page 234.

UI Elements (A-Z) Description
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Process Instances for a Selected Business Activity

This section describes the Process Instances dialog when selected from a 
Business Activity view.

The Process Instances dialog is divided into the following areas:

➤ “Instance Dialog Settings for a Business Activity” on page 232

➤ “Dialog Instance Results for a Business Activity” on page 233

Process Value The content of the Value attribute for the listed 
Process Instance.

Process Value is based on the Process Value 
property of the Business Process. The Process 
Value is assigned when you create the Business 
Process in the Modeler. The value is typically 
assigned from a Business Event when the 
processes is active.

Start Time The time that this Process Instance fulfilled the 
Start Condition for the Start Activity.

Status The status of the listed Process Instance, and can 
be one of:

➤ Healthy

➤ At Risk

➤ Blocked

➤ Completed

See section “Process Status” on page 206 for 
descriptions of the status values.

UI Elements (A-Z) Description
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Instance Dialog Settings for a Business Activity

The following table describes the user interface elements for the settings area 
(unlabeled UI elements are shown in angle brackets):

UI Elements (A-Z) Description

<Activity Name> Name of the selected Activity

Activity Name Select box that shows the current selection 
criterion for the dialog. You can list all the 
instances in the selected process, or you can 
select a specific Activity and list only the 
Instances that are active at the Activity.

Activity Status The status of the Process Instances that you want 
to list in the results area. 

Select the value Any to list all Process Instances 
in all states.

Average Duration (H:M:S) The average time taken for all process instances 
to fulfill the Start and End condition for the 
Activity. This time is measured across all the 
instances that have passed through this Activity.

A value for this field is provided only when there 
is sufficient data to generate a statistical result.

Export all Enables you to export all the process instances 
and their values to a file in comma separated 
value (CSV) format. You can optionally include 
Data definition values when exporting the 
process instance information; this is set from the 
Servlet Engine option within the BPI Server 
Administration Console. See "Component 
Configuration - Servlet Engine" in the Business 
Process Insight Server Administration Guide. 

The exported CSV file can then be imported into 
Microsoft Excel for analysis.

Identifier The Identifier of the Process Instance that you 
want to list in the results area. Leave this field 
blank if you want to list all Process Instances for 
the selected Activity.
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Dialog Instance Results for a Business Activity

The following user interface elements are included (unlabeled UI elements 
are shown in angle brackets):

Instance Rate (per hour) The rate at which instances of the Activity are 
being completed, expressed as an hourly rate.

A value for this field is provided only when there 
is sufficient data to generate a statistical result.

Maximum List Size The number of Process Instances (Active and 
Completed) that you want to list in the results 
area. You can select from a list size of 8, 20 50 or 
100.

Operational Status Status of selected Activity, and can be one of:

➤ Healthy

➤ At Risk

➤ Blocked

➤ Completed

See section “Process Status” on page 206 for 
descriptions of the status values.

Process Value Rate (per hour) The value of the process instances as they are 
processed on an hourly basis. 

A value for this field is provided only when there 
is sufficient data to generate a statistical result.

UI Elements (A-Z) Description

Activity Start Time The time that this Process Instance fulfilled the 
Start Condition for the selected Activity. If an 
Activity fulfills its Start Condition multiple time, 
the most recent start time is listed.

Activity Stop Time The time that this Process Instance fulfilled the 
End Condition for a selected Activity.

UI Elements (A-Z) Description
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Process Instance Dialog Box

The Process Instance dialog displays information relating to the selected 
process instance.

Identifier The identifier for the Process Instance. Click to 
open the Process Instance page to obtain more 
information relating to the selected Process 
Instance; see “Process Instance Dialog Box” on 
page 234.

Process Value The content of the Value attribute for the listed 
Process Instance.

Start Time The time that this Process Instance fulfilled the 
Start Condition for a Start Activity.

To access ➤ Instances dialog; see “Process Instances Dialog” on 
page 227.

➤ Monitor dialog; see “Monitor Dialog Box” on 
page 244.

➤ Monitor Threshold dialog; see “Monitor Threshold 
Dialog Box” on page 251.

➤ Violations dialog; see “Instance Violations Dialog Box” 
on page 241.

UI Elements (A-Z) Description
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Following is an example of the Process Instance dialog.

Process Diagram

User interface elements are described below (unlabeled elements are shown 
in angle brackets):
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Process Timeline

User interface elements are described below (unlabeled elements are shown 
in angle brackets):

Monitor Thresholds

User interface elements are described below (unlabeled elements are shown 
in angle brackets):

UI Elements (A-Z) Description

<Activity> Click an Activity in the process diagram and open the 
Activity Instance dialog; see “Activity Instance Dialog 
Box” on page 240.

<Process diagram> This shows the process diagram for the selected Process 
Instance; see “Process Diagram Area” on page 210 for a 
description of the process diagram.

UI Elements (A-Z) Description

<Activity> Click an Activity in the process diagram and open the 
Activity Instance dialog; see “Activity Instance Dialog 
Box” on page 240.

<Process Instance 
details>

This shows the Process Instance details as a time line, so 
that you can easily see the order in which Activities are 
executed and graphically see the length of time spent at 
each Activity.

UI Elements (A-Z) Description

<Associated 
monitor>

Click the associated Monitor to open the Monitor dialog; 
see “Monitor Dialog Box” on page 244. 
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Process Activities

This page lists the details of a selected Process Activity.

User interface elements are described below (unlabeled elements are shown 
in angle brackets):

<Instance threshold 
name>

Click the instance threshold name to open the Threshold 
instance dialog; see “Monitor Threshold Dialog Box” on 
page 251.

<Monitor Instance 
threshold details>

This shows the monitor instance threshold details. Each 
instance threshold is shown in the form of a dial. The 
dial shows the status of the Monitor Instance Threshold.

UI Elements (A-Z) Description

Activity Name The name of the Activity instance.

Overall Duration Time taken to complete the Activity.

Latest Start Time Time at which the Process Instance fulfilled the Start 
Condition for the last activation of the Activity.

Latest End Time Time at which the Process Instance fulfilled the End 
Condition for the last activation of the Activity.

Multiple Starts Whether the Activity fulfilled its start condition more 
than once.

<Activity> Click an Activity to open the Activity Instance dialog; see 
“Activity Instance Dialog Box” on page 240.

UI Elements (A-Z) Description
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Data Definition

This page lists the Data definition property values for the Associated Data 
definition that has been defined in the Modeler for the Business Process.

User interface elements are described below (unlabeled elements are shown 
in angle brackets):

Transactions

This page lists the TransactionVision Transaction Instances associated 
within the context of the current Process Instance. 

Following is an example of the Transactions tab:

UI Elements (A-Z) Description

Property Name The name of the Data Definition property as entered in 
the Modeler.

Property Value The value for the Data Definition property at the selected 
Activity.
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The following elements are included for each transaction instance. User 
interface elements are described below (unlabeled elements are shown in 
angle brackets):

UI Elements Description

Business Transaction The class name of the transaction instance. 

If you configured BPI to integrate with TransactionVision 
within Transaction Management, a link to the 
Transaction Tracking Report (managed by Transaction 
Management) for the selected transaction instance, is 
displayed. For more details on the Transaction Tracking 
Report, see Using Transaction Management.

Completion State The current state of the transaction instance. This value 
may be Processing, Completed or Unknown. 

End Time The time that the transaction instance finished. 

Result State The result state of the transaction instance. This value 
may be Success, Failed or Unknown. 

Start Time The time that the transaction instance started. 
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Activity Instance Dialog Box

This page lists all the instances that have fulfilled their Start and End 
conditions for the selected Activity. 

Following is an example of an Activity Instance dialog:
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User interface elements are described below (unlabeled elements are shown 
in angle brackets):

Instance Violations Dialog Box

The Instance Violation dialog lists all the Threshold Violations instances 
related to the selected Business Process or Business Activity. The most recent 
instance Threshold violations are listed first.

The label No Data is displayed when no data samples are available.

UI Elements Description

Activity Status The status of the selected Activity, see “Process Status” on 
page 206 for details of the possible statuses for the 
Activity.

Maximum List Size A drop-down list box that enables you to configure the 
number of items that appear in the list.

Name The name of the selected Activity.

Overall Activity 
Duration (H:M:S)

The time taken to complete the Process Activity.

Paired Start and End 
Times

This is a list of the history of the Activity with respect to 
the number of times the selected instance has fulfilled 
the Start and End Conditions for the Activity; it includes 
the Duration, Start Time and End Time.
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Following is an example of the Instances Violation dialog:
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The following user interface elements are included for the Instance 
Violation settings (unlabeled UI elements are shown in angle brackets):

The following user interface elements are included (unlabeled UI elements 
are shown in angle brackets):

UI Elements Description

Activity Name The Activity Name for the single-activity 
Monitor.

Identifier Enter a Process Identifier to list violations related 
to a specific process instance. Leave this blank to 
list violations for all process instances, or enter a 
partial string to search.

Severity Select a severity level (Warning, Minor, Major or 
Critical) to list violations that are greater than or 
equal to a specific violation level. Enter All to list 
all violation levels.

Maximum List Size The number of instance violations that you want 
to list in the results area. You can select from a 
list size of 10, 20 50 or 100.

Export all as CSV Enables you to export all the process instances 
and their values to a file in comma separated 
value (CSV) format. You can optionally include 
Data definition values when exporting the 
process instance information; this is set from the 
Servlet Engine option within the BPI Server 
Administration Console. See "Component 
Configuration - Servlet Engine" in the Business 
Process Insight Server Administration Guide. The 
exported CSV file can then be imported into 
Microsoft Excel for analysis.

UI Elements Description

Time Threshold Violated The time that the instance threshold condition was 
violated.
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Monitor Dialog Box

The Monitor Dialog shows the data collected that relates to the Business 
Process Monitors that you defined for a Business Process.

Time Threshold Raised The time that the instance threshold condition was 
detected by BPI.

The time that a instance threshold is detected can 
be different if you have stopped the BPI Monitor 
Engine, or the BPI system has been disabled for 
some reason. 

Monitor Name Name of the Monitor that this instance threshold is 
defined for.

Click to open the related Monitor Dialog; see 
section “Monitor Dialog Box” on page 244.

Threshold Name Name of the instance threshold.

Click to open the related Monitor Threshold dialog; 
see section “Monitor Threshold Dialog Box” on 
page 251.

Monitor Value At Time of 
Threshold Violation

Value of Monitor when instance threshold was 
violated.

Severity Level of the violation, which can be one of:

➤ Normal

➤ Warning

➤ Minor

➤ Major

➤ Critical

Process Identifier Identifier for Process Instance listed for the selected 
Activity and affected by the instance threshold 
violation.

Click to open the related Process Instance page; see 
section “Process Instance Dialog Box” on page 234.

UI Elements Description



Chapter 10 • BPI Application Health

245

Following is an example of the Monitor dialog showing the Monitor 
Diagram page. 

Information about defining Business Process Monitors can be found in the 
following documentation:

➤ Business Process Insight Monitor Definer Online Help

➤ Business Process Insight Integration Training Guide - Defining Business 
Monitors

Monitor Diagram

This page shows a graphical representation of the selected Monitor as a 
process diagram, see “Process Diagram Area” on page 210 for a description 
of the process diagram. 
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Click an Activity on the process diagram to open the Process Instances 
dialog in the selected Activity context.

Select a group from the <group_property> drop-down list to view the Monitor 
Diagram by that group, if groups were defined in the Modeler. If groups were 
not defined, the <group_property> drop-down is not displayed. See “Health 
Page Overview” on page 194 for details.

The additional information on the process diagram are the red flags. These 
red flags reflect those added when you defined the Monitor in the Monitor 
Definer and show the start and end points for this Monitor Definition. The 
flags do not appear in the case of a Business Process Monitor with a span of 
Whole Process.

Monitor Description

This page displays the details of the Monitor as defined when you created 
the Monitor using the Monitor Definer: 

➤ Monitor Name

➤ Monitor Description

➤ Monitor Span

In the case of a Monitor Definition that has been defined with a span of 
Single Activity or Multiple Activity, the Start Activity and End Activity 
values are also listed.

You can use this page to gain an overview of all the monitors reported for 
the selected process. 

Monitor Values

This page lists the values for the Monitor instances, starting with the most 
recent.
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User interface elements are described below:

The results shown in the results area varies according to whether you are 
viewing a Value or Duration Monitor:

➤ “Value Monitor” on page 247

➤ “Duration Monitor” on page 248

Value Monitor

The following table describes the user interface elements for the Monitor 
Instance results area for a Value Monitor.

UI Elements (A-Z) Description

Monitor Name Name of the selected Monitor.

The number of Monitor Instances found and the 
number of Monitor Instances listed in the results 
area is displayed underneath Monitor Name.

Process Identifier Enter a Process Identifier to filter the list based 
on a specific Process Instance, or leave the field 
blank to filter on all instances.

Monitor Status Select the value of the status for the Monitor on 
which you want to filter the results:

➤ All 

➤ Active

➤ Completed

Maximum List Size The number of Monitor instances that you want 
to list in the results area. You can select from a 
list size of 10, 20 50 or 100.

Export All as CSV Enables you to export all the Monitor instance 
data to a file in comma separated value (CSV) 
format.

The exported CSV file can then be imported into 
Microsoft Excel for analysis.
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User interface elements are described below:

Duration Monitor

The following table describes the user interface elements for the Monitor 
Instance results area for a Duration Monitor.

User interface elements are described below:

UI Elements (A-Z) Description

Process Identifier The identifier for the Process Instance.

Start Time Time when process instance entered the span of 
the Monitor.

End Time Time when process instance exited the span of 
the Monitor.

Monitor Status Status of the Process Instance, which can be one 
of All, Active or Completed.

Process Value The configured value of each Process Instance 
that is currently within the span of the monitor

Severity The worst status of any instance threshold in 
this monitor and which the process instance has 
violated. The status can be:

➤ Normal

➤ Warning

➤ Minor

➤ Major

➤ Critical

➤ Unknown

UI Elements (A-Z) Description

Process Identifier The identifier for the Process Instance.

Start Time Time when process instance entered the Monitor 
span.
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Monitor Graph

This page shows the Monitor results as a graph based on the statistics 
collected for the Monitor; these statistics are selected from the Data 
Aggregation Method. The graph can be either a bar chart or a line. The data 
shown on the graph is tailored to your filter criteria. When you have 
completed the settings for the filters, the graph is drawn automatically as 
required.

The page is divided into an area to select the filter criteria and a results area, 
which show the required data in graphical form. 

User interface elements are described below:

End Time Time when process instance exited the Monitor 
span.

Monitor Status Status of the Monitor instance, which can be 
one of All, Active or Completed.

Monitor Duration The value of the Monitor specified as a time. 

Severity The worst status of any instance threshold in 
this monitor and that the process instance has 
violated. This status can be:

➤ Normal

➤ Warning

➤ Minor

➤ Major

➤ Critical

➤ Unknown

UI Elements (A-Z) Description

Monitor Name Name of the selected Monitor. You can change 
the Monitor that you want to see the results for 
using this drop-down selection box.

Data Aggregation Method The statistical sources that you want to use as 
the data to be plotted on the graph.

UI Elements (A-Z) Description
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Monitor Summary

This page displays summary information relating to recent and all values of 
the Monitor. 

Graph Type Select the type of graph that you want to show. 
This can be either a bar chart, or a line graph.

Graphing Period Select the time period that you want to plot 
results for. If you select All, then all the data 
collected is plotted.

Chart by group If you have defined Groups for your Monitors, in 
the Monitor Definer, you have the option to 
chart your data using the Group definitions. 
Select Yes to chart using your Group definitions, 
or No to chart the data without using groups.

Export Graph as CSV Enables you to export the statistical data plotted 
on the graph to a file in comma separated value 
(CSV) format. You can optionally include Data 
definition values when exporting the process 
instance information; this is set from the Servlet 
Engine option within the BPI Server 
Administration Console. See "Component 
Configuration - Servlet Engine" in the Business 
Process Insight Server Administration Guide. 

The exported CSV file can then be imported into 
Microsoft Excel for analysis.

Export all data sources as CSV Enables you to export all the statistical data for 
all the data sources to a file in comma separated 
value (CSV) format. You can optionally include 
Data definition values when exporting the 
process instance information; this is set from the 
Servlet Engine option within the BPI Server 
Administration Console. See "Component 
Configuration - Servlet Engine" in the Business 
Process Insight Server Administration Guide. 

The exported CSV file can then be imported into 
Microsoft Excel for analysis.

UI Elements (A-Z) Description
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User interface elements are described below:

Monitor Threshold Dialog Box

The Monitor Threshold dialog displays the statistical data collected that 
relates to the Business Process Monitor Thresholds that you defined in the 
Monitor Definer.

UI Elements (A-Z) Description

Monitor Values to date The data relating to each listed Monitor value 
since the Monitor was deployed.

Recently Completed Monitor 
Values

The data relating to each listed Monitor value 
over the last collection interval (Data sample 
collection period). 
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Following is an example of the Monitor Threshold dialog box.

Click on the Threshold name link to see the Monitor Threshold details, 
which are divided into the following tabbed areas:

➤ “Threshold Definitions” on page 252

➤ “Threshold Violations” on page 253

Threshold Definitions

This tab displays the details of the Monitor Threshold as defined using the 
Monitor Definer:
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User interface elements are described below:

Threshold Violations

This tab displays a list of all the violations found for the selected instance 
threshold.

The data shown in the list is tailored to your filter criteria. When you have 
completed the settings for the filters, the list is populated automatically as 
required.

The page is divided into the following areas, which show the required data 
in list form:

➤ “Filter Criteria for Threshold Violations” on page 254

➤ “Results Area for Threshold Violations” on page 255)

UI Elements Description

<Parent monitor definition> The following is additional information relating 
to the parent Monitor Definition:

<group_property> drop-down list

The <group_property> drop-down list allows you 
to view the threshold details by group, if a 
Group property was set in the Monitor Definer. 
See “Health Page Overview” on page 200 for 
details.

Recent Monitor Average The average Monitor value as measured over the 
latest collection interval; see section “Collection 
Interval” on page 117 for information relating to 
the collection interval.

Associated Monitor Link to the Monitor Page that shows 
information for the Monitor that is associated 
with the selected Threshold. 
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Filter Criteria for Threshold Violations

The following user interface elements are included (unlabeled UI elements 
are shown in angle brackets):

UI Elements Description

<group_property> Select a group from the drop-down list to view 
the threshold violations by group, if groups were 
defined in the Monitor Definer. If groups were 
not defined, <group_property> is not displayed. 
See “Health Page Overview” on page 200 for 
details.

Identifier Enter a Process Identifier to list violations related 
to a specific process instance. Leave this blank to 
list violations for all process instances.

Severity Select the violation level that you want to list. If 
you select the value All, all violation levels are 
listed.

Maximum List Size The number of Threshold Violations that you 
want to list in the results area. You can select 
from a list size of 8, 20 50 or 100.

Export all as CSV Enables you to export all the Threshold 
Violation data to a file in comma separated value 
(CSV) format. You can optionally include Data 
definition values when exporting the process 
instance information; this is set from the Servlet 
Engine option within the BPI Server 
Administration Console. See "Component 
Configuration - Servlet Engine" in the Business 
Process Insight Server Administration Guide.

The exported CSV file can then be imported into 
Microsoft Excel for analysis.
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Results Area for Threshold Violations

The following user interface elements are included (unlabeled UI elements 
are shown in angle brackets):

UI Elements Description

Process Identifier The identifier for the Process Instance. Click to 
open the Process Instance page to obtain more 
information relating to the selected Process 
Instance; see section “Process Instance Dialog 
Box” on page 234.

Time Threshold Violated The time that the instance threshold condition 
was violated.

Time Violation Raised The time that the instance threshold condition 
was detected by BPI.

The time that an instance threshold is detected 
can be different if you have stopped the Monitor 
Engine, or the BPI or BSM system has been 
disabled for some reason. 

Monitor Value At Violation 
Time

Value of parent Monitor instance at the point 
where the Violation occurred.

Severity The level of the instance threshold violation, 
which can be:

➤ Normal

➤ Warning

➤ Minor

➤ Major

➤ Critical

➤ Unknown
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11
BPI Application Scorecard

This chapter includes:

Concepts

➤ BPI Application Scorecard Overview on page 258

➤ Understanding KPI Statuses on page 259

➤ How the Scorecard Builds its Display on page 261

Reference

➤ BPI Application Scorecard User Interface on page 263
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Concepts

BPI Application Scorecard Overview

This section provides an overview of the key features of the BPI Application 
Scorecard pages and explains how to use the Scorecard pages to provide 
summary information for your Business Processes. 

The Scorecard presents a type of report and enables you to display the real 
time status, trend, and changes-over-time data for the selected BPI Business 
Processes and Business Activities. These are organized by best and worst 
statuses.

Following is an example of the BPI Scorecard:
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The Scorecard is divided into the following areas:

➤ The common header, which enables you to tailor the content of the main 
body of the page; see section “Common Header” on page 264.

➤ The main body of the page, where the selected Business Process data is 
presented; see section “Results Area” on page 266.

Following are the areas of the Scorecard.

Understanding KPI Statuses

When a KPI is not relevant to the Business Process, the Status column 
displays [NA], the Trend column is empty, and the over time bar does not 
exist. 
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When a KPI is relevant for the Business Process but has a No Data status, the 
Status column displays a grey icon, the Trend column is empty, and the 
relevant part of the over time bar is grey. 

When the Business Processes are listed in one column only, the KPIs that are 
not relevant for the Business Process are not displayed and each table 
includes as many rows of KPIs as needed.
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How the Scorecard Builds its Display

The Scorecard pages sort and display selected Business Processes and their 
KPI’s statuses from worst to best. The sorting mechanism compares the 
selected Business Process CIs in pairs as shown in the following diagram.
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If a pair of Business Process CIs have the same number of KPIs with a specific 
status, the sorting mechanism compares the number of KPIs with the next 
better status using the critical, major, minor and warning statuses in this order. 
The Business Process with the highest number of those KPIs is then given a 
lower grade than the other Business Processes. 

If a pair of Business Process CIs have the same number of warning KPIs, then 
the mechanism compares the number of KPIs with OK status. The CI with 
the highest number of KPIs with the OK status is given a higher grade than 
the other CI. The same sorting is used for the Info status. 

KPIs without data are not used in the comparison.

If a pair of Business Process CIs have exactly the same numbers of KPIs at 
each status level, the page sorts the CIs alphabetically (from A to Z) and the 
first CI in the alphabetical list, is given the lower grade.

Splitting Mechanism
When all Business Process CIs have a grade, the CIs are sorted into the Worst 
and Best columns. If you select four or more Business Process CIs, the 
Scorecard page is divided into two columns where:

➤ The Worst column displays the worst half of the CIs (lower grades) 
ordered from worst (first row) to best (last row).

➤ The Best column displays the best half of the CIs (higher grades) ordered 
from best (first row) to worst (last row).

Business Process CIs with no data KPIs always appear at the bottom of each 
Worst/Best column. The splitting mechanism removes them from the list 
before it lists the other CIs in the proper order and distributes these CIs 
between the Worst and Best columns. The CIs with no data KPIs are then 
sorted in alphabetical order and distributed between the Worst and Best 
columns and put at the bottom of each column.

The Worst column includes one more Business Process CIs if you select an 
odd number of CIs.

A single column displays the Business Process CIs ordered from worst to best 
from top to bottom when you select less than four CIs.
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BPI Application Scorecard User Interface 

This section includes (in alphabetical order):

 ➤ Common Header on page 264

 ➤ Results Area on page 266
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Common Header

Following are the user interface elements in the General Information area:

The following user interface elements are included (unlabeled UI elements 
are shown in angle brackets):

UI Element Description

Description Enables you to select the criteria that you want 
to use for presenting Scorecard results. 

To access: Select Applications > Business Process 
Insight > Scorecard

Important Information The Scorecard sorts and displays the ordered 
Business Processes and their KPIs statuses for 
the selected time period; for details, see section 
“How the Scorecard Builds its Display” on 
page 261. 

The Scorecard page is available only when you 
have configured the Business Process Insight 
Server to be integrated with BSM and 
configured to send data samples and configured 
a Profile database.

UI Element Description

<Common report

settings>

For details, see “Common Report Elements” in 
Reports.

Business Processes Click to open the Business Processes dialog 
where you can select the Business Process that 
you want to display. 

If one Business Process is selected, its name is 
displayed to the right of the link. If more than 
one Business Process is selected, (n/m) Filtered is 
displayed to the right of the link, where n 
represents the number of selected Business 
Processes and m represents the total available for 
selection.
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KPIs Enables you to select the KPIs that you want to 
display on the filtered results area for each 
Business Process. All KPIs that have been 
configured for the Business Process CI and any 
child CIs are available for selection. Select one or 
more KPIs and click OK. 

If more than one KPI is selected, (n/m) Filtered 
is displayed to the right of the link, where n 
represents the number of selected KPIs and m 
represents the total available for selection

View Enables you to select the viewing period used for 
the over-time bar in the results area. Select the 
viewing period from the drop-down selection 
box and click the Apply button to apply the 
changes to the page.

UI Element Description
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Results Area

This part of the Scorecard shows the results of the selections made from the 
Common Area; see “Common Header” on page 264.

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

GUI Element Description

Description Enables you to display the real time status, 
trend, and over time data of the Business 
Process. The results are organized by worst to 
best statuses.

To access: Select Applications > Business Process 
Insight > Scorecard

Important Information The Scorecard page is available only when you 
have configured the Business Process Insight 
Server to be integrated with BSM and configured 
to send data samples.

The Scorecard page sorts and displays the 
ordered Business Processes and their KPIs 
statuses for the selected time period; for details, 
see section “How the Scorecard Builds its 
Display” on page 261. 

All the data sample information sent by the BPI 
Server is displayed using the following KPIs:

➤ Backlog

➤ Business Health

➤ Business Impact

➤ Duration

➤ Value

➤ Volume
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The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

GUI Element Description

Click the button to the right of the Business 
Process to display the available menu options. 
The context menu options are described in Using 
Service Health.

<Business Process Name> The name of the Business Process.

<Over-time bar> Displays an over-time line, which comprises a 
colored band representing the KPI status results 
over the selected time; each color represents a 
specific KPI status. 

The width of the colored bands corresponds to 
the length of time the KPI is in a particular 
status. The most recent status in the time bar is 
on the right.

Example:

KPI The name of the KPI for the Business Process. 
The column lists the KPIs that were selected in 
the KPIs dialog box for the Scorecard.
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Status Indicates the status of the KPI. For details on the 
statuses, see “Understanding KPI Statuses” on 
page 259.

Tooltip: Provides the value of the status, and 
indicated when the status was changed to the 
current value.

Trend Indicates the trend of the KPI as compared to its 
previous state. 

For details on the trend information refer to the 
Service Health documentation.

Tooltip: Provides the description of the trend.

GUI Element Description
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12
BPI Application Reports

This chapter includes:

Concepts

➤ Reports Overview on page 270

Tasks

➤ How to View and Analyze Data Using the BPI Application Reports 
on page 271

Reference

➤ BPI Application Reports User Interface on page 273
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Concepts

Reports Overview

The BPI Application Report pages display historical data relating to 
summaries of Business Processes, Business Activities, and Monitors that you 
have defined.

The BPI reports customized BSM Reports and comprise charts and tables that 
help you track and analyze the health of your monitored BPI environment. 

You can view and generate the BPI reports, as well as drill down and apply 
various filtering criteria to examine performance trends and pinpoint the 
cause of health and performance issues. 

Reports enable you to examine and analyze the data that is collected for 
Business Process Insight in the Profile database. When generating reports, 
you can specify various report settings, including time range and resolution, 
profile, grouping, and filters. 

As with all BSM reports, you can customize the BPI reports by adding a 
header and a footer, by selecting to automatically or manually generate the 
report, or by customizing other display elements. More details of using 
reports can be found in Report Manager.
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Tasks

How to View and Analyze Data Using the BPI Application 
Reports 

The following steps describe how to view and analyze data using the BPI 
Application reports.

➤ “Prerequisites” on page 271

➤ “View and analyze the data using the reports” on page 271

➤ “Enrich the Business Process Report View” on page 272

 1 Prerequisites

In order to see report information for your Business Processes, you need 
to make sure that you have created a Profile database using the following 
option within BSM:

Admin > Platform > Manage Profile Databases

 2 View and analyze the data using the reports

When there is data available in the Profile database; that is, BPI is sending 
data samples, the following BPI reports are available to help you analyze 
the BPI Business Process data:

➤ Business Process Summary. Displays summary data for the selected 
Business Process; see section “Business Process Summary Report” on 
page 273.

You can drill down to the following reports from the Business Process 
Summary report:

➤ BPI Monitors Over Time. Displays two graphs for each selected 
Monitor definition; see section “BPI Monitors Over Time Report” on 
page 283.

The first graph displays the average/minimum/maximum/weighted 
value or duration of the selected Monitor over time.
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The second graph displays the number of Monitor instance 
violations over time.

➤ Business Activity Summary. Displays summary data for the selected 
Business Activity; see section “Business Activity Summary Report” 
on page 287.

You can drill down to the Business Activity Over Time report from 
this report.

The following diagram shows the hierarchy of reports for Business 
Process Insight.

 3 Enrich the Business Process Report View

You can additionally attach IT Universe CIs to the appropriate Business 
Activity. This enables you to add additional CI information to your 
reports to enhance the level of information that the reports provide.
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BPI Application Reports User Interface 

This section includes:

 ➤ Business Process Summary Report on page 273

 ➤ BPI Monitors Over Time Report on page 283

 ➤ Business Activity Summary Report on page 287

 ➤ Business Process Over Time Report on page 291

 ➤ Business Activity Over Time Report on page 295

Business Process Summary Report

The Business Process Summary Report displays the summary data for the 
selected Business Processes. Use the Business Process Summary Report to 
gain an overall view of the historical health of your Business Processes.

To access Applications > Business Process Insight > Reports 
>Business Process Summary
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Following is an example of a Business Process Summary Report.

Report Settings

The following table describes the user interface elements of the Business 
Process Summary report settings (unlabeled UI elements are shown in angle 
brackets):

UI Elements (A-Z) Description

<Common report elements> For details, see “Common Report Elements” in 
Reports.



Chapter 12 • BPI Application Reports

275

Browse/Search Tabs

When you select Business Processes, a dialog opens with the Browse and 
Search views in which you can select which Business Processes you want to 
display.

Browse View

You can browse CIs in the ODB and associate CIs that represent dependent 
IT operation resources with Business Process Activities. These CIs are already 
populated in the ODB by the person responsible to IT operations. This is 
done either manually or through automated means, such as discovery.

Select the Business Process view and the Business Process CIs that you want 
to display on the Report page.

If one Business Process is selected, its name is displayed to the right of the 
link. If more than one Monitor is selected, Filtered (n) is displayed to the 
right of the link, where n represents the number of selected Processes.

You can only select CIs within the current Browse view.

Business Processes Click to open the Business Processes dialog box 
where you can filter which Business Processes 
you want to display. For details, see “Browse/
Search Tabs” on page 275.

Show Select one of the following options:

➤ Value. Select to display value data for the 
Business Processes in the Value area.

➤ Count. Select to display Business Process 
count values in the Count area.

➤ Both. Select to display both the counts and 
the values. This is the default for the Report.

UI Elements (A-Z) Description
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Search

Search for one or more Business Process CIs in the views or the ODB, search 
for all occurrences of a CI, or filter the list of CIs that is displayed.

The Search option enables you to find the CI you need. You can set up 
searches based on any combination of the filter criteria based on CI Type 
and CI Name.

When searching for CIs by name, you enter a string, or partial string in the 
CI Name list box. The search returns all CIs that contain the entered string 
somewhere in the name (within the boundaries of the other search criteria 
that you define).

When using this search option, note the following:

➤ The search by CI name option is not case sensitive.

➤ You can search just for the name by using the first few letters of the name 
or first part of the name. Wildcards do not work.

➤ You can search just for the CI type by entering the type, such as 
business_activity.

If there are more than one CIs beginning with that name or of that CI 
type, a list displays in the left panel. 

➤ You can select one or more CIs and click the right arrow to put the CIs in 
the Related CIs right panel.
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Report Value

The following table describes the user interface elements of the Business 
Process Summary Value area. The Value area is displayed when you select 
Value or Both from the Show: option (unlabeled UI elements are shown in 
angle brackets).

UI Elements Description

Select a Business Process and click the Drill 
Down to Business Process Over Time 
Report button to drill down to the Business 
Process Over Time report for the selected 
Business Process. The report is displayed with 
the most appropriate option selected.

Select a Business Process and click the Drill 
Down to Business Activity Summary Report 
button to drill down to the Business Activity 
Summary report for the selected Business 
Process. The report is displayed with the most 
appropriate option selected.

Select a Business Process and click the Drill Down 
to Duration Monitors Over Time Report button 
to drill down to the BPI Monitors Over Time 
report for the selected Business Process where 
only the Duration Monitors are shown in the 
report.

The button is enabled only if the selected 
Business Process has Duration Monitors defined.

Select a Business Process and click the Drill 
Down to Value Monitors Over Time Report 
button to drill down to the Monitors Over Time 
report for the selected Business Process where 
only the Value Monitors are shown in this 
report.

Custom Monitor can also be selected for this 
report. 

The button is enabled only if the selected 
Business Process has a Value Monitor defined.
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Business Process The name of the selected Business Process.

Note: You can sort on this column.

Tooltip: Displays the name of the Business 
Process and the currency symbol, in cases where 
the value is a currency type.

Total Value of Completed 
Instances

Displays the total of the value attribute for all 
the Business Process instances that were 
completed in the selected time period.

The background color of the table row is set to 
gray.

Tooltip: Displays the value of the table cell with 
a currency unit if it is available.

Avg. Value of Backlog Instances Displays the average of the value attributes for 
all the Business Process instances with a status of 
Active over the specified period of time.

The background color of the table row is set to 
gray.

Tooltip: Displays the value of the table cell with 
a currency unit if it is available.

Avg. Value of Healthy Instances Displays the average of the value attributes for 
all the Business Process instances that have a 
Healthy status over the specified period of time. 
The background color of the table row is set to 
green.

Tooltip: Displays:

➤ The value of the table cell.

➤ The value of the Avg. Number of Backlog 
Instances cell.

➤ The percentage of the current table cell value 
compared to the value of the Avg. Number 
of Backlog Instances cell.

UI Elements Description
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Avg. Value of At Risk Instances Displays the average of the value attributes for 
all the Business Process instances that have an 
At Risk status over the specified period of time. 
The background color of the table row is set to 
yellow.

Tooltip: Displays:

➤ The value of the table cell.

➤ The value of the Avg. Value of Backlog 
Instances cell.

➤ The percentage of the current table cell value 
compared to the value of the Avg. Value of 
Backlog Instances cell.

Avg. Value of Blocked Instances Displays the average of the value attribute for all 
the Business Process instances that are in the 
Blocked status over the specified period of time.

The background color of the table row is set to 
red.

Tooltip: Displays:

➤ The value of the table cell.

➤ The value of the Avg. Number of Backlog 
Instances cell.

➤ The percentage of the current table cell value 
compared to the value of the Avg. Number of 
Backlog Instances cell.

UI Elements Description
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Report Count

The following table describes the user interface elements of the Business 
Process Summary Count area. The Count area is displayed when you select 
Count or Both from the Show: option (unlabeled UI elements are shown in 
angle brackets).

UI Elements Description

Select a Business Process and click the Drill 
Down to Business Process Over Time Report 
button to drill down to the Business Process 
Over Time report for the selected Business 
Process. The report is displayed with the Count 
option selected.

Select a Business Process and click the Drill 
Down to Business Activity Summary Report 
button to drill down to the Business Activity 
Summary report for the selected Business 
Process. The report is displayed with the Count 
option selected.

Select a Business Process and click the Drill 
Down to Duration Monitors Over Time Report 
button to drill down to the Monitors Over 
Time report for the selected Business Process 
where only the Duration Monitors are shown 
in the report.

The button is enabled only if the selected 
Business Process has a duration Monitor 
defined.
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Select a Business Process and click the Drill 
Down to Value Monitors Over Time Report 
button to drill down to the Monitors Over 
Time report for the selected Business Process 
where only the Value Monitors are shown in 
this report.

Custom Monitors can also be displayed in this 
report. 

The button is enabled only if the selected 
Business Process has a Value Monitor defined.

Business Process The name of the selected Business Process.

Note: You can sort on this column.

Tooltip: Displays the name of the Business 
Process.

Number of Completed 
Instances

Displays the total number of the Business 
Process instances that were completed in the 
selected time period.

The background color of the table row is set to 
gray.

Tooltip: Displays the value of the table cell.

Avg. Number of Backlog 
Instances

Displays the average number of backlogged 
Business Process instances out of the number of 
samples reported over the specified period of 
time.

The background color of the table row is set to 
gray.

Tooltip: Displays the value of the table cell.

UI Elements Description
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Avg. Number of Healthy 
Instances

Displays the average number of the Business 
Process instances that have a Healthy status, 
out of the number of samples reported over the 
specified period of time. The background color 
of the table row is set to green.

Tooltip: Displays:

➤ The value of the table cell.

➤ The value of the Avg. Number of Backlog 
Instances cell.

➤ The percentage of the current table cell value 
compared to the value of the Avg. Number 
of Backlog Instances cell.

UI Elements Description
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BPI Monitors Over Time Report

The BPI Monitors Over Time Report displays two graphs for a selected 
Business Process Monitor: Monitor Data and Status Distribution.

Avg. Number of At Risk 
Instances

Displays the average number of the business

process instances that have an At Risk status, 
out of the number of samples reported over the 
specified period of time. The background color 
of the table row is set to yellow.

Tooltip: Displays:

➤ The value of the table cell.

➤ The value of the Avg. Number of Backlog 
Instances cell.

➤ The percentage of the current table cell value 
compared to the value of the Avg. Number 
of Backlog Instances cell.

Avg. Number of Blocked 
Instances

Displays the average number of Business 
Process instances that are in the Blocked status, 
out of the number of samples reported over the 
specified period of time.

The background color of the table row is set to 
red.

Tooltip: Displays:

➤ The value of the table cell.

➤ The value of the Avg. Number of Backlog 
Instances cell.

➤ The percentage of the current table cell value 
compared to the value of the Avg. Number 
of Backlog Instances cell.

To access Applications > Business Process Insight > Reports > BPI 
Monitors Over Time

UI Elements Description
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Following is an example of the BPI Monitors Over Time Report.

Use the BPI Monitors Over Time Report to list information relating to the 
Business Process Monitors status for your Business Processes over a selected 
time period. The report data is shown in graphical form and can also be 
published in tabular form for the following graphs:

➤ Monitor Data, which plots the average/minimum/maximum/weighted 
value or duration of the selected Business Process Monitor over time.

➤ Status Distribution, which plots the Monitor instance violations over 
time, based on their status.
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Report Settings

The following table describes the user interface elements of the BPI Monitor 
Over Time Report settings (unlabeled UI elements are shown in angle 
brackets).

Monitor Data Area

The Monitor Over Time Report displays a separate set of charts for each 
selected Monitor and for the selected time period in the Monitor Data area.

If you have selected an BPI Value or Custom Monitor, the graph displays the 
following information:

UI Elements (A-Z) Description

<Common report elements> For details, see “Common Report Elements” in 
Reports.

BPI Monitors Click to open the BPI Monitors dialog box where 
you can filter which BPI Monitor you want to 
display. For details, see “Browse/Search Tabs” on 
page 275.

Graph by Group This option appears when one Business Process 
Monitor is selected. If more than one monitor is 
selected, this option is not available. 

Click Graph by Group to drill down to a Monitor 
Graph with a display that is split according to 
the different elements in the Group definition

UI Elements (A-Z) Description

Average Duration The average duration of the completed instances of 
the selected Monitors out of the total number of 
completed instances of the selected Monitors.

Average Value per 
Instance

The average value of the completed instances of the 
selected Monitor out of the total number of 
completed instances.

Maximum Duration. The maximum duration of all the completed 
instances for the selected Monitor.
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Status Distribution

The Monitor Over Time Report displays a separate bar chart for each of the 
selected Monitors for the selected time period in the Status Distribution 
area.

The Monitor Over Time report displays the following data for the selected 
Monitor over the selected time period:

Maximum Value The maximum value of all the completed instances 
of the selected Monitor.

Minimum Duration The minimum duration of all the completed 
instances for the selected Monitor.

Minimum Value The minimum value of all the completed instances 
of the selected Monitor.If you have selected an BPI 
Duration Monitor, the graph displays the following 
information:

Weighted Average 
Duration

The weighted average duration of all the completed 
instances of the BPI Monitors out of the total 
number of completed instances of the Monitor. 

<Tooltip> There is tooltip for each point on the graphs and 
you can progressively drill down to a specific hour 
for more detailed data.

UI Elements (A-Z) Description

Total % of Value/Duration 
Critical Violated Instances

The percentage of the total number of instances of 
the Monitor instances that completed with a 
Critical Violated status out of the total number of 
completed instances of the Monitor.

Total % of Value/Duration 
Major Violated Instances

The percentage of the total number of instances of 
the Monitor instances that completed with a Major 
Violated status out of the total number of 
completed instances of the Monitor. 

UI Elements (A-Z) Description
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Business Activity Summary Report

The Business Activity Summary Report shows summary information for a 
Business Activity over a selected period of time.

Total % of Value/Duration 
Minor Violated Instances 

The percentage of the total number of instances of 
the Monitor instances that completed with a Minor 
Violated status out of the total number of 
completed instances of the Monitor.

Total % of Value/Duration 
Non-Violated Instances

The percentage of the total number of instances of 
the Monitor instances that completed with a 
Non-Violated status out of the total number of 
completed instances of the Monitor.

Total % of Value/Duration 
Warning Violated 
Instances

The percentage of the total number of instances of 
the Monitor instances that completed with a 
Warning Violated status out of the total number of 
completed instances of the Monitor.

<Tooltips> Tooltips for bars in the bar chart display the number 
of instances, the total number of instances, and the 
percentage and you can progressively drill down to 
a specific hour for more detailed data.

To access Applications > Business Process Insight > Reports > 
Business Activity Summary

UI Elements (A-Z) Description
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Following is an example of a Business Activity Summary report.

Report Settings

The following table describes the user interface elements of the Business 
Activity Summary Report settings (unlabeled UI elements are shown in 
angle brackets).

UI Elements (A-Z) Description

<Common report elements> For details, see “Common Report Elements” in 
Reports.
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Value Table

This table lists the value of completed process instances at each Activity, 
plus the average value of the active instances at each Activity (backlog). 

The following table describes the user interface elements of the Value table 
(unlabeled UI elements are shown in angle brackets).

Business Processes Click to open the Business Processes dialog box 
where you can select the Business Process whose 
Activities you want to report on. For details, see 
“Browse/Search Tabs” on page 275.

Show Select one of the following options:

➤ Value - Select to display value data for the 
Business Activities in the Value area.

➤ Count - Select to display Business Activity 
count values in the Count area

➤ Both - Select to display both the Activity 
Value and Activity Count values for the 
Business Process Activities. Both the Value 
and the Count area are displayed. This is the 
default.

UI Elements (A-Z) Description

Select a Business Process and click the Drill 
Down to Activity Over Time Report button 
to drill down to the Activity Over Time report 
for a selected Business Activity. The report is 
displayed with the Value option selected.

Activity Name The name of the selected Business Activity. You 
can select to list the Activities in ascending or 
descending alphabetical order.

Tooltip: Displays the name of the Business 
Activity.

UI Elements (A-Z) Description
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Count Table

This table lists the total number of completed process instances at each 
Activity, plus the average number of the active instances at each Activity 
(backlog).

The following table describes the user interface elements of the Count table 
(unlabeled UI elements are shown in angle brackets).

Total Value of Completed 
Instance

Displays the total of the value attribute for all 
the Business Activity instances that were 
completed in the selected time period.

Tooltip: Displays the value of the table cell, with 
value units (where value units are set).

Avg. Value of Backlog Instances Displays the average value (backlog) of the active 
instances at each Activity in the process over the 
selected time period.

Tooltip: Displays the value of the table cell.

UI Elements Description

Select a Business Process and click the Drill Down 
to Activity Over Time Report button to drill 
down to the Business Activity Over Time report 
for the selected Business Activity. The report is 
displayed with the Count option selected.

Activity Name The name of the selected Business Activity.

Tooltip: Displays the name of the Business 
Activity.

UI Elements (A-Z) Description
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Business Process Over Time Report

The Business Process Over Time Report shows an over-time graph of 
information relating to the Business Process value and count data over a 
selected time period. 

The report data is shown in graphical form and can also be published in 
tabular form. 

Number of Completed 
Instances

Displays the total number of the Business 
Activity instances that were completed in the 
selected time period.

Tooltip: Displays the value of the table cell.

Avg. Number of Backlog 
Instances

Displays the average value (backlog) of the active 
instances at each Activity in the process over the 
selected time period.

Tooltip: Displays the value of the table cell.

To access Applications > Business Process Insight > Reports > 
Business Process Summary > Business Process Over Time

UI Elements Description
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Following is an example of the Business Process Over Time Report:

Report Settings

The following table describes the user interface elements for the Business 
Process Over Time Report settings (unlabeled UI elements are shown in 
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angle brackets).

Data

The Data graph displays data relating to the Value or Count for the selected 
Business Process over the selected time period.

The Business Process Over Time report displays the following data for the 
selected Business Process over the selected time period:

UI Elements (A-Z) Description

<Common report elements> For details, see “Common Report Elements” in 
Reports.

Business Processes Click to open the Business Processes dialog box 
where you can select a Business Process that you 
want to display.

You can select only Business Processes that have 
a Business Process Monitor defined for them. 
The name of the Business Process is displayed to 
the right of the link.

Show Is preselected when you enter the report 
according to the setting at the Parent Business 
Process Summary, you can change the selection 
as follows:

➤ Select Value to display value-related data for 
the Business Processes in the Value area.

➤ Select Count to display count-related data for 
the Business Processes in the Count area.
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Health

The Health bar chart displays the overall health of the Business Process over 
the selected time.

The Business Process Over Time report displays the following health 
information for the selected Business Process over the selected time period:

UI Elements (A-Z) Description

<Tooltips> Tooltips for the over time graph display the same 
information for the selected entry and you can 
progressively drill down to a specific hour for more 
detailed data.

Avg. Backlog Value/Count The average Value or average Count for the backlog 
KPI for the selected Business Process. This average is 
taken from the total number of completed Business 
Process instances.

Total Value/Count of 
Completed Instances

The total Value or Count of the completed instances 
for the selected Business Process.

UI Elements (A-Z) Description

<Tooltips> Tooltips for the bars in the bar chart display the 
same information for the selected entry and you 
can progressively drill down to a specific hour for 
more detailed data.

Avg. % of At Risk 
Instances or Avg. % of At 
Risk Instances Value

The percentage of the average number of instances 
of the Business Process, which are in the state of At 
Risk, measured from the total number of instances 
over the period. 
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Business Activity Over Time Report

The Business Activity Over Time Report shows an over-time graph of 
information relating to the Business Activity status. This report shows 
information relating to the values and counts for Activities in the selected 
Business Activity over a selected time period.

The report is accessible from:

Avg. % of Blocked 
Instances or Avg. % of 
Blocked Instances Value

The percentage of the average number of instances 
of the Business Process, which are in the state of 
Blocked, measured from the total number of 
instances over the period. 

Avg. % of Healthy 
Instances or Avg. % of 
Healthy Instances Value

The percentage of the average number of instances 
of the Business Process, which are in the state of 
Healthy, measured from the total number of 
instances over the period.

To access Applications > Business Process Insight > Reports > 
Business Activity Summary > Business Activity Over Time

UI Elements (A-Z) Description
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Following is an example of a Business Activity Over Time Report.

The report data is shown in graphical form and can also be published in 
tabular form.

Report Settings

The following table describes the user interface elements for the Business 
Activity Over Time Report settings (unlabeled UI elements are shown in 
angle brackets).

UI Elements (A-Z) Description

<Common report elements> For details, see “Common Report Elements” in 
Reports.

Business Processes Click to open the Business Processes dialog box 
where you can select the Business Process that 
you want to display data for. 
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Value

This over-time graph shows the total value of completed instances and the 
average Backlog value of process instances at the selected Activity.

The Business Activity Over Time report displays the following Value data for 
the selected Business Activity over the configured time period:

Activities: Click to open the Activities dialog box where 
you can select the Business Activity that you 
want to display.

Show Is preselected when you enter the report 
according to the setting at the Parent Business 
Activity Summary, you can change the selection 
as follows:

➤ Select Value to display value-related data for 
the Business Process.

➤ Select Count to display count-related data for 
the Business Process.

UI Elements (A-Z) Description

Total Value of Completed 
Instances

The total Value of the completed instances for the 
selected Business Activity.

Avg. Value of Backlog 
Instances 

The average Value for the backlog KPI for the 
selected Business Activity. This average is taken 
from the total number of completed Business 
Process instances.

<Tooltips> Tooltips for the over time graph display the same 
information for the selected entry and you can 
progressively drill down to a specific hour for more 
detailed data.

UI Elements (A-Z) Description
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Count

This over-time graph shows the number of completed instances and the 
average number of Backlog instances at the selected Activity.

The Business Activity Over Time report displays the following Count data 
for the selected Business Activity over the configured time period:

UI Elements (A-Z) Description

<Tooltips> Tooltips for the over time graph display the same 
information for the selected entry and you can 
progressively drill down to a specific hour for more 
detailed data.

Avg. Number of Backlog 
Instances 

The average number of instances for the backlog 
KPI for the selected Business Activity. This average is 
taken from the total number of completed Business 
Process instances.

Number of Completed 
Instances 

The total number of the completed instances for the 
selected Business Activity.
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13
Annotations for Process Diagrams

This chapter includes:

Concepts

➤ Annotations Overview on page 300

Tasks

➤ How to Customize Your Process Diagram on page 302

➤ How to Include Character Set Encoding in the Annotation File 
on page 309

Reference

➤ annotations.xml File Format on page 310
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Concepts

Annotations Overview

This chapter describes how to add annotations to your Process Diagrams, 
which appear within the Health page and on the Service Health application 
Business Process Diagram.

BPI enables you to view any deployed Business Process. When displaying the 
process diagram, it annotates each of the Activities by showing the number 
of active process instances and the Value of the total instances at each 
Activity.

Following is an example of a process diagram shown from the Health Page.

BPI enables you to customize a process diagram as follows:

➤ You can configure a customized image for each Activity in the process.

➤ You can configure the text that is shown above each Activity.

As an example, you can customize your process diagram to be displayed as 
shown in the following figure. In this figure, the instance values and the 
instance counts are shown on two of the Activities and the End Activity is 
configured to show the total value of all completed instances.
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Tasks

How to Customize Your Process Diagram

You can customize your Process Diagram in one of the following ways: 

➤ “Using the Properties Dialog in the Modeler” on page 302

➤ “Use an annotations.xml File” on page 304

➤ “Do not display text on Process Activity” on page 305

➤ “Use a Custom Image for Process Activity Image” on page 305

➤ “Show the Value for Active Instances and Custom Image on a Process 
Activity” on page 306

➤ “Show the Scaled Active Value” on page 306

➤ “Show Value and Instance Count” on page 307

Note: Keep the following in mind when customizing Activity icons:

➤ If you have defined images in the annotation.xml file, the Health and 
Process Instance pages show those images, but the Modeler does not.

➤ If you have different images selected in the Modeler, those images take 
precedence over the images in the annotation.xml file.

➤ The following image file types are supported: .jpeg, .jpg, .gif, and .png.

Using the Properties Dialog in the Modeler

You can customize the Activity icons for each Activity from the Modeler’s 
Properties dialog. 

To configure the text shown above each Activity, you create an 
annotations.xml file as described in “Use an annotations.xml File” on 
page 304.
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To customize the Activity icons: 

 1 Upload the image or images to both the BSM Gateway Server and BPI 
Server as follows:

➤ On the BSM Gateway Server, place images in:

BSM-install-dir\AppServer\webapps\bpi.war\customimages

➤ On the BPI Server, place images in:

BPI-install-dir\nonOV\jakarta-tomcat-5.0.19\webapps\hpbpi-bpd\c
ustomimages

and

BPI-install-dir\nonOV\jakarta-tomcat-5.0.19\webapps\ovbpimetric
definer\customimages

 2 Open the Modeler:

Admin > Business Process Insight > Modeler

 3 Click the Business Process in the left pane and click the Process Editor in 
the right pane to display the Activities of the Business Process model.

If you are creating a new Business Process model in the Process Editor, you 
can customize each Activity icon using the following steps. For more 
information about the Modeler and creating Business Process models, see 
Chapter 3, “Modeler Management,” and the Modeler Online Help.

 4 Right-click on the Activity you want to customize and click Properties. 
The Activity Properties dialog opens.

 5 Select an image from the Images dropdown list.

Make sure the images you use are proportional in width and height. If the 
images are not square, they may not display properly.

 6 Close the Properties dialog to see the customized Activity icon.
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Use an annotations.xml File

You can configure the changes that you want to make to your Process 
Diagram by creating an annotations.xml file and then copying it to the 
following locations:

➤ Under the BSM installation hierarchy:

BSM-install-dir\lib

where BSM-install-dir is the installation directory for the BSM Gateway 
Server to which the BPI Server is configured to connect.

➤ On the BPI Server:

BPI-install-dir\nonOV\jakarta-tomcat-5.0.19\webapps\hpbpi-bpd\WEB-I
NF\classes

The annotations.xml file needs to be placed on the BPI Server so that the 
annotations are correct on the Process Instance pages.

When BPI detects that the file exists and the icon was not customized using 
the Modeler, BPI uses the file when it draws a Process Diagram.

If there is an error processing the annotations.xml file, the file is ignored and 
the Process Diagram displays as it would if the file did not exist. 

The Business Process Insight Problem Solving Guide provides some information 
on troubleshooting your system when your annotations are not displayed as 
expected.

Examples

The following are examples of using the annotation element. These 
examples assume that the image files exist in the following directories:

➤ On the BSM Gateway Server:

BSM-install-dir\AppServer\webapps\bpi.war\customimages

➤ On the BPI Server:

BPI-install-dir\nonOV\jakarta-tomcat-5.0.19\webapps\hpbpi-bpd\c
ustomimages

and
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BPI-install-dir\nonOV\jakarta-tomcat-5.0.19\webapps\ovbpimetric
definer\customimages

Do not display text on Process Activity

If you do not want any text shown above your Process Activities, specify 
your XML as follows:

<step name="Process Order">
   <texttype>none</texttype>
</step>

In this example, the Process Order Activity is shown without any text above 
the Activity, as seen below.

Use a Custom Image for Process Activity Image

If you want to replace the default Process Activity image with a custom 
image, specify your XML as follows:

<step name="Process Order">
   <texttype>none</texttype>
   <image>customimages/engineer_on_call.gif</image>
</step>

In this example, the Process Order Activity is shown with a custom image 
as seen below.
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Show the Value for Active Instances and Custom Image on a 
Process Activity

If you want to show the value for the active instances on a custom image for 
a Process Activity, specify your XML as follows:

<step name="Process Order">
   <texttype>value</texttype>
   <textsymbol>$</textsymbol>
   <image>customimages/engineer_on_phone.gif</image>
</step>

In this example, the Process Order Activity is shown with an active value as 
seen below.

Show the Scaled Active Value

If you want to show the value for the active instances that has been scaled 
and that also includes a custom image for a Process Activity, specify your 
XML as follows:

<step name="Process Order">
   <texttype>value</texttype>
   <textsymbol>$</textsymbol>
   <textdp>-3</textdp>
   <scalesymbol>K</scalesymbol>
   <image>customimages/engineer_on_phone.gif</image>
</step>
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In this example, the Process Order Activity is shown with a scaled active 
value, as seen below.

Show Value and Instance Count

If you want to show both a value, which has been scaled, for the active 
instances and the number of active instances, plus a custom image for a 
Process Activity, specify your XML as follows:

<step name="Process Order">
   <texttype>both</texttype>
   <textsymbol>$</textsymbol>
   <textdp>-3</textdp>
   <scalesymbol>K</scalesymbol>
   <image>customimages/engineer_on_phone.gif</image>
</step>

This displays the Process Order Activity showing both the value and 
instance count, as shown below.

Example of a complete process

The following is an example of the file annotations.xml for a complete 
process:

<?xml version="1.0" encoding="ISO-8859-1"?>
<annotations>
    <step name="New Order">
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      <texttype>none</texttype>
      <image>customimages/phone_receiver.gif</image>
    </step>
    <step name="Process Order">
      <texttype>both</texttype>
      <textsymbol>$</textsymbol>
      <textdp>2</textdp>
      <image>customimages/engineer_on_phone.gif</image>
    </step>
    <step name="Ship Order">
      <texttype>both</texttype>
      <textsymbol>$</textsymbol>
      <textdp>2</textdp>
      <image>customimages/ship.gif</image>
    </step>
    <step name="End">
      <texttype>value</texttype>
      <textsymbol>$</textsymbol>
      <textdp>-3</textdp>
      <scalesymbol>K</scalesymbol>
      <image>customimages/success.gif</image>
    </step>
</annotations>

In this example, the Process Diagram is displayed as shown below.
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How to Include Character Set Encoding in the 
Annotation File

To create an annotations file that contains a specific character set encoding, 
for example, UTF-8:

 1 Use an editor that supports UTF-8.

The editor that you use does not add any extra characters (hidden 
characters) to the file. As an example, Notepad writes three additional 
bytes to the start of a file, which although not visible within Notepad, 
create errors in the XML file that you create.

 2 Specify the first line of your XML as follows:

<?xml version="1.0" encoding="UTF-8"?>

In the UTF-8 example, if you specify UTF-8 as the XML encoding and do 
not use a corresponding UTF-8 editor when entering the UTF-8 
characters, BPI fails to parse the annotations.xml file and therefore 
ignores your settings. 

 3 Make sure that you use an editor that supports the character set encoding 
that you specify in your annotations file.
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Reference

annotations.xml File Format

The annotations.xml file is structured as follows:

<?xml version="1.0" encoding="..." ?>
<annotations>
    <step name="...">
      <texttype> ... </texttype>
      <textsymbol> ... </textsymbol>
      <textdp> ... </textdp>
      <scalesymbol> ... </scalesymbol>
      <image> ... </image>
    </step>

    ...further steps...

</annotations>

Note: An Activity is configured using the <step> element.

The following sections describe this structure in more detail and provide 
some examples of configuration options.

➤ encoding=

➤ <annotations>

➤ <step>

➤ <texttype>

➤ <textsymbol>

➤ <textdp>

➤ <scalesymbol>
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➤ <image>

encoding=

The first line of the annotations file declares that this file contains XML and 
it declares the encoding used within this XML.

If your annotations include 8-bit Western European characters, then you 
could set the first line of the file to be:

<?xml version="1.0" encoding="ISO-8859-1"?>

The following are examples of other XML encodings you could use:

windows-1252
UTF-8
UTF-16

The XML encoding that you use depends on the editor you are using to 
create the annotations file and the type of characters you are using.

<annotations>

The annotations element simply encloses the set of activity elements.

You must have one, and only one, annotations element within the 
annotations.xml file.

<step>

You define a step element for each Activity in the Process Diagram that you 
want to annotate.

BPI uses only one annotations.xml file, and there is no way to specify a 
Process Name in the annotations.xml file. This means that when you specify 
a step element for a particular Process Activity name, all Process Activities 
with the same name in any process definition, are displayed with the same 
annotation in the Process Diagram. As a result, you might want to consider 
making sure that your Activity names are unique across your process 
definitions.
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As an example, you might have a step element structured as follows:

<step name="New Order">
...
</step>

In this case, any process with a Process Activity named New Order is 
annotated when BPI displays it as a Process Diagram.

<texttype>

The texttype element enables you to specify the data that is displayed 
above the image of the Process Activity.

You can specify one of the following values:

➤ count

This displays the number of active instance at this Process Activity.

For example:

<texttype>count</texttype>

If you do not specify a texttype element, a value for count is 
automatically added to the Process Diagram.

When displayed within the Process Diagram, the value for count is 
displayed above, and slightly to the right, of the Process Activity.

➤ value

This is the value of all the current active instances at the specified Process 
Activity and as defined by the Process Value property for the Process.

For example:

<texttype>value</texttype>

When displayed within the Process Diagram, the Process Value of the 
active instances is displayed above, and slightly to the right, of the 
Process Activity.
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➤ both

This enables you to display both the active count of process instances at 
this Process Activity, and the active value of these instances.

For example:

<texttype>both</texttype>

When displayed within the process diagram, the value of the active 
instances is displayed above, and slightly to the left, of the Process 
Activity, and the count of the active instances is displayed above, and 
slightly to the right, of the Process Activity.

➤ none

If you do not want to show any text above the Process Activity use 
option.

For example:

<texttype>none</texttype>

<textsymbol>

The textsymbol element enables you to specify a character sequence to 
display as part of the active instance value. This character sequence is 
usually displayed before the active instance value, but its position is 
localizable.

The textsymbol element is used only if you have specified a texttype setting 
of value or both.

For example:

<textsymbol>$</textsymbol>

<textdp>

The textdp element enables you to specify the number of decimal places to 
use when displaying the value attribute for active instances at a specified 
Process Activity.

The textdp element is used only if you have specified a texttype setting of 
value or both.
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For example, you might set the value for textdp to be 2 as follows:

<textdp>2</textdp>

If you then have a value of 2.8765, this is shown as 2.88 on the Process 
Diagram.

If you do not specify a textdp element, the value is shown with zero decimal 
places on the Process Diagram.

If you specify a negative value for the value of textdp, that is, a number 
between -1 and -100, then the number that you want to display is 
truncated by that number of digits, and the value rounded.

For example, you might set the following value for textdp:

<textdp>-3</textdp>

If you then have a value of 234567, this is shown as follows on the Process 
Diagram:

Note: If you specify a negative value for textdp, you also need to specify a 
scalesymbol element, as described in “<scalesymbol>” on page 314.

<scalesymbol>

The scalesymbol element is used to define the symbol you want to be 
displayed with the active instances value to reflect the scaled number. In 
other words, if you have specified a textdp with a negative value then you 
need to set a scalesymbol to show the scaling that has occurred.

The following are examples of how you might set values for textdp and 
scalesymbol and the results that are displayed:
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Example 1:
<textdp>-3</textdp>
<scalesymbol>K</scalesymbol>

If you then have a value of 234567, this is shows as follows on the Process 
Diagram:

235K

Example 2:
<textdp>-6</textdp>
<scalesymbol>M</scalesymbol>

If you then have a value of 1234567, this is shown as 1M on the Process 
Diagram.

<image>

The image element specifies a file name of an image that you want to be 
displayed in place of the standard Process Activity image. The file name for 
the image is relative to the webapps directory.

For example, you might set the following:

<image>customimages/myImage.gif</image>

In this example, BPI looks for the myImage.gif file in the following 
directories:

➤ BSM installation directory:

BSM-install-dir\AppServer\webapps\bpi.war\customimages

➤ BPI Server installation directories:

BPI-install-dir\nonOV\jakarta-tomcat-5.0.19\webapps\hpbpi-bpd\cust
omimages

and

BPI-install-dir\nonOV\jakarta-tomcat-5.0.19\webapps\ovbpimetricdefi
ner\customimages

You need to create the directory customimages, if it does not already exist.
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14
BPI Components in MyBSM

This chapter includes:

Concepts

➤ MyBSM Components Overview on page 318

Tasks

➤ How to Add BPI Components to MyBSM on page 319



Chapter 14 • BPI Components in MyBSM

318

Concepts

MyBSM Components Overview

Within Business Service Management, you can use the MyBSM portal server 
to add and customize BPI pre-defined components so that you can display 
specific content that is relevant to you.

You can configure MyBSM to display the following pre-defined BPI 
components:

➤ Business Process Overtime to display information about the volume 
(throughput), backlog (active process value) and health of a selected 
Business Process CI over a specific time interval. For details, see "Business 
Process Over Time Report" on page 291.

➤ Business Process Instance Violations to display information about the 
instance violations for a selected Business Process. For details, see 
"Instance Violation Counts" on page 223.

➤ Business Process Summary to display the summary data for all selected 
Business Processes. For details, see "Business Process Summary Report" on 
page 273.

➤ Business Process Diagram to display the overall status of the health of 
your Business Process. For details, see "Process Diagram Area" on page 210.
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Tasks

How to Add BPI Components to MyBSM

You can add one or more BPI pre-defined components. For details on adding 
and using components in MyBSM, see Using MyBSM.
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